Important Notice

Texas Instruments and its subsidiaries (TI) reserve the right to make changes to their products or to discontinue any product or service without notice, and advise customers to obtain the latest version of relevant information to verify, before placing orders, that information being relied on is current and complete. All products are sold subject to the terms and conditions of sale supplied at the time of order acknowledgment, including those pertaining to warranty, patent infringement, and limitation of liability.

TI warrants performance of its semiconductor products to the specifications applicable at the time of sale in accordance with TI's standard warranty. Testing and other quality control techniques are utilized to the extent TI deems necessary to support this warranty. Specific testing of all parameters of each device is not necessarily performed, except those mandated by government requirements.

Customers are responsible for their applications using TI components.

In order to minimize risks associated with the customer’s applications, adequate design and operating safeguards must be provided by the customer to minimize inherent or procedural hazards.

TI assumes no liability for applications assistance or customer product design. TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right of TI covering or relating to any combination, machine, or process in which such semiconductor products or services might be or are used. TI’s publication of information regarding any third party’s products or services does not constitute TI’s approval, warranty or endorsement thereof.

Copyright © 2015 – 2018 Texas Instruments Incorporated

Revision History

February 2015 – Revision 1.0
May 2015 – Revision 1.1
January 2018 – Revision 2.0

Mailing Address

Texas Instruments
C2000 Training Technical
13905 University Boulevard
Sugar Land, TX 77479
Workshop Outline

1. Architecture Overview
2. Programming Development Environment
   • Lab: Linker command file
3. Peripheral Register Header Files
4. Reset and Interrupts
5. System Initialization
   • Lab: Watchdog and interrupts
6. Analog Subsystem
   • Lab: Build a data acquisition system
7. Control Peripherals
   • Lab: Generate and graph a PWM waveform
8. Direct Memory Access (DMA)
   • Lab: Use DMA to buffer ADC results
9. Control Law Accelerator (CLA)
   • Lab: Use CLA to filter PWM waveform
10. System Design
    • Lab: Run the code from flash memory
11. Dual-Core Inter-Processor Communications (IPC)
    • Lab: Transfer data using IPC
12. Communications
13. Support Resources
Required Workshop Materials

- F28379D LaunchPad (LAUNCHXL-F28379D)
- Install Code Composer Studio v7.3.0
- Run the workshop installer
  
  *F2837xD Microcontroller Workshop-2.0-Setup.exe*

- Lab Files / Solution Files
- Workshop Manual

Development Tools

**F28379D LaunchPad**

- JP3: 5V from USB (disables isolation)
- JP2: GND from USB (disables isolation)
- D10: GPIO31 (blue)
- D9: GPIO34 (red)
- D1: Power (green)
- S1: Boot Modes
- S2: Reset
- TMS320F28379D
- J6/J8 *
- J14: QEP_A
- J15: QEP_B
- J12: CAN
- J13/J11 I2C
- J1: Power (green)
- J2: UART (disables isolation)
- J3: Boot Modes
- J4/J5/J6/J7 *
- J21: (ADC-D differential pair inputs)
- J20/J19: (Optional SMA connector point)
- J11/J13: I2C
- J14: QEP_A
- J15: QEP_B
- J12: CAN
- J13/J11 I2C
- * = BoosterPack plug-in module connector

Note: F28379D – 337 pin package
F28379D controlCARD

- A:J1 - USB emulation/UART
- A:SW1 - isolated emulation and UART communication enable switch
- J8: Host/Device
- LED LD2: GPIO31 (red)
- LED LD3: GPIO34 (red)
- SW1: Boot Modes
- LED LD1: Power (green)
- TMS320F28379D
- SW3: ADC VREFHI ADC C & D
- SW2: ADC VREFHI ADC A & B
- J2 - J7: USB PHY connection enable jumpers
- XDS100v2 emulation and isolation circuitry
- U5: µSD card

controlCARD Docking Station
# TMS320F28x7x Device Comparison

<table>
<thead>
<tr>
<th></th>
<th>F2807x</th>
<th>F2837xS</th>
<th>F2837xD</th>
</tr>
</thead>
<tbody>
<tr>
<td>C28x CPUs</td>
<td>1</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Clock</td>
<td>120 MHz</td>
<td>200 MHz</td>
<td>200 MHz</td>
</tr>
<tr>
<td>Flash / RAM / OTP</td>
<td>256Kw / 50Kw / 2Kw</td>
<td>512Kw / 82Kw / 2Kw</td>
<td>512Kw / 102Kw / 2Kw</td>
</tr>
<tr>
<td>On-chip Oscillators</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Watchdog Timer</td>
<td>✓</td>
<td>✓</td>
<td>✓ (each CPU)</td>
</tr>
<tr>
<td>ADC</td>
<td>Three 12-bit</td>
<td>Four 12/16-bit</td>
<td>Four 12/16-bit</td>
</tr>
<tr>
<td>Buffered DAC</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Analog COMP w/DAC</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>FPU</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>6-Channel DMA</td>
<td>✓</td>
<td>✓</td>
<td>✓ (each CPU)</td>
</tr>
<tr>
<td>CLA</td>
<td>✓</td>
<td>✓</td>
<td>✓ (each CPU)</td>
</tr>
<tr>
<td>VCU / TMU</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
<td>✓ / ✓ (each CPU)</td>
</tr>
<tr>
<td>ePWM / HRPWM</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
</tr>
<tr>
<td>eCAP / HRCAP</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
</tr>
<tr>
<td>eQEP</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SCI / SPI / I2C</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
</tr>
<tr>
<td>CAN / McBSP / USB</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
<td>✓ / ✓</td>
</tr>
<tr>
<td>UPP</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>EMIF</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

# TMS320F28x7x Block Diagrams

![F2837xD – Dual-Core Block Diagram](image)
Architecture Overview

Introduction

This architectural overview introduces the basic architecture of the C2000™ family of microcontrollers from Texas Instruments. The F28x7x series adds a new level of high performance processing ability. The C2000™ is ideal for applications combining digital signal processing, microcontroller processing, efficient C code execution, and operating system tasks.

Unless otherwise noted, the terms C28x and F28x7x refer to TMS320F28x7x devices throughout the remainder of these notes. For specific details and differences please refer to the device data sheet, user's guide, and technical reference manual.

Module Objectives

When this module is complete, you should have a basic understanding of the F28x7x architecture and how all of its components work together to create a high-end, uniprocessor control system.

Module Objectives

- Review the F28x7x block diagram and device features
- Describe the F28x7x bus structure and memory map
- Identify the various memory blocks on the F28x7x
- Identify the peripherals available on the F28x7x
Chapter Topics

Architecture Overview................................................................................................................ 1-1
Introduction to the TMS320F28x7x ........................................................................................... 1-3
C28x Internal Bussing ........................................................................................................... 1-4
C28x CPU + FPU + VCU + TMU and CLA ........................................................................... 1-5
Special Instructions ............................................................................................................... 1-6
CPU Pipeline ....................................................................................................................... 1-7
C28x CPU + FPU + VCU + TMU Pipeline ............................................................................ 1-8
Peripheral Write-Read Protection ........................................................................................ 1-9
Memory ................................................................................................................................... 1-10
Memory Map ....................................................................................................................... 1-10
Dual Code Security Module (DCSM) .................................................................................. 1-11
Peripherals .......................................................................................................................... 1-11
Fast Interrupt Response Manager .......................................................................................... 1-12
Math Accelerators ................................................................................................................... 1-13
Viterbi / Complex Math Unit (VCU-II) .................................................................................. 1-13
Trigonometric Math Unit (TMU) ......................................................................................... 1-14
On-Chip Safety Features ...................................................................................................... 1-15
Summary ................................................................................................................................. 1-16
Introduction to the TMS320F28x7x

The TMS320F37xD, TMS320F37xS, and TMS320F07x, collectively referred to as the TMS320F28x7x or F28x7x, are device members of the C2000™ microcontroller (MCU) product family. These devices are most commonly used within embedded control applications. Even though the topics presented in this workshop are based on the TMS320F2837xD dual-core device series, most all of the topics are fully applicable to the TMS320F2837xS and TMS320F2807x single-core device series. The F2837xD dual-core MCU design is based on the TI 32-bit C28x CPU architecture. Each core is identical with access to its own local RAM and flash memory, as well as globally shared RAM memory. Sharing information between the two CPU cores is accomplished with an Inter-Processor Communications (IPC) module. Additionally, each core shares access to a common set of highly integrated analog and control peripherals, providing a complete solution for demanding real-time high-performance signal processing applications, such as digital power, industrial drives, inverters, and motor control.

The TMS320F28x7x Core Block Diagram

The above block diagram represents an overview of all device features and is not specific to any one device. The F28x7x device is designed around a multibus architecture, also known as a modified Harvard architecture. This can be seen in the block diagram by the separate program bus and data bus, along with the link between the two buses. This type of architecture greatly enhances the performance of the device.

In the upper left area of the block diagram is the memory section, which consists of the boot ROM, sectored flash, and RAM. Also, notice that the six-channel DMA has its own set of buses.

In the lower left area of the block diagram is the execution section, which consists of a 32-bit by 32-bit hardware multiplier, a read-modify-write atomic ALU, a floating-point unit, a trigonometric math unit, and a Viterbi complex math CRC unit. The control law accelerator (CLA) is an independent and separate unit that has its own set of buses.

The peripherals are grouped on the right side of the block diagram. The upper set is the control peripherals, which consists of the ePWM, eCAP, eQEP, and ADC. The lower set is the...
communication peripherals and consists of the multichannel buffered serial port, I2C, SCI, SPI, CAN, and USB.

The PIE block, or Peripheral Interrupt Expansion block, manages the interrupts from the peripherals. In the bottom right corner is the general-purpose I/O. The CPU has a watchdog module and three 32-bit general-purpose timers are available. Also, the device features an external memory interface, as shown on the left side.

**C28x Internal Bussing**

As with many high performance microcontrollers, multiple busses are used to move data between the memory blocks, peripherals, and the CPU. The C28x memory bus architecture consists of six buses (three address and three data):

- A program read bus (22-bit address line and 32-bit data line)
- A data read bus (32-bit address line and 32-bit data line)
- A data write bus (32-bit address line and 32-bit data line)

The 32-bit-wide data busses provide single cycle 32-bit operations. This multiple bus architecture (Harvard Bus Architecture) enables the C28x to fetch an instruction, read a data value and write a data value in a single cycle. All peripherals and memory blocks are attached to the memory bus with prioritized memory accesses.
C28x CPU + FPU + VCU + TMU and CLA

The C28x is a highly integrated, high performance solution for demanding control applications. The C28x is a cross between a general purpose microcontroller and a digital signal processor (DSP), balancing the code density of a RISC processor and the execution speed of a DSP with the architecture, firmware, and development tools of a microcontroller.

The DSP features include a modified Harvard architecture and circular addressing. The RISC features are single-cycle instruction execution, register-to-register operations, and a modified Harvard architecture. The microcontroller features include ease of use through an intuitive instruction set, byte packing and unpacking, and bit manipulation.

The C28x design supports an efficient C engine with hardware that allows the C compiler to generate compact code. Multiple busses and an internal register bus allow an efficient and flexible way to operate on the data. The architecture is also supported by powerful addressing modes, which allow the compiler as well as the assembly programmer to generate compact code that is almost one to one corresponded to the C code.

The C28x is as efficient in DSP math tasks as it is in system control tasks. This efficiency removes the need for a second processor in many systems, though the F2837xD is a dual-core device for even higher performance. The 32 x 32-bit multiply-accumulate (MAC) capabilities can also support 64-bit processing, enable the C28x to efficiently handle higher numerical resolution calculations that would otherwise demand a more expensive solution. Along with this is the capability to perform two 16 x 16-bit multiply accumulate instructions simultaneously or Dual MACs (DMAC). The devices also feature floating-point units.

The addition of the Floating-Point Unit (FPU) to the fixed-point CPU core enables support for hardware IEEE-754 single-precision floating-point format operations. The FPU adds an extended set of floating-point registers and instructions to the standard C28x architecture, providing seamless integration of floating-point hardware into the CPU.
Atomic instructions are a group of small common instructions which are non-interruptable. The atomic ALU capability supports instructions and code that manages tasks and processes. These instructions usually execute several cycles faster than traditional coding.
The C28x uses a special 8-stage protected pipeline to maximize the throughput. This protected pipeline prevents a write to and a read from the same location from occurring out of order.

This pipelining also enables the C28x CPU to execute at high speeds without resorting to expensive high-speed memories. Special branch-look-ahead hardware minimizes the latency for conditional discontinuities. Special store conditional operations further improve performance. With the 8-stage pipeline most operations can be performed in a single cycle.
C28x CPU + FPU + VCU + TMU Pipeline

Floating-point math operations, conversions between integer and floating-point formats, and complex MPY/MAC require 1 delay slot – everything else does not require a delay slot (load, store, max, min, absolute, negative, etc.)

- Floating Point Unit, VCU and TMU has an unprotected pipeline
  - i.e. FPU/VCU/TMU can issue an instruction before previous instruction has written results
- Compiler prevents pipeline conflicts
- Assembler detects pipeline conflicts
- Performance improvement by placing non-conflicting instructions in floating-point pipeline delay slots

Floating-point unit (FPU), VCU and TMU operations are not pipeline protected. Some instructions require delay slots for the operation to complete. This can be accomplished by insert NOPs or other non-conflicting instructions between operations.

In the user’s guide, instructions requiring delay slots have a ‘p’ after their cycle count. The 2p stands for 2 pipelined cycles. A new instruction can be started on each cycle. The result is valid only 2 instructions later.

Three general guidelines for the FPU/VCU/TMU pipeline are:

<table>
<thead>
<tr>
<th>Math</th>
<th>Instructions</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MPYF32, ADDF32, SUBF32, MACF32, VCMPY</td>
<td>2p cycles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One delay slot</td>
</tr>
<tr>
<td>Conversion</td>
<td>I16TOF32, F32TOI16, F32TOI16R, etc…</td>
<td>2p cycles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One delay slot</td>
</tr>
<tr>
<td>Everything else*</td>
<td>Load, Store, Compare, Min, Max, Absolute and Negative value</td>
<td>Single cycle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No delay slot</td>
</tr>
</tbody>
</table>

* Note: MOV32 between FPU and CPU registers is a special case.
Peripheral Write-Read Protection

Suppose you need to write to a peripheral register and then read a different register for the same peripheral (e.g., write to control, read from status register)?

- CPU pipeline protects W-R order for the same address
- Write-Read protection mechanism protects W-R order for different addresses

- The following address ranges have Write-Read Protection:
  - Block Protected Zone 1 (0x0000 4000 to 0x0000 7FFF)
    - Peripheral Frame 1: ePWM, eCAP, eQEP, DAC, CMPSS, SDFM
  - Peripheral Frame 2: McBSP, SPI, uPP, WD, XINT, SCI, I2C, ADC, X-BAR, GPIO
  - Block Protected Zone 2 (0x0004 0000 to 0x0005 FFFF)
    - Peripheral Frame 2: USB, EMIF, CAN, IPC, System Control

The peripheral write-read protection is a mechanism to protect the write-read order for peripherals at different addresses. This works similar to the CPU pipeline protection of write-read order for the same address.
Memory

The F28x7x MCU utilizes a memory map where the unified memory blocks can be accessed in either program space, data space, or both spaces. This type of memory map lends itself well for supporting high-level programming languages. The memory structure consisting of dedicated RAM blocks, shared local RAM blocks, shared global RAM blocks, message RAM blocks, Flash, and one-time programmable (OTP) memory. The Boot is factory programmed with boot software routines and standard tables used in math related algorithms.

Memory Map

The C28x CPU core contains no memory, but can access on-chip and off-chip memory. The C28x uses 32-bit data addresses and 22-bit program addresses. This allows for a total address reach of 4G words (1 word = 16-bits) in data memory and 4M words in program memory.

There are four dedicated RAM block (M0, M1, D0, and D1) which are tightly coupled with the CPU, and only the CPU has access to them. The PIE Vectors are a special memory area containing the vectors for the peripheral interrupts. The six local shared memory blocks, LS0 through LS5, are accessible by its CPU and CLA. Global shared memory blocks GS0 through GS15 on the F2837x and through GS7 on the F2807x are accessible by CPU and DMA.

There are two types of message RAM blocks: CPU message RAM blocks and CLA message RAM blocks. The CPU message RAM blocks are used to share data between CPU1 subsystem and CPU2 subsystem in a dual-core device via inter-processor communications. The CLA message RAM blocks are used to share date between the CPU and CLA.

The user OTP is a one-time, programmable, memory block which contains device specific calibration data for the ADC, internal oscillators, and buffered DACs, in addition to settings used by the flash state machine for erase and program operations. Additionally, it contains locations for programming security settings, such as passwords for selectively securing memory blocks, configuring the standalone boot process, as well as selecting the boot-mode pins in case the

![Simplified F28x7x Memory Map](image-url)
factory-default pins cannot be used. This information is programmed into the dual code security module (DCSM). The flash memory is primarily used to store program code, but can also be used to store static data. Notice that the external memory interface is assigned a region within the memory map. The boot ROM and boot ROM vectors are located at the bottom of the memory map.

**Dual Code Security Module (DCSM)**

<table>
<thead>
<tr>
<th>Z1_CSMPSWD0</th>
<th>Z2_CSMPSWD0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z1_CSMPSWD1</td>
<td>Z2_CSMPSWD1</td>
</tr>
<tr>
<td>Z1_CSMPSWD2</td>
<td>Z2_CSMPSWD2</td>
</tr>
<tr>
<td>Z1_CSMPSWD3</td>
<td>Z2_CSMPSWD3</td>
</tr>
</tbody>
</table>

- Various on-chip memory resources can be assigned to either zone 1 or zone 2
- Each zone has its own password
- 128-bit user defined password is stored in OTP
- 128-bits = $2^{128} = 3.4 \times 10^{38}$ possible passwords
- To try 1 password every 8 cycles at 200 MHz, it would take at least $4.3 \times 10^{23}$ years to try all possible combinations!

**Peripherals**

The F28x7x is available with a variety of built in peripherals optimized to support control applications. These peripherals vary depending on which F28x7x device selected.

- ePWM
- eCAP
- eQEP
- CMPSS
- ADC
- DAC
- Watchdog Timer
- DMA
- CLA
- SDFM
- SPI
- SCI
- I2C
- McBSP
- CAN
- USB
- GPIO
- EMIF
Fast Interrupt Response Manager

The fast interrupt response manage is capable of automatically performing context save of critical registers. This results in the ability of servicing many asynchronous events with minimal latency. The F28x7x implements a zero cycle penalty to do 14 registers context saved and restored during an interrupt. This feature helps reduce the interrupt service routine overheads.

C28x Fast Interrupt Response Manager

- 192 dedicated PIE vectors
- No software decision making required
- Direct access to RAM vectors
- Auto flags update
- Concurrent auto context save

By incorporating the very fast interrupt response manager with the peripheral interrupt expansion (PIE) block, it is possible to allow up to 192 interrupt vectors to be processed by the CPU. More details about this will be covered in the reset, interrupts, and system initialization modules.
Math Accelerators

Viterbi / Complex Math Unit (VCU-II)

Extends C28x instruction set to support:
- Viterbi operations
  - Decode for communications
- Complex math
  - 16-bit fixed-point complex FFT
    - used in spread spectrum communications, and many signal processing algorithms
  - Complex filters
    - used to improve data reliability, transmission distance, and power efficiency
- Power Line Communications (PLC) and radar applications
- Cyclic Redundancy Check (CRC)
  - Communications and memory robustness checks
- Other: OFDM interleaving & de-interleaving, Galois Field arithmetic, AES acceleration

The Viterbi, Complex Math, and CRC Unit (VCU) adds an extended set of registers and instructions to the standard C28x architecture for supporting various communications-based algorithms, such as power line communications (PLC) standards PRIME and G3. These algorithms typically require Viterbi decoding, complex Fast Fourier Transform (FFT), complex filters, and cyclical redundancy check (CRC). By utilizing the VCU a significant performance benefit is realized over a software implementation. It performs fixed-point operations using the existing instruction set format, pipeline, and memory bus architecture. Additionally, the VCU is very useful for general-purpose signal processing applications such as filtering and spectral analysis.
Trigonometric Math Unit (TMU)

The Trigonometric Math Unit (TMU) is an extension of the FPU and the C28x instruction set, and it efficiently executes trigonometric and arithmetic operations commonly found in control system applications. Similar to the FPU, the TMU provides hardware support for IEEE-754 single-precision floating-point operations that are specifically focused on trigonometric math functions. Seamless code integration is accomplished by built-in compiler support that automatically generates TMU instructions where applicable. This dramatically increases the performance of trigonometric functions, which would otherwise be very cycle intensive. It uses the same pipeline, memory bus architecture, and FPU registers as the FPU, thereby removing any special requirements for interrupt context save or restore.

- Supported by natural C and C-intrinsics
- Significant performance impact on algorithms such as:
  - Park / Inverse Park
  - dq0 Transform & Inverse dq0
  - Space Vector GEN
  - FFT Magnitude & Phase Calculations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Instruction</th>
<th>Exe Cycles</th>
<th>Result Latency</th>
<th>FPU Cycles w/o TMU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z = Y/X</td>
<td>DIVF32</td>
<td>Rz, Ry, Rx</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>Y = sqrt(X)</td>
<td>SQRTF32</td>
<td>Ry, Rx</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>Y = sin(X/2pi)</td>
<td>SINPUF32</td>
<td>Ry, Rx</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Y = cos(X/2pi)</td>
<td>COSPUF32</td>
<td>Ry, Rx</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Y = atan(X/2pi)</td>
<td>ATANPUF32</td>
<td>Ry, Rx</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Instruction To</td>
<td>QUADF32</td>
<td>Rw, Rx, Ry, Rx</td>
<td>3</td>
<td>11</td>
</tr>
<tr>
<td>Support ATAN2</td>
<td>ATANPUF32</td>
<td>Ra, Rz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculation</td>
<td>ADDF32</td>
<td>Rb, Ra, Rw</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y = X * 2pi</td>
<td>MPY2PIF32</td>
<td>Ry, Rx</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Y = X * 1/2pi</td>
<td>DIV2PIF32</td>
<td>Ry, Rx</td>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>
On-Chip Safety Features

On-Chip Safety Features

- **Memory Protection**
  - ECC and parity enabled RAMs, shared RAMs protection
  - ECC enabled flash memory

- **Clock Checks**
  - Missing clock detection logic
  - PLLSLIP detection
  - NMIWDs
  - Windowed watchdog

- **Write Register Protection**
  - LOCK protection on system configuration registers
  - EALLOW protection
  - CPU1 and CPU2 PIE vector address validity check

- **Annunciation**
  - Single error pin for external signalling of error
Summary

- High performance 32-bit CPU
- 32x32 bit or dual 16x16 bit MAC
- IEEE single-precision floating point unit (FPU)
- Hardware Control Law Accelerator (CLA)
- Viterbi, complex math, CRC unit (VCU)
- Trigonometric math unit (TMU)
- Atomic read-modify-write instructions
- Fast interrupt response manager
- 256Kw on-chip flash memory
- Dual code security module (DCSM)
- Control peripherals
- ADC module
- Comparators
- Direct memory access (DMA)
- Shared GPIO pins
- Communications peripherals
Introduction

This module will explain how to use Code Composer Studio (CCS) integrated development environment (IDE) tools to develop a program. Creating projects and setting building options will be covered. Use and the purpose of the linker command file will be described.

Module Objectives

- Use Code Composer Studio to:
  - Create a Project
  - Set Build Options
- Create a user linker command file which:
  - Describes a system’s available memory
  - Indicates where sections will be placed in memory
Chapter Topics

Programming Development Environment ................................................................. 2-1

  Code Composer Studio ......................................................................................... 2-3
  Software Development and COFF Concepts ......................................................... 2-3
  Code Composer Studio ......................................................................................... 2-4
  Edit and Debug Perspective (CCSv7) ............................................................... 2-5
  Target Configuration ............................................................................................ 2-6
  CCSv7 Project ...................................................................................................... 2-7
  Creating a New CCSv7 Project ............................................................................... 2-8
  CCSv7 Build Options – Compiler / Linker ......................................................... 2-9
  CCS Debug Environment .................................................................................... 2-10

Creating a Linker Command File ........................................................................ 2-12
  Sections ................................................................................................................. 2-12
  Linker Command Files (.cmd) ........................................................................... 2-15
  Memory-Map Description .................................................................................... 2-15
  Section Placement ............................................................................................... 2-16
  Summary: Linker Command File ....................................................................... 2-17

Lab File Directory Structure ................................................................................ 2-18

Lab 2: Linker Command File .................................................................................. 2-19
Code Composer Studio

Software Development and COFF Concepts

In an effort to standardize the software development process, TI uses the Common Object File Format (COFF). COFF has several features which make it a powerful software development system. It is most useful when the development task is split between several programmers.

Each file of code, called a module, may be written independently, including the specification of all resources necessary for the proper operation of the module. Modules can be written using Code Composer Studio (CCS) or any text editor capable of providing a simple ASCII file output. The expected extension of a source file is .ASM for assembly and .C for C programs.

Code Composer Studio includes:

- Integrated Edit/Debug GUI
- Code Generation Tools
- TI-RTOS

Code Composer Studio includes a built-in editor, compiler, assembler, linker, and an automatic build process. Additionally, tools to connect file input and output, as well as built-in graph displays for output are available. Other features can be added using the plug-ins capability.

Numerous modules are joined to form a complete program by using the linker. The linker efficiently allocates the resources available on the device to each module in the system. The linker uses a command (.CMD) file to identify the memory resources and placement of where the various sections within each module are to go. Outputs of the linking process includes the linked object file (.OUT), which runs on the device, and can include a .MAP file which identifies where each linked section is located.

The high level of modularity and portability resulting from this system simplifies the processes of verification, debug and maintenance. The process of COFF development is presented in greater detail in the following paragraphs.

The concept of COFF tools is to allow modular development of software independent of hardware concerns. An individual assembly language file is written to perform a single task and may be linked with several other tasks to achieve a more complex total system.
Writing code in modular form permits code to be developed by several people working in parallel so the development cycle is shortened. Debugging and upgrading code is faster, since components of the system, rather than the entire system, is being operated upon. Also, new systems may be developed more rapidly if previously developed modules can be used in them.

Code developed independently of hardware concerns increases the benefits of modularity by allowing the programmer to focus on the code and not waste time managing memory and moving code as other code components grow or shrink. A linker is invoked to allocate systems hardware to the modules desired to build a system. Changes in any or all modules, when re-linked, create a new hardware allocation, avoiding the possibility of memory resource conflicts.

**Code Composer Studio**

Code Composer Studio™ (CCS) is an integrated development environment (IDE) for Texas Instruments (TI) embedded processor families. CCS comprises a suite of tools used to develop and debug embedded applications. It includes compilers for each of TI’s device families, source code editor, project build environment, debugger, profiler, simulators, real-time operating system and many other features. The intuitive IDE provides a single user interface taking you through each step of the application development flow. Familiar tools and interfaces allow users to get started faster than ever before and add functionality to their application thanks to sophisticated productivity tools.

CCS is based on the Eclipse open source software framework. The Eclipse software framework was originally developed as an open framework for creating development tools. Eclipse offers an excellent software framework for building software development environments and it is becoming a standard framework used by many embedded software vendors. CCS combines the advantages of the Eclipse software framework with advanced embedded debug capabilities from TI resulting in a compelling feature-rich development environment for embedded developers. CCS supports running on both Windows and Linux PCs. Note that not all features or devices are supported on Linux.
Edit and Debug Perspective (CCSv7)

A perspective defines the initial layout views of the workbench windows, toolbars, and menus that are appropriate for a specific type of task, such as code development or debugging. This minimizes clutter to the user interface.

Each perspective provides a set of functionality aimed at accomplishing a specific task.

**Edit Perspective**
- Displays views used during code development
  - C/C++ project, editor, etc.

**Debug Perspective**
- Displays views used for debugging
  - Menus and toolbars associated with debugging, watch and memory windows, graphs, etc.

Code Composer Studio has “Edit” and “Debug” perspectives. Each perspective provides a set of functionality aimed at accomplishing a specific task. In the edit perspective, views used during code development are displayed. In the debug perspective, views used during debug are displayed.
Target Configuration

A Target Configuration defines how CCS connects to the device. It describes the device using GEL files and device configuration files. The configuration files are XML files and have a *.ccxml file extension.

Creating a Target Configuration

- File ➔ New ➔ Target Configuration File
- Select connection type
- Select device
- Save configuration
CCSv7 Project

Code Composer works with a project paradigm. Essentially, within CCS you create a project for each executable program you wish to create. Projects store all the information required to build the executable. For example, it lists things like: the source files, the header files, the target system’s memory-map, and program build options.

A project contains files, such as C and assembly source files, libraries, BIOS configuration files, and linker command files. It also contains project settings, such as build options, which include the compiler, assembler, linker, and TI-RTOS, as well as build configurations.

To create a new project, you need to select the following menu items:

File → New → CCS Project

Along with the main Project menu, you can also manage open projects using the right-click popup menu. Either of these menus allows you to modify a project, such as add files to a project, or open the properties of a project to set the build options.
Creating a New CCSv7 Project

A graphical user interface (GUI) is used to assist in creating a new project. The GUI is shown in the slide below.

After a project is created, the build options are configured.
CCSv7 Build Options – Compiler / Linker

Project options direct the code generation tools (i.e. compiler, assembler, linker) to create code according to your system’s needs. When you create a new project, CCS creates two sets of build options – called Configurations: one called Debug, the other Release (you might think of as optimize).

To make it easier to choose build options, CCS provides a graphical user interface (GUI) for the various compiler and linker options. Here’s a sample of the configuration options.

There is a one-to-one relationship between the items in the text box on the main page and the GUI check and drop-down box selections. Once you have mastered the various options, you can probably find yourself just typing in the options.

There are many linker options but these four handle all of the basic needs.

- `-o <filename>` specifies the output (executable) filename.
- `-m <filename>` creates a map file. This file reports the linker’s results.
- `-c` tells the compiler to autoinitialize your global and static variables.
- `-x` tells the compiler to exhaustively read the libraries. Without this option libraries are searched only once, and therefore backwards references may not be resolved.

To help make sense of the many compiler options, TI provides two default sets of options (configurations) in each new project you create. The Release (optimized) configuration invokes the optimizer with –o3 and disables source-level, symbolic debugging by omitting –g (which disables some optimizations to enable debug).
CCS Debug Environment

The basic buttons that control the debug environment are located in the top of CCS:

![CCS Debug Environment Buttons]

The common debugging and program execution descriptions are shown below:

### Start debugging

<table>
<thead>
<tr>
<th>Image</th>
<th>Name</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>New Target Configuration</td>
<td>Creates a new target configuration file.</td>
<td>File New Menu Target Menu</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Debug</td>
<td>Opens a dialog to modify existing debug configurations. Its drop down can be used to access other launching options.</td>
<td>Debug Toolbar Target Menu</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Connect Target</td>
<td>Connect to hardware targets.</td>
<td>TI Debug Toolbar Target Menu Debug View Context Menu</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>Terminate All</td>
<td>Terminates all active debug sessions.</td>
<td>Target Menu Debug View Toolbar</td>
</tr>
</tbody>
</table>
## Program execution

<table>
<thead>
<tr>
<th>Image</th>
<th>Name</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Halt" /></td>
<td>Halt</td>
<td>Halts the selected target. The rest of the debug views will update automatically with most recent target data.</td>
<td>Target Menu Debug View Toolbar</td>
</tr>
<tr>
<td><img src="image" alt="Run" /></td>
<td>Run</td>
<td>Resumes the execution of the currently loaded program from the current PC location. Execution continues until a breakpoint is encountered.</td>
<td>Target Menu Debug View Toolbar</td>
</tr>
<tr>
<td><img src="image" alt="Run to Line" /></td>
<td>Run to Line</td>
<td>Resumes the execution of the currently loaded program from the current PC location. Execution continues until the specific source/assembly line is reached.</td>
<td>Target Menu Disassembly Context Menu Source Editor Context Menu</td>
</tr>
<tr>
<td><img src="image" alt="Go to Main" /></td>
<td>Go to Main</td>
<td>Runs the programs until the beginning of function main is reached.</td>
<td>Debug View Toolbar</td>
</tr>
<tr>
<td><img src="image" alt="Step Into" /></td>
<td>Step Into</td>
<td>Steps into the highlighted statement.</td>
<td>Target Menu Debug View Toolbar</td>
</tr>
<tr>
<td><img src="image" alt="Step Over" /></td>
<td>Step Over</td>
<td>Steps over the highlighted statement. Execution will continue at the next line either in the same method or (if you are at the end of a method) it will continue in the method from which the current method was called. The cursor jumps to the declaration of the method and selects this line.</td>
<td>Target Menu Debug View Toolbar</td>
</tr>
<tr>
<td><img src="image" alt="Step Return" /></td>
<td>Step Return</td>
<td>Steps out of the current method.</td>
<td>Target Menu Debug View Toolbar</td>
</tr>
<tr>
<td><img src="image" alt="Reset" /></td>
<td>Reset</td>
<td>Resets the selected target. The drop-down menu has various advanced reset options, depending on the selected device.</td>
<td>Target Menu Debug View Toolbar</td>
</tr>
<tr>
<td><img src="image" alt="Restart" /></td>
<td>Restart</td>
<td>Restores the PC to the entry point for the currently loaded program. If the debugger option &quot;Run to main on target load or restart&quot; is set the target will run to the specified symbol, otherwise the execution state of the target is not changed.</td>
<td>Target Menu Debug View Toolbar</td>
</tr>
<tr>
<td><img src="image" alt="Assembly Step Into" /></td>
<td>Assembly Step Into</td>
<td>The debugger executes the next assembly instruction, whether source is available or not.</td>
<td>TI Explicit Stepping Toolbar Target Advanced Menu</td>
</tr>
<tr>
<td><img src="image" alt="Assembly Step Over" /></td>
<td>Assembly Step Over</td>
<td>The debugger steps over a single assembly instruction. If the instruction is an assembly subroutine, the debugger executes the assembly subroutine and then halts after the assembly function returns.</td>
<td>TI Explicit Stepping Toolbar Target Advanced Menu</td>
</tr>
</tbody>
</table>
Creating a Linker Command File

Sections

Looking at a C program, you'll notice it contains both code and different kinds of data (global, local, etc.). All code consists of different parts called sections. All default section names begin with a dot and are typically lower case. The compiler has default section names for initialized and uninitialized sections. For example, x and y are global variables, and they are placed in the section .ebss. Whereas 2 and 7 are initialized values, and they are placed in the section called .cinit. The local variables are in a section .stack, and the code is placed in a section called .text.

In the TI code-generation tools (as with any toolset based on the COFF – Common Object File Format), these various parts of a program are called Sections. Breaking the program code and data into various sections provides flexibility since it allows you to place code sections in ROM and variables in RAM. The preceding diagram illustrated four sections:

- Global Variables
- Initial Values for global variables
- Local Variables (i.e. the stack)
- Code (the actual instructions)
The following is a list of the sections that are created by the compiler. Along with their description, we provide the Section Name defined by the compiler. This is a small list of compiler default section names. The top group is initialized sections, and they are linked to flash. In our previous code example, we saw .txt was used for code, and .cinit for initialized values. The bottom group is uninitialized sections, and they are linked to RAM. Once again, in our previous example, we saw .ebss used for global variables and .stack for local variables.

### Compiler Section Names

#### Initialized Sections

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Link Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>.text</td>
<td>code</td>
<td>FLASH</td>
</tr>
<tr>
<td>.cinit</td>
<td>initialization values for global and static variables</td>
<td>FLASH</td>
</tr>
<tr>
<td>.econst</td>
<td>constants (e.g. const int k = 3;)</td>
<td>FLASH</td>
</tr>
<tr>
<td>.switch</td>
<td>tables for switch statements</td>
<td>FLASH</td>
</tr>
<tr>
<td>.pinit</td>
<td>tables for global constructors (C++)</td>
<td>FLASH</td>
</tr>
</tbody>
</table>

#### Uninitialized Sections

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Link Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ebss</td>
<td>global and static variables</td>
<td>RAM</td>
</tr>
<tr>
<td>.stack</td>
<td>stack space</td>
<td>low 64Kw RAM</td>
</tr>
<tr>
<td>.esysmem</td>
<td>memory for far malloc functions</td>
<td>RAM</td>
</tr>
</tbody>
</table>

*Note: During development initialized sections could be linked to RAM since the emulator can be used to load the RAM*

Sections of a C program must be located in different memories in your target system. This is the big advantage of creating the separate sections for code, constants, and variables. In this way, they can all be linked (located) into their proper memory locations in your target embedded system. Generally, they're located as follows:

**Program Code (.text)**

Program code consists of the sequence of instructions used to manipulate data, initialize system settings, etc. Program code must be defined upon system reset (power turn-on). Due to this basic system constraint it is usually necessary to place program code into non-volatile memory, such as FLASH or EPROM.

**Constants (.cinit – initialized data)**

Initialized data are those data memory locations defined at reset. It contains constants or initial values for variables. Similar to program code, constant data is expected to be valid upon reset of the system. It is often found in FLASH or EPROM (non-volatile memory).

**Variables (.ebss – uninitialized data)**

Uninitialized data memory locations can be changed and manipulated by the program code during runtime execution. Unlike program code or constants, uninitialized data or variables must reside in volatile memory, such as RAM. These memories can be modified and updated, supporting the way variables are used in math formulas, high-level languages, etc. Each variable
must be declared with a directive to reserve memory to contain its value. By their nature, no value is assigned, instead they are loaded at runtime by the program.

Next, we need to place the sections that were created by the compiler into the appropriate memory spaces. The uninitialized sections, .ebss and .stack, need to be placed into RAM; while the initialized sections, .cinit, and .text, need to be placed into flash.

### Placing Sections in Memory

<table>
<thead>
<tr>
<th>Memory</th>
<th>Sections</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00 0000</td>
<td>.ebss</td>
</tr>
<tr>
<td>0x00 0400</td>
<td>.stack</td>
</tr>
<tr>
<td>0x08 0000</td>
<td>.cinit</td>
</tr>
<tr>
<td>FLASH (0x40000)</td>
<td>.text</td>
</tr>
</tbody>
</table>

Linking code is a three step process:
1. Defining the various regions of memory (on-chip RAM vs. FLASH vs. External Memory).
2. Describing what sections go into which memory regions
3. Running the linker with “build” or “rebuild”
Linker Command Files (.cmd)

The linker concatenates each section from all input files, allocating memory to each section based on its length and location as specified by the MEMORY and SECTIONS commands in the linker command file. The linker command file describes the physical hardware memory and specifies where the sections are placed in the memory. The file created during the link process is a .out file. This is the file that will be loaded into the microcontroller. As an option, we can generate a map file. This map file will provide a summary of the link process, such as the absolute address and size of each section.

### Memory-Map Description

The MEMORY section describes the memory configuration of the target system to the linker.

The format is: \[Name: \text{origin} = 0x????, \text{length} = 0x????\]

For example, if you placed a 256Kw FLASH starting at memory location 0x080000, it would read:

```
MEMORY
{
  FLASH: origin = 0x080000, length = 0x040000
}
```

Each memory segment is defined using the above format. If you added RAMM0 and RAMM1, it would look like:

```
MEMORY
{
  RAMM0: origin = 0x000000, length = 0x0400
  RAMM1: origin = 0x000400, length = 0x0400
}
```
Remember that the MCU has two memory maps: Program, and Data. Therefore, the MEMORY description must describe each of these separately. The loader uses the following syntax to delineate each of these:

```
<table>
<thead>
<tr>
<th>Linker Page</th>
<th>TI Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page 0</td>
<td>Program</td>
</tr>
<tr>
<td>Page 1</td>
<td>Data</td>
</tr>
</tbody>
</table>
```

A linker command file consists of two sections, a memory section and a sections section. In the memory section, page 0 defines the program memory space, and page 1 defines the data memory space. Each memory block is given a unique name, along with its origin and length. In the sections section, the section is directed to the appropriate memory block.

**Section Placement**

The SECTIONS section will specify how you want the sections to be distributed through memory. The following code is used to link the sections into the memory specified in the previous example:

```
SECTIONS
{
  .text:>    FLASH    PAGE 0
  .ebss:>    RAMM0   PAGE 1
  .cinit:>   FLASH    PAGE 0
  .stack:>   RAMM1   PAGE 1
}
```
The linker will gather all the code sections from all the files being linked together. Similarly, it will combine all 'like' sections.

Beginning with the first section listed, the linker will place it into the specified memory segment.

**Summary: Linker Command File**

The linker command file (.cmd) contains the inputs — commands — for the linker. This information is summarized below:

```
Linker Command File Summary

- Memory Map Description
  - Name
  - Location
  - Size

- Sections Description
  - Directs software sections into named memory regions
  - Allows per-file discrimination
  - Allows separate load/run locations
```
Lab File Directory Structure

- Supporting Files
  - Easier to make projects portable
  - `${PROJECT_ROOT}` provides an anchor point for paths to files that travel with the project
  - Easier to maintain and update supporting files
- Project Source Files
  - All modified files are in the Project Folder
- Other Source Files that are “Added” to the Project Folder
  - Source files for multiple part lab exercises

Note: CCSv7 will automatically add ALL files contained in the folder where the project is created
Lab 2: Linker Command File

Objective

Use a linker command file to link the C program file (Lab2.c) into the system described below.

System Description:
- TMS320F2837x
- All internal RAM blocks allocated

Placement of Sections:
- .text into RAM Block RAMGS0123 on PAGE 0 (program memory)
- .cinit into RAM Block RAMGS0123 on PAGE 0 (program memory)
- .ebss into RAM Block RAMM0 on PAGE 1 (data memory)
- .stack into RAM Block RAMM1 on PAGE 1 (data memory)

Initial Hardware Set Up

Note: The lab exercises in this workshop have been developed and targeted for the F28379D LaunchPad. Optionally, the F28379D Experimenter Kit can be used. Other F2807x or F2837xS development tool kits may be used and might require some minor modifications to the lab code and/or lab directions; however the Inter-Processor Communications lab exercise will require either the F28379D LaunchPad or the F28379D Experimenter Kit. Refer to Appendix A for additional information about the F28379D Experimenter Kit.

- F28379D LaunchPad:

Using the supplied USB cable – plug the USB Standard Type A connector into the computer USB port and the USB Mini Type B connector into the LaunchPad. This will power the LaunchPad using the power supplied by the computer USB port. Additionally, this USB port will provide the JTAG communication link between the device and Code Composer Studio.

At the beginning of the workshop, boot mode switch S1 position 3 must be set to “1 – ON”. This will configure the device for emulation boot mode.

Initial Software Set Up

Code Composer Studio must be installed in addition to the workshop files. A local copy of the required C2000Ware files is included with the lab files. This provides portability, making the
workshop files self-contained and independent of other support files or resources. The lab
directions for this workshop are based on all software installed in their default locations.

➢ Procedure

Start Code Composer Studio and Open a Workspace

1. Start Code Composer Studio (CCS) by double clicking the icon on the desktop or selecting it
   from the Windows Start menu. When CCS loads, a dialog box will prompt you for the
   location of a workspace folder. Use the default location for the workspace and click OK.

   This folder contains all CCS custom settings, which includes project settings and views when
   CCS is closed so that the same projects and settings will be available when CCS is opened
   again. The workspace is saved automatically when CCS is closed.

2. The first time CCS opens an introduction page appears. Close the page by clicking the X on
   the “Getting Started” tab. You should now have an empty workbench. The term “workbench”
   refers to the desktop development environment. Maximize CCS to fill your screen.

   The workbench will open in the CCS Edit perspective view. Notice the “CCS Edit” icon in the
   upper right-hand corner. A perspective defines the initial layout views of the workbench
   windows, toolbars, and menus which are appropriate for a specific type of task (i.e. code
   development or debugging). This minimizes clutter to the user interface. The CCS Edit
   perspective is used to create or build C/C++ projects. A CCS Debug perspective view will
   automatically be enabled when the debug session is started. This perspective is used for
   debugging C/C++ projects.

Setup Target Configuration

3. Open the target configuration dialog box. On the menu bar click:

   File → New → Target Configuration File

   In the file name field type F2837xD.cxml. This is just a descriptive name since multiple
   target configuration files can be created. Leave the “Use shared location” box checked and
   select Finish.

4. In the next window that appears, select the emulator using the “Connection” pull-down list
   and choose “Texas Instruments XDS100v2 USB Debug Probe”. In the “Board or Device” box
   type TMS320F28379D to filter the options. In the box below, check the box to select
   “TMS320F28379D”. Click Save to save the configuration, then close the “F2837xD.cxml”
   setup window by clicking the X on the tab.

5. To view the target configurations, click:

   View → Target Configurations

   and click the plus sign (+) to the left of “User Defined”. Notice that the F2837xD.cxml file is
   listed and set as the default. If it is not set as the default, right-click on the .cxml file and
   select “Set as Default”. Close the Target Configurations window by clicking the X on the tab.

Create a New Project

6. A project contains all the files you will need to develop an executable output file (.out) which
   can be run on the MCU hardware. To create a new project click:

   File → New → CCS Project or click: Project → New CCS Project...
A CCS Project window will open. At the top of this window, filter the “Target” options by using the pull-down list on the left and choose “2837xD Delfino”. In the pull-down list immediately to the right, choose the “TMS320F28379D”.

Leave the “Connection” box blank. We have already set up the target configuration.

7. The next section selects the project settings. In the Project name field type **Lab2**. **Uncheck** the “Use default location” box. Click the Browse... button and navigate to:

C:\C28x\Labs\Lab2\cpu01

Click OK.

8. Next, open the “Advanced setting” section and set the “Linker command file” to “<none>”. We will be using our own linker command file rather than the one supplied by CCS. Leave the “Runtime Support Library” set to “<automatic>”. This will automatically select the “rts2800_fpu32.lib” runtime support library for floating-point devices.

9. Then, open the “Project templates and examples” section and select the “Empty Project” template. Click Finish.

10. A new project has now been created. Notice the Project Explorer window contains Lab2. If the workbench is empty, reset the perspective view by clicking:

Window → Perspective → Reset Perspective...

The project is set “Active” and the output files will be located in the “Debug” folder. At this point, the project does not include any source files. The next step is to add the source files to the project.

11. To add the source files to the project, right-click on Lab2 in the Project Explorer window and select:

Add Files...

or click: Project → Add Files...

and make sure you’re looking in C:\C28x\Labs\Lab2\source. With the “files of type” set to view all files (*.*) select Lab2.c and Lab2.cmd then click OPEN. A “File Operation” window will open, choose “Copy files” and click OK. This will add the files to the project.

12. In the Project Explorer window, click the plus sign (+) to the left of Lab2 and notice that the files are listed.

**Project Build Options**

13. There are numerous build options in the project. Most default option settings are sufficient for getting started. We will inspect a couple of the default options at this time. Right-click on Lab2 in the Project Explorer window and select Properties or click:

Project → Properties

14. A “Properties” window will open and in the section on the left under “Build” be sure that the “C2000 Compiler” and “C2000 Linker” options are visible. Next, under “C2000 Linker” select the “Basic Options”. Notice that .out and .map files are being specified. The .out file is the executable code that will be loaded into the MCU. The .map file will contain a linker report showing memory usage and section addresses in memory. Also notice the stack size is set to 0x200.

15. Under “C2000 Compiler” select the “Processor Options”. Notice the large memory model and unified memory boxes are checked. Next, notice the “Specify CLA support” is set to
clal, the “Specify floating point support” is set to fpu32, the “Specify TMU support” is set to TMU0, and the “Specify VCU support” is set to vcu2. Select OK to close the Properties window.

**Linker Command File – Lab2.cmd**

16. Open and inspect Lab2.cmd by double clicking on the filename in the Project Explorer window. Notice that the Memory{} declaration describes the system memory shown on the “Lab2: Linker Command File” slide in the objective section of this lab exercise. Memory blocks RAMLS4, RAMLS5 and RAMGS0123 have been placed in program memory on page 0, and the other memory blocks have been placed in data memory on page 1.

17. In the Sections{} area notice that the sections defined on the slide have been “linked” into the appropriate memories. Also, notice that a section called .reset has been allocated. The .reset section is part of the rts2800_fpu32.lib and is not needed. By putting the TYPE = DSECT modifier after its allocation the linker will ignore this section and not allocate it. Close the inspected file.

**Build and Load the Project**

18. Two buttons on the horizontal toolbar control code generation. Hover your mouse over each button as you read the following descriptions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Build</td>
<td>Full build and link of all source files</td>
</tr>
<tr>
<td>2</td>
<td>Debug</td>
<td>Automatically build, link, load and launch debug-session</td>
</tr>
</tbody>
</table>

19. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window (we have deliberately put an error in Lab2.c). When you get an error, you will see the error message in the Problems window. Expand the error by clicking on the plus sign (+) to the left of the “Errors”. Then simply double-click the error message. The editor will automatically open to the source file containing the error, with the code line highlighted with a red circle with a white “x” inside of it.

20. Fix the error by adding a semicolon at the end of the “z = x + y” statement. For future knowledge, realize that a single code error can sometimes generate multiple error messages at build time. This was not the case here.

21. Build the project again. There should be no errors this time.

22. CCS can automatically save modified source files, build the program, open the debug perspective view, connect and download it to the target, and then run the program to the beginning of the main function.

Click on the “Debug” button (green bug) or click RUN → Debug

A Launching Debug Session window will open. Select only CPU1 to load the program on (i.e. uncheck CPU2), and then click OK.

Notice the “CCS Debug” icon in the upper right-hand corner indicating that we are now in the CCS Debug perspective view. The program ran through the C-environment initialization routine in the rts2800_fpu32.lib and stopped at main() in Lab2.c.
Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There are various methods for doing this in Code Composer Studio. We will examine two of them here: memory browser, and expressions.

23. Open a “Memory Browser” to view the global variable “z”.

   Click: View → Memory Browser on the menu bar.

   Type &z into the address field, select “Data” memory page, and then <enter>. Note that you must use the ampersand (meaning “address of”) when using a symbol in a memory browser address box. Also note that CCS is case sensitive.

   Set the properties format to “16-Bit Hex – TI Style” in the browser. This will give you more viewable data in the browser. You can change the contents of any address in the memory browser by double-clicking on its value. This is useful during debug.

24. Notice the “Variables” window automatically opened and the local variables x and y are present. The variables window will always contain the local variables for the code function currently being executed.

   (Note that local variables actually live on the stack. You can also view local variables in a memory browser by setting the address to “SP” after the code function has been entered).

25. We can also add global variables to the “Expressions” window if desired. Let's add the global variable “z”.

   Click the “Expressions” tab at the top of the window. In the empty box in the “Expression” column (Add new expression), type z and then <enter>. An ampersand is not used here. The expressions window knows you are specifying a symbol. (Note that the expressions window can be manually opened by clicking: View → Expressions on the menu bar).

   Check that the expressions window and memory browser both report the same value for “z”. Try changing the value in one window, and notice that the value also changes in the other window.

Single-stepping the Code

26. Click the “Variables” tab at the top of the window to watch the local variables. Single-step through main() by using the <F5> key (or you can use the “Step Into” button on the horizontal toolbar). Check to see if the program is working as expected. What is the value for “z” when you get to the end of the program?

Terminate Debug Session and Close Project

27. The “Terminate” button will terminate the active debug session, close the debugger and return Code Composer Studio to the CCS Edit perspective view.

   Click: Run → Terminate or use the Terminate icon:  

28. Next, close the project by right-clicking on Lab2 in the Project Explorer window and select Close Project.

End of Exercise
Peripheral Registers Header Files

Introduction

The purpose of the F2837xD C-code header files is to simplify the programming of the many peripherals on the F28x device. Typically, to program a peripheral the programmer needs to write the appropriate values to the different fields within a control register. In its simplest form, the process consists of writing a hex value (or masking a bit field) to the correct address in memory. But, since this can be a burdensome and repetitive task, the C-code header files were created to make this a less complicated task.

The F2837xD C-code header files are part of a library consisting of C functions, macros, peripheral structures, and variable definitions. Together, this set of files is known as the 'header files.'

Registers and the bit-fields are represented by structures. C functions and macros are used to initialize or modify the structures (registers).

In this module, you will learn how to use the header files and C programs to facilitate programming the peripherals.

Module Objectives

- Review Register Programming Model
- Understand the usage of the F2837xD C-Code Header Files
- Be able to program peripheral registers
- Understand how the structures are mapped with the linker command file
Chapter Topics

Peripheral Registers Header Files............................................................................................ 3-1

  Register Programming Model .............................................................................................. 3-3

  Traditional and Structure Approach to C Coding ................................................................. 3-5

Naming Conventions.................................................................................................................. 3-9

F2837xD C-Code Header Files.................................................................................................. 3-11

  Peripheral Structure .h File ................................................................................................. 3-11

  Global Variable Definitions File ......................................................................................... 3-13

  Mapping Structures to Memory ......................................................................................... 3-14

  Linker Command File ......................................................................................................... 3-14

  Peripheral Specific Routines ............................................................................................... 3-15

Summary .................................................................................................................................. 3-16
The various levels of the programming model provide different degrees of abstraction. The highest level is DriverLib which are C functions that automatically set the bit fields. This gives you the least amount of flexibility in exchange for a reduced learning curve and simplified programming. The bit field header files are C structures that allow registers to be accessed whole or by bits and bit fields, and modified without masking. This provides a nice balance between ease of use and flexibility when working with Code Composer Studio. Direct register access is the lowest level where the user code, in C or assembly, defines and access register addresses.
The above slide provides a comparison of each programming model, from the lowest level to the highest level of abstraction. With direct register access, the register addresses are #defined individually and the user must compute the bit-field mask. The bit field header files define all registers as structures and the bit fields are directly accessible. DriverLib performs low-level register manipulation and provides the highest level of abstraction. This workshop makes use of the bit field header files, which provides a balance between ease of use and flexibility. Device support packages can be downloaded from www.ti.com.
In the traditional approach to C coding, we used a #define to assign the address of the register and referenced it with a pointer. The first line of code on this slide we are writing to the entire register with a 16-bit value. The second line, we are ORing a bit field.

Advantages? Simple, fast, and easy to type. The variable names can exactly match the register names, so it's easy to remember. Disadvantages? Requires individual masks to be generated to manipulate individual bits, it cannot easily display bit fields in the debugger window, and it will generate less efficient code in many cases.
Structure Approach to C Coding

```c
void main(void)
{
    EPwm1Regs.TBCTL.all = 0x1234;    //write entire register
    EPwm1Regs.TBCTL.bit.CTRMODE = 3; //stop time-base counter
}
```

Advantages
- Easy to manipulate individual bits
- Watch window is amazing! (next slide)
- Generates most efficient code (on C28x)

Disadvantages
- Can be difficult to remember the structure names (Editor Auto Complete feature to the rescue!)
- More to type (again, Editor Auto Complete feature to the rescue)

The structure approach to C coding uses the peripheral register header files. First, a peripheral is specified, followed by a control register. Then you can modify the complete register or selected bits. This is almost self-commented code.

The first line of code on this slide we are writing to the entire register. The second line of code we are modifying a bit field. Advantages? Easy to manipulate individual bits, it works great with our tools, and will generate the most efficient code. Disadvantages? Can be difficult to remember the structure names and more to type; however, the edit auto complete feature of Code Composer Studio will eliminate these disadvantages.
Register values can be viewed using the built-in Register Window. Also, the peripheral can be added to the expression window. In addition to viewing register values, individual bit fields can be modified. There is no need to refer to the reference guide to identify the bit field settings.
### Is the Structure Approach Efficient?

The structure approach enables efficient compiler use of DP addressing mode and C28x atomic operations.

<table>
<thead>
<tr>
<th>C Source Code</th>
<th>Generated Assembly Code*</th>
</tr>
</thead>
<tbody>
<tr>
<td>// Stop CPU Timer0</td>
<td>MOVW DF, #0030</td>
</tr>
<tr>
<td>CpuTimer0Regs.TCR.bit.TSS = 1;</td>
<td>OR @4, #0x0010</td>
</tr>
<tr>
<td>// Load new 32-bit period value</td>
<td>MOVL XAR4, #0x010000</td>
</tr>
<tr>
<td>CpuTimer0Regs.PRD.all = 0x00010000;</td>
<td>MOVL @2, XAR4</td>
</tr>
<tr>
<td>// Start CPU Timer0</td>
<td>AND @4, #0xFFEF</td>
</tr>
<tr>
<td>CpuTimer0Regs.TCR.bit.TSS = 0;</td>
<td></td>
</tr>
</tbody>
</table>

**- Easy to read the code w/o comments**
**- Bit mask built-in to structure**

You could not have coded this example any more efficiently with hand assembly!

* C28x Compiler v5.0.1 with -g and either -o1, -o2, or -o3 optimization level

### Compare with the #define Approach

The #define approach relies heavily on less-efficient pointers for random memory access, and often does not take advantage of C28x atomic operations.

<table>
<thead>
<tr>
<th>C Source Code</th>
<th>Generated Assembly Code*</th>
</tr>
</thead>
<tbody>
<tr>
<td>// Stop CPU Timer0</td>
<td>MOV @AL, *(0:0x0C04)</td>
</tr>
<tr>
<td>*TIMER0TCR</td>
<td>= 0x0010;</td>
</tr>
<tr>
<td>// Load new 32-bit period value</td>
<td>MOVL XAR5, #0x010000</td>
</tr>
<tr>
<td>*TIMER0TPRD32 = 0x00010000;</td>
<td>MOVL XAR4, #0x00000000</td>
</tr>
<tr>
<td>// Start CPU Timer0</td>
<td>MOVL *(+XAR4[0]), XAR5</td>
</tr>
<tr>
<td>*TIMER0TCR &amp;= 0xFFEF;</td>
<td>MOVL @AL, *(0:0x0C04)</td>
</tr>
<tr>
<td></td>
<td>AND @AL, #0x00FF00</td>
</tr>
<tr>
<td></td>
<td>MOVL *(0:0x0C04), @AL</td>
</tr>
</tbody>
</table>

**- Hard to read the code w/o comments**
**- User had to determine the bit mask**

* C28x Compiler v5.0.1 with -g and either -o1, -o2, or -o3 optimization level
The header files use a familiar set of naming conventions. They are consistent with the Code Composer Studio configuration tool, and generated file naming conventions.

## Structure Naming Conventions

- The F2837xD header files define:
  - All of the peripheral structures
  - All of the register names
  - All of the bit field names
  - All of the register addresses

```plaintext
PeripheralName.RegisterName.all // Access full 16 or 32-bit register
PeripheralName.RegisterName.bit.FieldName // Access specified bit fields of register
```

Notes:
- [1] “PeripheralName” are assigned by TI and found in the F2837xD header files. They are a combination of capital and small letters (i.e. CpuTimer0Regs).
- [2] “RegisterName” are the same names as used in the data sheet. They are always in capital letters (i.e. TCR, TIM, TPR,...).
- [3] “FieldName” are the same names as used in the data sheet. They are always in capital letters (i.e. POL, TOG, TSS,...).

The header files define all of the peripheral structures, all of the register names, all of the bit field names, and all of the register addresses. The most common naming conventions used are PeripheralName.RegisterName.all, which will access the full 16 or 32-bit register; and PeripheralName.RegisterName.bit.FieldName, which will access the specified bit fields of a register.
Editor Auto Complete to the Rescue!

The editor auto complete feature works as follows. First, you type EPwm1Regs. Then, when you type a "." a window opens up, allowing you to select a control register. In this example TBCTL is selected. Then, when you type the "." a window opens up, allowing you to select "all" or "bit". In this example "bit" is selected. Then, when you type the "." a window opens up, allowing you to select a bit field. In this example CTRMODE is selected. And now, the structure is completed.
F2837xD C-Code Header Files

The F2837xD header file package contains everything needed to use the structure approach. It defines all the peripheral register bits and register addresses. The header file package includes the header files, linker command files, code examples, and documentation. The header file package is available from C2000Ware.

F2837xD Header File Package
(http://www.ti.com, C2000Ware)

- Contains everything needed to use the structure approach
- Defines all peripheral register bits and register addresses
- Header file package includes:
  - `\F2837xD_headers\include` ➔ .h files
  - `\F2837xD_headers\cmd` ➔ linker .cmd files
  - `\F2837xD_examples` ➔ CCS examples
  - `\doc` ➔ documentation

C2000Ware Header File Package located at –
C:\ti\c2000\C2000Ware_<version>\device_support\n
A peripheral is programmed by writing values to a set of registers. Sometimes, individual fields are written to as bits, or as bytes, or as entire words. Unions are used to overlap memory (register) so the contents can be accessed in different ways. The header files group all the registers belonging to a specific peripheral.

Peripheral data structures can be added to the watch window by right-clicking on the structure and selecting the option to add to watch window. This will allow viewing of the individual register fields.

Peripheral Structure .h File

The F2837xD_Device.h header file is the main include file. By including this file in the .c source code, all of the peripheral specific .h header files are automatically included. Of course, each specific .h header file can be included individually in an application that does not use all the header files, or you can comment out the ones you do not need. (Also includes typedef statements).
Next, we will discuss the steps needed to use the header files with your project. The .h files contain the bit field structure definitions for each peripheral register.

**Peripheral Structure .h files (2 of 2)**

- The header file package contains a .h file for each peripheral in the device

<table>
<thead>
<tr>
<th>F2837xD_adc.h</th>
<th>F2837xD_emif.h</th>
<th>F2837xD_mmintrupt.h</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2837xD_analogsbsys.h</td>
<td>F2837xD_epwm.h</td>
<td>F2837xD_output_xbar.h</td>
</tr>
<tr>
<td>F2837xD_can.h</td>
<td>F2837xD_mmiintrupt.h</td>
<td></td>
</tr>
<tr>
<td>F2837xD_cla.h</td>
<td>F2837xD_pcictrl.h</td>
<td></td>
</tr>
<tr>
<td>F2837xD_cmpss.h</td>
<td>F2837xD_spi.h</td>
<td></td>
</tr>
<tr>
<td>F2837xD_cputimer.h</td>
<td>F2837xD_sdmf.h</td>
<td></td>
</tr>
<tr>
<td>F2837xD_dac.h</td>
<td>F2837xD_sysctrl.h</td>
<td></td>
</tr>
<tr>
<td>F2837xD_dcsms.h</td>
<td>F2837xD_xbar.h</td>
<td></td>
</tr>
<tr>
<td>F2837xD_device.h</td>
<td>F2837xD_xbar.h</td>
<td></td>
</tr>
<tr>
<td>F2837xD_dma.h</td>
<td>F2837xD_xbar.h</td>
<td></td>
</tr>
<tr>
<td>F2837xD_ecap.h</td>
<td>F2837xD_xbar.h</td>
<td></td>
</tr>
</tbody>
</table>

- **F2837xD_device.h**
  - Main include file
  - Will include all other .h files
  - Include this file (directly or indirectly) in each source file:

    ```
    #include "F2837xD_device.h"
    ```

The header file package contains a .h file for each peripheral in the device. The F2837xD_Device.h file is the main include file. It will include all of the other .h files. There are
three steps needed to use the header files. The first step is to include this file directly or indirectly in each source files.

## Global Variable Definitions File

With F2837xD_GlobalVariableDefs.c included in the project all the needed variable definitions are globally defined.

### Global Variable Definitions File

**F2837xD_GlobalVariableDefs.c**

- Declares a global instantiation of the structure for each peripheral
- Each structure is placed in its own section using a DATA_SECTION pragma to allow linking to the correct memory (see next slide)

```c
#include "F2837xD_device.h"
...
#pragma DATA_SECTION(EPwm1Regs,"EPwm1RegsFile");
volatile struct EPWM_REGS EPwm1Regs;
...
```

- Add this file to your CCS project:  
  **F2837xD_GlobalVariableDefs.c**

The global variable definition file declares a global instantiation of the structure for each peripheral. Each structure is placed in its own section using a DATA_SECTION pragma to allow linking to the correct memory. The second step for using the header files is to add F2837xD_GlobalVariableDefs.c file to your project.
Mapping Structures to Memory

The data structures describe the register set in detail. And, each instance of the data type (i.e., register set) is unique. Each structure is associated with an address in memory. This is done by (1) creating a new section name via a DATA_SECTION pragma, and (2) linking the new section name to a specific memory in the linker command file.

Linker Command Files for the Structures

- Links each structure to the address of the peripheral using the structures named section
- non-BIOS and BIOS versions of the .cmd file
- Add one of these files to your CCS project:
  - F2837xD_nonBIOS.cmd
  - F2837xD_BIOS.cmd

The header file package has two linker command file versions; one for non-BIOS projects and one for BIOS projects. This linker command file is used to link each structure to the address of the peripheral using the structures named section. The third and final step for using the header files is to add the appropriate linker command file to your project.

Linker Command File

When using the header files, the user adds the MEMORY regions that correspond to the CODE_SECTION and DATA_SECTION pragmas found in the .h and global-defintions.c file.

The user can modify their own linker command file, or use a pre-configured linker command file such as F28075.cmd. This file has the peripheral memory regions defined and tied to the individual peripheral.
Peripheral Specific Routines

Peripheral Specific C functions are used to initialize the peripherals. They are used by adding the appropriate .c file to the project.

Peripheral Specific Examples

◆ Example projects for each peripheral
◆ Helpful to get you started

The peripheral register header file package includes example projects for each peripheral. This can be very helpful to getting you started.
In summary, the peripheral register header files allow for easier code development, they are easy to use, generates the most efficient code, works great with Code Composer Studio, and TI has already done the work for you. Just make sure to use the correct header file package for your device.
Reset and Interrupts

Introduction

This module covers the interrupt process and explains how the Peripheral Interrupt Expansion (PIE) is used to service the peripheral interrupts.

Module Objectives

- Describe the F28x reset process
- List the event sequence during an interrupt
- Describe the F28x interrupt structure
# Chapter Topics

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reset and Interrupts</strong></td>
<td>4-1</td>
</tr>
<tr>
<td><strong>Reset and Boot Process</strong></td>
<td>4-3</td>
</tr>
<tr>
<td>Reset - Bootloader</td>
<td>4-5</td>
</tr>
<tr>
<td>Emulation Boot Mode</td>
<td>4-6</td>
</tr>
<tr>
<td>Stand-Alone Boot Mode</td>
<td>4-7</td>
</tr>
<tr>
<td>Reset Code Flow – Summary</td>
<td>4-8</td>
</tr>
<tr>
<td>Emulation Boot Mode using Code Composer Studio GEL</td>
<td>4-8</td>
</tr>
<tr>
<td>Getting to main()</td>
<td>4-9</td>
</tr>
<tr>
<td>Peripheral Software Reset Registers</td>
<td>4-10</td>
</tr>
<tr>
<td><strong>Interrupts</strong></td>
<td>4-11</td>
</tr>
<tr>
<td>Interrupt Processing</td>
<td>4-12</td>
</tr>
<tr>
<td>Interrupt Flag Register (IFR)</td>
<td>4-13</td>
</tr>
<tr>
<td>Interrupt Enable Register (IER)</td>
<td>4-13</td>
</tr>
<tr>
<td>Interrupt Global Mask Bit (INTM)</td>
<td>4-14</td>
</tr>
<tr>
<td>Peripheral Interrupt Expansion (PIE)</td>
<td>4-14</td>
</tr>
<tr>
<td>PIE Block Initialization</td>
<td>4-17</td>
</tr>
<tr>
<td>Interrupt Signal Flow – Summary</td>
<td>4-19</td>
</tr>
<tr>
<td>F2837xD Dual-Core Interrupt Structure</td>
<td>4-20</td>
</tr>
<tr>
<td>Interrupt Response and Latency</td>
<td>4-21</td>
</tr>
</tbody>
</table>
Reset and Boot Process

Reset Sources

- **POR** – *Power-on Reset* generates a device reset during power-up conditions
- **RESC** – *Reset Cause* register contains the cause of the last reset (sticky bits maintain state with multiple resets)

*Note:* Only F2807x devices support an on-chip voltage regulator (*VREG*) to generate the core voltage.

The device has various reset sources, but in general resets on CPU1 will reset the entire device and resets on CPU2 will reset only the CPU2 subsystem. The reset sources include an external reset pin, watchdog timer reset, power-on reset which generates a device reset during power-up conditions, Hibernate reset, as well as a missing clock detect reset. A reset cause register (RESC) is available for each CPU subsystem which can be read to determine the cause of the reset. The external reset pin is the main chip-level reset for the device, and it resets both CPU subsystems to their default state. The power-on reset (POR) circuit is used to create a clean reset throughout the device during power-up, while suppressing glitches on the input/output pins. Note, only the F2807x devices support an on-chip voltage regulator to generate the core voltage.
During the F2837xD dual-core microcontroller booting, CPU1 controls the boot process and starts execution from the CPU1 boot ROM while CPU2 is held in reset. CPU2 goes through its own boot process under the control of CPU1, except when CPU2 is set to boot-to-flash. The IPC registers are used to communicate between CPU1 and CPU2 during the boot process. Additionally, the boot ROM contains the necessary boot loading routines to support peripheral boot loading.
Reset and Boot Process

Reset - Bootloader

When the device is reset, the peripheral interrupt expansion block, also known as the PIE block, and the master interrupt switch INTM are disabled. This prevents any interrupts during the boot process. The program counter is set to 0x3FFFC0, where the reset vector is fetched. In the boot code the JTAG Test Reset line (TRST line) is checked to determine if the emulator is connected.

If the emulator is connected, then the boot process follows the Emulation Boot mode flow. In Emulation Boot mode, the boot is determined by the EMU_BOOTCTRL register located in the PIE RAM. Specific details about the boot flow are then determined by the EMU_KEY and EMU_BMODE bit fields in the EMU_BOOTCTRL register.

If the emulator is not connected, the boot process follows the Stand-alone Boot mode flow. In Stand-alone Boot mode, the boot is determined by two GPIO pins and the Z1-BOOTCTRL and Z2-BOOTCTRL registers located in the OTP. Specific details about the boot flow are then determined by the OTP_KEY and OTP_BMODE bit fields in the Z1-BOOTCTRL and Z2-BOOTCTRL registers.
In Emulation Boot mode, first the EMU_KEY bit fields are checked for a value of 0x5A. If either EMU_KEY or EMU_BMODE bit fields are invalid, the "Wait" boot mode is entered. These bit field values can then be modified using the debugger and then a reset is issued to restart the boot process.
process. This is the typical sequence followed during device power-up with the emulator connected, allowing the user to control the boot process using the debugger.

Once the EMU_KEY bit fields are set to 0x5A, then the EMU_BMODE bit field values determines the boot mode. The various Emulation Boot modes supported are Parallel I/O, SCI, SPI, I2C, CAN, M0 RAM, FLASH, USB, and Wait. The GetMode and when EMU_BMODE bit fields have a value of 0xFE or 0xFF are used to emulate the Stand-alone Boot mode.

### Stand-Alone Boot Mode

In Stand-alone boot mode, first GPIO pins 72 and 84 are checked to determine if the boot mode is Parallel I/O, SCI, Wait, or GetMode. These pin can be remapped to any GPIO pins, if needed, and the default “unconnected” pins set the boot mode to GetMode. In GetMode the OTP_KEY bit fields in the Z1-BOOTCTRL and Z2-BOOTCTRL registers are checked for a value of 0x5A. An un-programmed device will have these locations set as 1’s, and the flash boot mode is entered, as expected for the default mode. If the OTP_KEY bit fields in either Z1-BOOTCTRL or Z2-BOOTCTRL registers has a value of 0x5A, then the OTP_BMODE bit field values in the registers determines the boot mode. The various Stand-alone Boot modes supported are Parallel I/O, SCI, SPI, I2C, CAN, M0 RAM, FLASH, USB, and Wait.
Reset Code Flow – Summary

In summary, the reset code flow is as follows. After reset, the program counter is set to 0x3FFFC0, where the flow is vectored to the Init_Boot code in the Boot ROM. The Init_Boot code defines the execution entry based on emulation boot mode or stand-alone boot mode. The entry point can be executing boot-loading routines, entry to the flash, or M0 RAM.

![Reset Code Flow - Summary Diagram]

* reset vector = 0x3FF16A for CPU1; 0x3FEC52 for CPU2

Emulation Boot Mode using Code Composer Studio GEL

The CCS GEL file is used to setup the boot modes for the device during debug. By default the GEL file provides functions to set the device for "Boot to SARAM" and "Boot to FLASH". It can be modified to include other boot mode options, if desired.

```c
 פוסט to EMU Boot Mode Select hotmenu EMU_BOOT_SARAM()
{
    *0xD00 = 0x0A5A;
}
hotmenu EMU_BOOT_FLASH()
{
    *0xD00 = 0x0B5A;
}
```

To access the GEL file use: Tools → GEL Files
Getting to main()

After reset how do we get to main()?

- At the code entry point, branch to _c_int00()
  - Part of compiler runtime support library
  - Sets up compiler environment
  - Calls main()

After reset how do we get to main? When the bootloader process is completed, a branch to the compiler runtime support library is located at the code entry point. This branch to _c_int00 is executed, then the compiler environment is set up, and finally main is called.
Peripheral Software Reset Registers

<table>
<thead>
<tr>
<th>Register</th>
<th>PeripheralName</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOFTPRES0</td>
<td>CPU1_CLA1, CPU2_CLA1</td>
</tr>
<tr>
<td>SOFTPRES1</td>
<td>EMIF1, EMIF2</td>
</tr>
<tr>
<td>SOFTPRES2</td>
<td>EPWM1, EPWM2, EPWM3, EPWM4, EPWM5, EPWM6, EPWM7, EPWM8, EPWM9, EPWM10, EPWM11, EPWM12</td>
</tr>
<tr>
<td>SOFTPRES3</td>
<td>ECAP1, ECAP2, ECAP3, ECAP4, ECAP5, ECAP6</td>
</tr>
<tr>
<td>SOFTPRES4</td>
<td>EQEP1, EQEP2, EQEP3</td>
</tr>
<tr>
<td>SOFTPRES5</td>
<td>SD1, SD2</td>
</tr>
<tr>
<td>SOFTPRES6</td>
<td>SCI_A, SCI_B, SCI_C, SCI_D</td>
</tr>
<tr>
<td>SOFTPRES7</td>
<td>SPI_A, SPI_B, SPI_C</td>
</tr>
<tr>
<td>SOFTPRES8</td>
<td>DC_A, DC_B</td>
</tr>
<tr>
<td>SOFTPRES11</td>
<td>McBSP_A, McBSP_B, USB_A</td>
</tr>
<tr>
<td>SOFTPRES13</td>
<td>ADC_A, ADC_B, ADC_C, ADC_D</td>
</tr>
<tr>
<td>SOFTPRES14</td>
<td>CMPSS1, CMPSS2, CMPSS3, CMPSS4, CMPSS5, CMPSS6, CMPSS7, CMPSS8</td>
</tr>
<tr>
<td>SOFTPRES16</td>
<td>DAC_A, DAC_B, DAC_C</td>
</tr>
</tbody>
</table>

The peripheral software reset register contains the reset bit for each peripheral.
The internal interrupt sources include the general purpose timers 0, 1, and 2, and all of the peripherals on the device. External interrupt sources include the three external interrupt lines, the trip zones, and the external reset pin. The core has 14 interrupt lines. The Peripheral Interrupt Expansion block, known as the PIE block, is connected to the core interrupt lines 1 through 12 and is used to expand the core interrupt capability, allowing up to 192 possible interrupt sources.
Interrupt Processing

Maskable Interrupt Processing

Conceptual Core Overview

<table>
<thead>
<tr>
<th>Core Interrupt</th>
<th>(IFR) “Latch”</th>
<th>(IER) “Switch”</th>
<th>(INTM) “Global Switch”</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT2</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT14</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- A valid signal on a specific interrupt line causes the latch to display a “1” in the appropriate bit
- If the individual and global switches are turned “on” the interrupt reaches the core

By using a series of flag and enable registers, the CPU can be configured to service one interrupt while others remain pending, or perhaps disabled when servicing certain critical tasks. When an interrupt signal occurs on a core line, the interrupt flag register (IFR) for that core line is set. If the appropriate interrupt enable register (IER) is enabled for that core line, and the interrupt global mask (INTM) is enabled, the interrupt signal will propagate to the core. Once the interrupt service routine (ISR) starts processing the interrupt, the INTM bit is disabled to prevent nested interrupts. The IFR is then cleared and ready for the next interrupt signal. When the interrupt servicing is completed, the INTM bit is automatically enabled, allowing the next interrupt to be serviced. Notice that when the INTM bit is ‘0’, the “switch” is closed and enabled. When the bit is ‘1’, the “switch” is open and disabled. The IER is managed by ORing and ANDing mask values. The INTM bit in the status register is managed by using in-line assembly instructions.
Interrupts

Interrupt Flag Register (IFR)

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTOSINT</td>
<td>DLOGINT</td>
<td>INT14</td>
<td>INT13</td>
<td>INT12</td>
<td>INT11</td>
<td>INT10</td>
<td>INT9</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>INT8</td>
<td>INT7</td>
<td>INT6</td>
<td>INT5</td>
<td>INT4</td>
<td>INT3</td>
<td>INT2</td>
<td>INT1</td>
</tr>
</tbody>
</table>

Pending : IFR Bit = 1
Absent : IFR Bit = 0

/*** Manual setting/clearing IFR ***/
extern cregister volatile unsigned int IFR;
IFR |= 0x0008; //set INT4 in IFR
IFR &= 0xFFF7; //clear INT4 in IFR

- Compiler generates atomic instructions (non-interruptible) for setting/clearing IFR
- If interrupt occurs when writing IFR, interrupt has priority
- IFR(bit) cleared when interrupt is acknowledged by CPU
- Register cleared on reset

Interrupt Enable Register (IER)

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTOSINT</td>
<td>DLOGINT</td>
<td>INT14</td>
<td>INT13</td>
<td>INT12</td>
<td>INT11</td>
<td>INT10</td>
<td>INT9</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>INT8</td>
<td>INT7</td>
<td>INT6</td>
<td>INT5</td>
<td>INT4</td>
<td>INT3</td>
<td>INT2</td>
<td>INT1</td>
</tr>
</tbody>
</table>

Enable: Set IER Bit = 1
Disable: Clear IER Bit = 0

/*** Interrupt Enable Register ***/
extern cregister volatile unsigned int IER;
IER |= 0x0008; //enable INT4 in IER
IER &= 0xFFF7; //disable INT4 in IER

- Compiler generates atomic instructions (non-interruptible) for setting/clearing IER
- Register cleared on reset
Interrupt Global Mask Bit (INTM)

- INTM used to globally enable/disable interrupts:
  - Enable: INTM = 0
  - Disable: INTM = 1 (reset value)
- INTM modified from assembly code only:

```c
/*** Global Interrupts ***/
asm("CLRC INTM"); // enable global interrupts
asm("SETC INTM"); // disable global interrupts
```

Peripheral Interrupt Expansion (PIE)

The C28x CPU core has a total of fourteen interrupt lines, of which two interrupt lines are directly connected to CPU Timers 1 and 2 (on INT13 and INT14, respectively) and the remaining twelve
Interrupts

Interrupt lines (INT1 through INT12) are used to service the peripheral interrupts. A Peripheral Interrupt Expansion (PIE) module multiplexes up to sixteen peripheral interrupts into each of the twelve CPU interrupt lines, further expanding support for up to 192 peripheral interrupt signals. The PIE module also expands the interrupt vector table, allowing each unique interrupt signal to have its own interrupt service routine (ISR), permitting the CPU to support a large number of peripherals.

The PIE module has an individual flag and enable bit for each peripheral interrupt signal. Each of the sixteen peripheral interrupt signals that are multiplexed into a single CPU interrupt line is referred to as a “group”, so the PIE module consists of 12 groups. Each PIE group has a 16-bit flag register (PIEIFR), a 16-bit enable register (PIEIER), and a bit field in the PIE acknowledge register (PIEACK) which acts as a common interrupt mask for the entire group. For a peripheral interrupt to propagate to the CPU, the appropriate PIEIFR must be set, the PIEIER enabled, the CPU IFR set, the IER enabled, and the INTM enabled. Note that some peripherals can have multiple events trigger the same interrupt signal, and the cause of the interrupt can be determined by reading the peripheral’s status register.

We have already discussed the interrupt process in the core. Now we need to look at the peripheral interrupt expansion block. This block is connected to the core interrupt lines 1 through 12. The PIE block consists of 12 groups. Within each group, there are sixteen interrupt sources. Each group has a PIE interrupt enable register and a PIE interrupt flag register. Note that interrupt lines 13, 14, and NMI bypass the PIE block.

<table>
<thead>
<tr>
<th>F2837xD PIE Assignment Table - Lower</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTx.8</td>
</tr>
<tr>
<td>INT1</td>
</tr>
<tr>
<td>INT2</td>
</tr>
<tr>
<td>INT3</td>
</tr>
<tr>
<td>INT4</td>
</tr>
<tr>
<td>INT5</td>
</tr>
<tr>
<td>INT6</td>
</tr>
<tr>
<td>INT7</td>
</tr>
<tr>
<td>INT8</td>
</tr>
<tr>
<td>INT9</td>
</tr>
<tr>
<td>INT10</td>
</tr>
<tr>
<td>INT11</td>
</tr>
<tr>
<td>INT12</td>
</tr>
</tbody>
</table>

The PIE assignment table maps each peripheral interrupt to the unique vector location for that interrupt service routine. Notice the interrupt numbers on the left represent the twelve core group interrupt lines and the interrupt numbers across the top represent the lower eight of the sixteen peripheral interrupts within the core group interrupt line. The next figure shows the upper eight of the sixteen peripheral interrupts within the core group interrupt line.
Similar to the core interrupt process, the PIE module has an individual flag and enable bit for each peripheral interrupt signal. Each PIE group has a 16-bit flag register, a 16-bit enable register, and a bit field in the PIE acknowledge register which acts as a common interrupt mask for the entire group. The enable PIE bit in the PIECTRL register is used to activate the PIE module.

PIE Registers

**PIEIFRx register**  \((x = 1 \text{ to } 12)\)

<table>
<thead>
<tr>
<th>Field</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTx.16</td>
<td>INTx.15</td>
<td>INTx.14</td>
<td>INTx.13</td>
<td>INTx.12</td>
<td>INTx.11</td>
<td>INTx.10</td>
<td>INTx.9</td>
<td>INTx.8</td>
<td>INTx.7</td>
<td>INTx.6</td>
<td>INTx.5</td>
<td>INTx.4</td>
<td>INTx.3</td>
<td>INTx.2</td>
<td>INTx.1</td>
<td></td>
</tr>
</tbody>
</table>

**PIEIERx register**  \((x = 1 \text{ to } 12)\)

<table>
<thead>
<tr>
<th>Field</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTx.16</td>
<td>INTx.15</td>
<td>INTx.14</td>
<td>INTx.13</td>
<td>INTx.12</td>
<td>INTx.11</td>
<td>INTx.10</td>
<td>INTx.9</td>
<td>INTx.8</td>
<td>INTx.7</td>
<td>INTx.6</td>
<td>INTx.5</td>
<td>INTx.4</td>
<td>INTx.3</td>
<td>INTx.2</td>
<td>INTx.1</td>
<td></td>
</tr>
</tbody>
</table>

**PIE Interrupt Acknowledge Register (PIEACK)**

<table>
<thead>
<tr>
<th>Field</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>PIEACKx</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**PIECTRL register**

<table>
<thead>
<tr>
<th>Field</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIEVECT</td>
<td>ENPIE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```c
#include "F2837x_Device.h"
PieCtrlRegs.PIEIFR1.bit.INTx4 = 1; // manually set IFR for XINT1 in PIE group 1
PieCtrlRegs.PIEIER3.bit.INTx2 = 1; // enable PWM2 interrupt in PIE group 3
PieCtrlRegs.PIEACK.all = 0x0004; // acknowledge the PIE group 3
PieCtrlRegs.PIECTRL.bit.ENPIE = 1; // enable the PIE
```
The interrupt vector table, as mapped in the PIE interrupt assignment table, is located in the PieVect.c file. During processor initialization a function call to PieCtrl.c file is used to copy the interrupt vector table to the PIE RAM and then the PIE module is enabled by setting ENPIE to ‘1’. When the CPU receives an interrupt, the vector address of the ISR is fetched from the PIE RAM, and the interrupt with the highest priority that is both flagged and enabled is executed. Priority is determined by the location within the interrupt vector table. The lowest numbered interrupt has the highest priority when multiple interrupts are pending.
In summary, the PIE initialization code flow is as follows. After the device is reset and execution of the boot code is completed, the selected boot option determines the code entry point. In this figure, two different entry points are shown. The one on the left is for memory block M0 RAM, and the one on the right is for flash.

In either case, the CodeStartBranch.asm file has a Long Branch instruction to the entry point of the runtime support library. After the runtime support library completes execution, main is called. In main, a function is called to initialize the interrupt process and enable the PIE module. When the CPU receives an interrupt, the vector address of the ISR is fetched from the PIE RAM, and the interrupt with the highest priority that is both flagged and enabled is executed. Priority is determined by the location within the interrupt vector table.
Interrupt Signal Flow – Summary

In summary, the following steps occur during an interrupt process. First, a peripheral interrupt is generated and the PIE interrupt flag register is set. If the PIE interrupt enable register is enabled, then the core interrupt flag register will be set. Next, if the core interrupt enable register and global interrupt mask is enabled, the PIE vector table will redirect the code to the interrupt service routine.
Each C28x CPU core in the F2837xD device has its own PIE module, and each PIE module is configured independently. Some interrupt signals are sourced from shared peripherals that can be owned by either CPU, and these interrupt signals are sent to both CPU PIE modules regardless of which CPU owns the peripheral. Therefore, if enabled a peripheral owned by one CPU can cause an interrupt on the other CPU.
Interrupt Response and Latency

Interrupt Response - Hardware Sequence

<table>
<thead>
<tr>
<th>CPU Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registers → stack</td>
<td>14 Register words auto saved</td>
</tr>
<tr>
<td>0 → IFR (bit)</td>
<td>Clear corresponding IFR bit</td>
</tr>
<tr>
<td>0 → IER (bit)</td>
<td>Clear corresponding IER bit</td>
</tr>
<tr>
<td>1 → INTM/DBGM</td>
<td>Disable global ints/debug events</td>
</tr>
<tr>
<td>Vector → PC</td>
<td>Loads PC with int vector address</td>
</tr>
<tr>
<td>Clear other status bits</td>
<td>Clear LOOP, EALLOW, IDLESTAT</td>
</tr>
</tbody>
</table>

Note: some actions occur simultaneously, none are interruptible

Interrupt Latency

- Minimum latency (to when real work occurs in the ISR):
  - Internal interrupts: 14 cycles
  - External interrupts: 16 cycles
- Maximum latency: Depends on wait states, INTM, etc.
This module covers the operation of the OSC/PLL-based clock module and watchdog timer. Also, the general-purpose digital I/O, external interrupts, low power modes and the register protection will be covered.

Module Objectives

- OSC/PLL Clock Module
- Watchdog Timer
- General Purpose Digital I/O
- External Interrupts
- Low Power Modes
- Register Protection
Chapter Topics

System Initialization .................................................................................................................................. 5-1
  Oscillator/PLL Clock Module ............................................................................................................. 5-3
  F2837xD Dual-Core System Clock ................................................................................................... 5-5
Watchdog Timer ..................................................................................................................................... 5-7
General Purpose Digital I/O ............................................................................................................... 5-12
  GPIO Input X-Bar ............................................................................................................................. 5-15
  GPIO Output X-Bar .......................................................................................................................... 5-16
External Interrupts .................................................................................................................................. 5-18
Low Power Modes ............................................................................................................................... 5-19
Register Protection ............................................................................................................................. 5-21
Lab 5: System Initialization ............................................................................................................... 5-23
The device clock signals are derived from one of four clock sources: Internal Oscillator 1 (INTOSC1), Internal Oscillator 2 (INTOSC2), External Oscillator (XTAL), and Auxiliary Clock Input (AUXCLKIN). At power-up, the device is clocked from the on-chip 10 MHz oscillator INTOSC2. INTOSC2 is the primary internal clock source, and is the default system clock at reset. The device also includes a redundant on-chip 10 MHz oscillator INTOSC1. INTOSC1 is a backup clock source, which normally only clocks the watchdog timers and missing clock detection circuit.

Additionally, the device includes dedicated X1 and X2 pins for supporting an external clock source such as an external oscillator, crystal, or resonator. The AUXCLKIN is used as the bit clock source for the USB and CAN to generate the precise frequency requirements.
The clock sources can be multiplied using the PLL and divided down to produce the desired clock frequencies for a specific application. By default, the CPU1 subsystem owns the PLL clock configuration, however a clock control semaphore is available for the CPU2 subsystem to access the clock configuration registers.

A clock source can be fed directly into the core or multiplied using the PLL. The PLL gives us the capability to use the internal 10 MHz oscillator and run the device at the full clock frequency. If the input clock is removed after the PLL is locked, the input clock failed detect circuitry will issue a limp mode clock of 1 to 4 MHz. Additionally, an internal device reset will be issued. The low-speed peripheral clock prescaler is used to clock some of the communication peripherals.

The PLL has a 7-bit integer and 2-bit fractional ratio control to select different CPU clock rates. The C28x CPU provides a SYSCLK clock signal. This signal is prescaled to provide a clock source for some of the on-chip communication peripherals through the low-speed peripheral clock prescaler. Other peripherals are clocked by SYSCLK and use their own clock prescalers for operation.
The PLL system clock is fed to both the CPU1 and CPU2 subsystems. By default, all peripherals are assigned to the CPU1 subsystem. Using the CPU selection register, each individual peripheral can be assigned to either the CPU1 or CPU2 subsystem. The clock for the EPWM modules are limited to 100 MHz, and by using the peripheral clock divider selection register, this clock can be divided down to meet this specification.
The dual-core CPU select register selects either CPU1 or CPU2 as the clock source for each peripheral. The peripheral clock control register allows individual peripheral clock signals to be enabled or disabled. If a peripheral is not being used, its clock signal could be disabled, thus reducing power consumption.

To lock the registers, use the DEVCFGLOCK1 and CPUSYSLOCK1 registers (lock bit for each register).
Watchdog Timer

The watchdog timer is a safety feature, which resets the device if the program runs away or gets trapped in an unintended infinite loop. The watchdog counter runs independent of the CPU. If the counter overflows, a user-selectable reset or interrupt is triggered. During runtime the correct key values in the proper sequence must be written to the watchdog key register in order to reset the counter before it overflows.

- Resets the C28x if the CPU crashes
  - Watchdog counter runs independent of CPU
  - If counter overflows, a reset or interrupt is triggered (user selectable)
  - CPU must write correct data key sequence to reset the counter before overflow
- Watchdog must be serviced or disabled within 131,072 WDCLK cycles after reset
- This translates to 13.11 ms with a 10 MHz WDCLK

The watchdog timer provides a safeguard against CPU crashes by automatically initiating a reset if it is not serviced by the CPU at regular intervals. In motor control applications, this helps protect the motor and drive electronics when control is lost due to a CPU lockup. Any CPU reset will set the PWM outputs to a high-impedance state, which should turn off the power converters in a properly designed system.

The watchdog timer starts running immediately after system power-up/reset, and must be dealt with by software soon after. Specifically, the watchdog must be serviced or disabled within 13.11 milliseconds (using a 10 MHz watchdog clock) after any reset before a watchdog initiated reset will occur. This translates into 131,072 watchdog clock cycles, which is a seemingly tremendous amount! Indeed, this is plenty of time to get the watchdog configured as desired and serviced. A failure of your software to properly handle the watchdog after reset could cause an endless cycle of watchdog initiated resets to occur.
The watchdog clock is divided by 512 and prescaled, if desired for slower watchdog time periods. A watchdog disable switch allows the watchdog to be enabled and disabled. Also a watchdog override switch provides an additional safety mechanism to insure the watchdog cannot be disabled. Once set, the only means to disable the watchdog is by a system reset.

During initialization, a value ‘101’ is written into the watchdog check bit fields. Any other values will cause a reset or interrupt. During run time, the correct keys must be written into the watchdog key register before the watchdog counter overflows and issues a reset or interrupt. Issuing a reset or interrupt is user-selectable. The watchdog also contains an optional “windowing” feature that requires a minimum delay between counter resets.
Watchdog Period Selection

<table>
<thead>
<tr>
<th>WDPS Bits</th>
<th>FRC rollover</th>
<th>WD timeout period @ 10 MHz WDCLK</th>
</tr>
</thead>
<tbody>
<tr>
<td>00x:</td>
<td>1</td>
<td>13.11 ms *</td>
</tr>
<tr>
<td>010:</td>
<td>2</td>
<td>26.22 ms</td>
</tr>
<tr>
<td>011:</td>
<td>4</td>
<td>52.44 ms</td>
</tr>
<tr>
<td>100:</td>
<td>8</td>
<td>104.88 ms</td>
</tr>
<tr>
<td>101:</td>
<td>16</td>
<td>209.76 ms</td>
</tr>
<tr>
<td>110:</td>
<td>32</td>
<td>419.52 ms</td>
</tr>
<tr>
<td>111:</td>
<td>64</td>
<td>839.04 ms</td>
</tr>
</tbody>
</table>

* reset default

♦ Remember: Watchdog starts counting immediately after reset is released!
♦ Reset default with WDCLK = 10 MHz computed as (1/10 MHz) * 512 * 256 = 13.11 ms

Watchdog Timer Control Register

SysCtrlRegs.WDCR (lab file: Watchdog.c)

<table>
<thead>
<tr>
<th>15 - 7</th>
<th>6</th>
<th>5 - 3</th>
<th>2 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>WDDIS</td>
<td>WDCHK</td>
<td>WDPS</td>
</tr>
</tbody>
</table>

Watchdog Disable Bit
Write 1 to disable
(Functions only if WD OVERRIDE bit in SCSR is equal to 1)

Logic Check Bits
Write as 101 or reset immediately triggered

WD Prescale Selection Bits

<table>
<thead>
<tr>
<th>WDPS</th>
<th>WDCLK =</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 0 x</td>
<td>OSCCLK / 512 / 1</td>
</tr>
<tr>
<td>0 1 0</td>
<td>OSCCLK / 512 / 2</td>
</tr>
<tr>
<td>0 1 1</td>
<td>OSCCLK / 512 / 4</td>
</tr>
<tr>
<td>1 0 0</td>
<td>OSCCLK / 512 / 8</td>
</tr>
<tr>
<td>1 0 1</td>
<td>OSCCLK / 512 / 16</td>
</tr>
<tr>
<td>1 1 0</td>
<td>OSCCLK / 512 / 32</td>
</tr>
<tr>
<td>1 1 1</td>
<td>OSCCLK / 512 / 64</td>
</tr>
</tbody>
</table>
Resetting the Watchdog
SysCtrlRegs.WDKEY (lab file: Watchdog.c)

- WDKEY write values:
  - 55h - counter enabled for reset on next AAh write
  - AAh - counter set to zero if reset enabled
- Writing any other value has no effect
- Watchdog should not be serviced solely in an ISR
  - If main code crashes, but interrupt continues to execute, the watchdog will not catch the crash
  - Could put the 55h WDKEY in the main code, and the AAh WDKEY in an ISR; this catches main code crashes and also ISR crashes

<table>
<thead>
<tr>
<th>Sequential Step</th>
<th>Value Written to WDKEY</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AAh</td>
<td>No action</td>
</tr>
<tr>
<td>2</td>
<td>AAh</td>
<td>No action</td>
</tr>
<tr>
<td>3</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>4</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>5</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>6</td>
<td>AAh</td>
<td>WD counter is reset</td>
</tr>
<tr>
<td>7</td>
<td>AAh</td>
<td>No action</td>
</tr>
<tr>
<td>8</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>9</td>
<td>AAh</td>
<td>WD counter is reset</td>
</tr>
<tr>
<td>10</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>11</td>
<td>23h</td>
<td>No effect; WD counter not reset on next AAh write</td>
</tr>
<tr>
<td>12</td>
<td>AAh</td>
<td>No action due to previous invalid value</td>
</tr>
<tr>
<td>13</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>14</td>
<td>AAh</td>
<td>WD counter is reset</td>
</tr>
</tbody>
</table>
**System Control and Status Register**

SysCtrlReg.SCSR (lab file: Watchdog.c)

**WD Override (protect bit)**

Protects WD from being disabled

- 0 = WDDIS bit in WDCR has no effect (WD cannot be disabled)
- 1 = WDDIS bit in WDCR can disable the watchdog

- This bit is a *clear-only* bit (write 1 to clear)
- The reset default of this bit is a 1

- The bit positions:
  
<table>
<thead>
<tr>
<th>15 - 3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>WDINTS</td>
<td>WDEN</td>
<td>WDOVERRIDE</td>
</tr>
</tbody>
</table>

**WD Interrupt Status (read only)**

0 = active
1 = not active

**WD Enable Interrupt**

0 = WD generates a MCU reset
1 = WD generates a WDINT interrupt
The F2837xD device incorporates a multiplexing scheme to enable each I/O pin to be configured as a GPIO pin or one of several peripheral I/O signals. Sharing a pin across multiple functions maximizes application flexibility while minimizing package size and cost. A GPIO Group multiplexer and four GPIO Index multiplexers provide a double layer of multiplexing to allow up to twelve independent peripheral signals and a digital I/O function to share a single pin. Each output pin can be controlled by either a peripheral or CPU1, CPU1 CLA, CPU2, or CPU2 CLA. However, the peripheral multiplexing and pin assignment can only be configured by CPU1. By default, all of the pins are configured as GPIO, and when configured as a signal input pin, a qualification sampling period can be specified to remove unwanted noise. Optionally, each pin has an internal pullup resistor that can be enabled in order to keep the input pin in a known state when no external signal is driving the pin. The I/O pins are grouped into six ports, and each port has 32 pins except for the sixth port which has nine pins (i.e. the remaining I/O pins). For a GPIO, each port has a series of registers that are used to control the value on the pins, and within these registers each bit corresponds to one GPIO pin.

If the pin is configured as GPIO, a direction (DIR) register is used to specify the pin as either an input or output. By default, all GPIO pins are inputs. The current state of a GPIO pin corresponds to a bit value in a data (DAT) register, regardless if the pin is configured as GPIO or a peripheral function. Writing to the DAT register bit field clears or sets the corresponding output latch, and if the pin is configured as an output the pin will be driven either low or high. The state of various GPIO output pins on the same port can be easily modified using the SET, CLEAR, and TOGGLE registers. The advantage of using these registers is a single instruction can be used to modify only the pins specified without disturbing the other pins. This also eliminates any timing issues that may occur when writing directly to the data registers.
The input qualification scheme is very flexible, and the type of input qualification can be configured for each GPIO pin individually. In the case of a GPIO input pin, the qualification can be specified as only synchronize to SYSCLKOUT or qualification by a sampling window. For pins that are configured as peripheral inputs, the input can also be asynchronous in addition to synchronized to SYSCLKOUT or qualified by a sampling window.

**F28x7x GPIO Input Qualification**

- Qualification available on ports A - F
- Individually selectable per pin
  - no qualification (peripherals only)
  - sync to CPUx.SYSCLK only
  - qualify 3 samples
  - qualify 6 samples

samples taken

T = qual period

TMS320F2837xD Microcontroller Workshop - System Initialization
General Purpose Digital I/O

**F28x7x GPIO Input Qual Registers**

*GpioCtrlRegs.register (lab file: Gpio.c)*

GPxQSEL1 / GPxQSEL2 where x = A, B, C, D, E or F

<table>
<thead>
<tr>
<th>31</th>
<th>16 pins configured per register</th>
</tr>
</thead>
</table>

- 00 = sync to SYSCLKOUT only *
- 01 = qual to 3 samples
- 10 = qual to 6 samples
- 11 = no sync or qual (for peripheral only; GPIO same as 00)

GPxCTRL where x = A, B, C, D, E or F

<table>
<thead>
<tr>
<th>31</th>
<th>24</th>
<th>16</th>
<th>8</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>QUALPRD3</td>
<td>QUALPRD2</td>
<td>QUALPRD1</td>
<td>QUALPRD0</td>
<td></td>
</tr>
<tr>
<td>A: GPIO31-24</td>
<td>GPIO23-16</td>
<td>GPIO15-8</td>
<td>GPIO7-0</td>
<td></td>
</tr>
<tr>
<td>B: GPIO63-56</td>
<td>GPIO55-48</td>
<td>GPIO47-40</td>
<td>GPIO39-32</td>
<td></td>
</tr>
<tr>
<td>C: GPIO95-88</td>
<td>GPIO87-80</td>
<td>GPIO79-72</td>
<td>GPIO71-64</td>
<td></td>
</tr>
<tr>
<td>D: GPIO127-120</td>
<td>GPIO119-112</td>
<td>GPIO111-104</td>
<td>GPIO103-96</td>
<td></td>
</tr>
<tr>
<td>E: GPIO159-152</td>
<td>GPIO151-144</td>
<td>GPIO143-136</td>
<td>GPIO135-128</td>
<td></td>
</tr>
<tr>
<td>F: GPIO191-184</td>
<td>GPIO183-176</td>
<td>GPIO175-168</td>
<td>GPIO167-160</td>
<td></td>
</tr>
</tbody>
</table>

- 00h no qualification (SYNC to SYSCLKOUT) *
- 01h QUALPRD = SYSCLKOUT/2
- 02h QUALPRD = SYSCLKOUT/4
- ... ...
- FFh QUALPRD = SYSCLKOUT/510

* reset default

**F28x7xD Dual-Core GPIO Core Select**

*GpioCtrlRegs.register (lab file: Gpio.c)*

- Selects which core’s GPIODAT/SET/CLEAR/TOGGLE registers are used to control a pin
- Each pin individually controlled

<table>
<thead>
<tr>
<th>31</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPxCSEL4</td>
<td>GPxCSEL3</td>
</tr>
<tr>
<td>GPxCSEL2</td>
<td>GPxCSEL1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>31</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: GPIO31-24</td>
<td>GPIO23-16</td>
</tr>
<tr>
<td>B: GPIO63-56</td>
<td>GPIO55-48</td>
</tr>
<tr>
<td>C: GPIO95-88</td>
<td>GPIO87-80</td>
</tr>
<tr>
<td>D: GPIO127-120</td>
<td>GPIO119-112</td>
</tr>
<tr>
<td>E: GPIO159-152</td>
<td>GPIO151-144</td>
</tr>
<tr>
<td>F: GPIO191-184</td>
<td>GPIO183-176</td>
</tr>
</tbody>
</table>

- xx00 pin controlled by CPU1 *
- xx01 pin controlled by CPU1.CLA1
- xx10 pin controlled by CPU2
- xx11 pin controlled by CPU2.CLA1

* reset default

Note: GPxLOCK register can be used to lock above registers (lock bit for each pin)
F28x7x GPIO Control & Data Registers

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPxCTRL</td>
<td>GPIO x Control Register</td>
</tr>
<tr>
<td>GPxQSEL1</td>
<td>GPIO x Qualifier Select 1 Register</td>
</tr>
<tr>
<td>GPxQSEL2</td>
<td>GPIO x Qualifier Select 2 Register</td>
</tr>
<tr>
<td>GPxMUX1</td>
<td>GPIO x Mux1 Register</td>
</tr>
<tr>
<td>GPxMUX2</td>
<td>GPIO x Mux2 Register</td>
</tr>
<tr>
<td>GPxDIR</td>
<td>GPIO x Direction Register</td>
</tr>
<tr>
<td>GPxDIR</td>
<td>GPIO x Direction Register</td>
</tr>
<tr>
<td>GPxPUD</td>
<td>GPIO x Pull-Up Disable Register</td>
</tr>
<tr>
<td>GPxINV</td>
<td>GPIO x Input Polarity Invert Registers</td>
</tr>
<tr>
<td>GPxGSEL1</td>
<td>GPIO x Peripheral Group Mux</td>
</tr>
<tr>
<td>GPxGSEL2</td>
<td>GPIO x Peripheral Group Mux</td>
</tr>
<tr>
<td>GPxCSEL1</td>
<td>GPIO x Core Select Register</td>
</tr>
<tr>
<td>GPxCSEL2</td>
<td>GPIO x Core Select Register</td>
</tr>
<tr>
<td>GPxCSEL3</td>
<td>GPIO x Core Select Register</td>
</tr>
<tr>
<td>GPxCSEL4</td>
<td>GPIO x Core Select Register</td>
</tr>
<tr>
<td>GPxDAT</td>
<td>GPIO x Data Register</td>
</tr>
<tr>
<td>GPxSET</td>
<td>GPIO x Data Set Register</td>
</tr>
<tr>
<td>GPxCLEAR</td>
<td>GPIO x Data Clear Register</td>
</tr>
<tr>
<td>GPxTOGGLE</td>
<td>GPIO x Data Toggle Register</td>
</tr>
</tbody>
</table>

Where x = A, B, C, D, E, or F

GPIO Input X-Bar

The Input X-BAR is used to route external GPIO signals into the device. It has access to every GPIO pin, where each signal can be routed to any or multiple destinations which include the ADCs, eCAPs, ePWMs, Output X-BAR, and external interrupts. This provides additional flexibility.
above the multiplexing scheme used by the GPIO structure. Since the GPIO does not affect the Input X-BAR, it is possible to route the output of one peripheral to another, such as measuring the output of an ePWM with an eCAP for frequency testing.

**F28x7x GPIO Input X-Bar Architecture**

This block diagram is replicated 14 times

![F28x7x GPIO Input X-Bar Architecture Diagram]

<table>
<thead>
<tr>
<th>Input</th>
<th>Destinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT1</td>
<td>ePWM[TZ1, TRIP1], ePWM X-Bar, Output X-Bar</td>
</tr>
<tr>
<td>INPUT2</td>
<td>ePWM[TZ2, TRIP2], ePWM X-Bar, Output X-Bar</td>
</tr>
<tr>
<td>INPUT3</td>
<td>ePWM[TZ3, TRIP3], ePWM X-Bar, Output X-Bar</td>
</tr>
<tr>
<td>INPUT4</td>
<td>XINT1, ePWM X-Bar, Output X-Bar</td>
</tr>
<tr>
<td>INPUT5</td>
<td>XINT2, ADCEXTSOC, EXTSYNCIN1, ePWM X-Bar, Output X-Bar</td>
</tr>
<tr>
<td>INPUT6</td>
<td>XINT3, ePWM[TRIP5], EXTSYNCIN2, ePWM X-Bar, Output X-Bar</td>
</tr>
<tr>
<td>INPUT7</td>
<td>eCAP1</td>
</tr>
<tr>
<td>INPUT8</td>
<td>eCAP2</td>
</tr>
<tr>
<td>INPUT9</td>
<td>eCAP3</td>
</tr>
<tr>
<td>INPUT10</td>
<td>eCAP4</td>
</tr>
<tr>
<td>INPUT11</td>
<td>eCAP5</td>
</tr>
<tr>
<td>INPUT12</td>
<td>eCAP6</td>
</tr>
<tr>
<td>INPUT13</td>
<td>XINT4</td>
</tr>
<tr>
<td>INPUT14</td>
<td>XINT5</td>
</tr>
</tbody>
</table>

Note: INPUTSELECTLOCK register can be used to lock above registers (lock bit for each register)

**GPIO Output X-Bar**

![F28x7x GPIO Output X-Bar Diagram]
The Output X-BAR is used to route various internal signals out of the device. It contains eight outputs that are routed to the GPIO structure, where each output has one or multiple assigned pin positions, which are labeled as OUTPUTXBARx. Additionally, the Output X-BAR can select a single signal or logically OR up to 32 signals.
External Interrupts

5 external interrupt signals: XINT1, XINT2, XINT3, XINT4 and XINT5

- Each can be mapped to any of GPIO pins via the X-Bar Input architecture
- XINT1, XINT2 and XINT3 also each have a free-running 16-bit counter that measures the elapsed time between interrupts
  - The counter resets to zero each time the interrupt occurs

Configuring External Interrupts

- Configuring external interrupts is a two-step process:
  - Enable interrupt and set polarity
  - Select XINT1-5 GPIO pins via Input X-Bar

<table>
<thead>
<tr>
<th>Interrupt</th>
<th>Pin Selection (Input X-Bar)</th>
<th>Configuration Register (XintRegs.register)</th>
<th>Counter Register (XintRegs.register)</th>
</tr>
</thead>
<tbody>
<tr>
<td>XINT1</td>
<td>X-Bar INPUT4</td>
<td>XINT1CR</td>
<td>XINT1CTR</td>
</tr>
<tr>
<td>XINT2</td>
<td>X-Bar INPUT5</td>
<td>XINT2CR</td>
<td>XINT2CTR</td>
</tr>
<tr>
<td>XINT3</td>
<td>X-Bar INPUT6</td>
<td>XINT3CR</td>
<td>XINT3CTR</td>
</tr>
<tr>
<td>XINT4</td>
<td>X-Bar INPUT13</td>
<td>XINT4CR</td>
<td></td>
</tr>
<tr>
<td>XINT5</td>
<td>X-Bar INPUT14</td>
<td>XINT5CR</td>
<td></td>
</tr>
</tbody>
</table>

- Input X-Bar selects GPIO pins as sources for XINT1-5
- XINT1-5 are sources for Input X-Bar signals 4, 5, 6, 13, and 14 respectively
- Configuration Register controls the enable/disable and polarity
- Counter Register holds the interrupt counter
Low Power Modes

<table>
<thead>
<tr>
<th>Low Power Mode</th>
<th>CPU Logic Clock</th>
<th>Peripheral Logic Clock</th>
<th>Watchdog Clock</th>
<th>PLL / OSC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Run</td>
<td>on</td>
<td>on</td>
<td>on</td>
<td>on</td>
</tr>
<tr>
<td>IDLE</td>
<td>off</td>
<td>on</td>
<td>on</td>
<td>on</td>
</tr>
<tr>
<td>STANDBY</td>
<td>off</td>
<td>off</td>
<td>on</td>
<td>on</td>
</tr>
<tr>
<td>HALT</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>HIB *</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

* Hibernate - low power data retention via M0 and M1 memories

See device datasheet for power consumption in each mode

Low Power Mode Control Register
SySCtrlRegs.LPMC (lab file: SySCtrl.c)

<table>
<thead>
<tr>
<th>31</th>
<th>30 - 18</th>
<th>17 - 16</th>
<th>15</th>
<th>14 - 8</th>
<th>7 - 2</th>
<th>1 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>IOISO</td>
<td>reserved</td>
<td>M0M1MODE</td>
<td>WDINTE</td>
<td>reserved</td>
<td>QUALSTDBY</td>
<td>LPM0</td>
</tr>
</tbody>
</table>

Low Power Mode Entering
1. Set LPM bits
2. Enable desired exit interrupt(s)
3. Execute IDLE instruction
4. The power down sequence of the hardware depends on LP mode

* QUALSTDBY will qualify the GPIO wakeup signal in series with the GPIO port qualification. This is useful when GPIO port qualification is not available or insufficient for wake-up purposes.
## Low Power Mode Exit

<table>
<thead>
<tr>
<th>Low Power Mode</th>
<th>Exit Interrupt</th>
<th>RESET</th>
<th>GPIO Port A Signal</th>
<th>Watchdog Interrupt</th>
<th>Any Enabled Interrupt</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDLE</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>STANDBY</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>HALT</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>HIB</td>
<td>yes</td>
<td>no*</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

* Hibernate - GPIO41 becomes HIBWAKE reset signal; boot ROM avoids clearing M0 and M1 memories and calls a user-specified I/O restore function.

### GPIO Low Power Wakeup Select

```
x = 0

x = 1
```

<table>
<thead>
<tr>
<th>SysCtrlRegs.GPIOPMSELx</th>
<th>31</th>
<th>30</th>
<th>29</th>
<th>28</th>
<th>27</th>
<th>26</th>
<th>25</th>
<th>24</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPIO63</td>
<td>GPIO62</td>
<td>GPIO61</td>
<td>GPIO60</td>
<td>GPIO59</td>
<td>GPIO58</td>
<td>GPIO57</td>
<td>GPIO56</td>
<td></td>
</tr>
<tr>
<td>GPIO55</td>
<td>GPIO54</td>
<td>GPIO53</td>
<td>GPIO52</td>
<td>GPIO51</td>
<td>GPIO50</td>
<td>GPIO49</td>
<td>GPIO48</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>14</td>
<td>13</td>
<td>12</td>
<td>11</td>
<td>10</td>
<td>9</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>GPIO47</td>
<td>GPIO46</td>
<td>GPIO45</td>
<td>GPIO44</td>
<td>GPIO43</td>
<td>GPIO42</td>
<td>GPIO41</td>
<td>GPIO40</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>GPIO39</td>
<td>GPIO38</td>
<td>GPIO37</td>
<td>GPIO36</td>
<td>GPIO35</td>
<td>GPIO34</td>
<td>GPIO33</td>
<td>GPIO32</td>
<td></td>
</tr>
</tbody>
</table>

```
x = 0

x = 1
```

### Note:
- CPUSYSLOCK1 register can be used to lock above registers (lock bit for each register)

### Wake device from
- STANDBY and HALT mode (GPIO Port A & B)
  - 0 = disable (default)
  - 1 = enable
Register Protection

**LOCK Protection Registers**

- “LOCK” registers protect several system configuration registers from spurious CPU writes.
- Once LOCK register bits are set, the respective locked registers can no longer be modified by software.

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLA1TASKSRCSELLOCK</td>
<td>Z2_OTPSECLOCK</td>
</tr>
<tr>
<td>DMACHSRCSELLOCK</td>
<td>DxLOCK</td>
</tr>
<tr>
<td>DEVCFGLOCK1</td>
<td>LSxLOCK</td>
</tr>
<tr>
<td>CLKCFGLOCK1</td>
<td>GSxLOCK</td>
</tr>
<tr>
<td>CPUUSYSLOCK1</td>
<td>INPUTSELECTLOCK</td>
</tr>
<tr>
<td>Z1OTP_PSWDLOCK</td>
<td>OUTPUTLOCK</td>
</tr>
<tr>
<td>Z1OTP_CRCLOCK</td>
<td>GPALOCK</td>
</tr>
<tr>
<td>Z2OTP_PSWDLOCK</td>
<td>GPBLOCK</td>
</tr>
<tr>
<td>Z2OTP_CRCLOCK</td>
<td>GPCLOCK</td>
</tr>
<tr>
<td>Z1_OTPSECLOCK</td>
<td>GPDLOCK</td>
</tr>
</tbody>
</table>

A series of “lock” registers can be used to protect several system configuration settings from spurious CPU writes. After the lock registers bits are set, the respective locked registers can no longer be modified by software.

**EALLOW Protection (1 of 2)**

- **EALLOW** stands for *Emulation Allow*
- Code access to protected registers allowed only when EALLOW = 1 in the ST1 register
- The emulator can always access protected registers
- EALLOW bit controlled by assembly level instructions
  - ‘EALLOW’ sets the bit (register access enabled)
  - ‘EDIS’ clears the bit (register access disabled)
- EALLOW bit cleared upon ISR entry, restored upon exit
### EALLOW Protection (2 of 2)

The following registers are protected:

<table>
<thead>
<tr>
<th>Device Configuration &amp; Emulation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash</td>
</tr>
<tr>
<td>Code Security Module</td>
</tr>
<tr>
<td>PIE Vector Table</td>
</tr>
<tr>
<td>DMA, CLA, SD, EMIF, X-Bar (some registers)</td>
</tr>
<tr>
<td>CANA/B (control registers only; mailbox RAM not protected)</td>
</tr>
<tr>
<td>ePWM, CMPSS, ADC, DAC (some registers)</td>
</tr>
<tr>
<td>GPIO (control registers only)</td>
</tr>
<tr>
<td>System Control</td>
</tr>
</tbody>
</table>

See device datasheet and Technical Reference Manual for detailed listings

#### EALLOW register access C-code example:

```c
asm(" EALLOW");  // enable protected register access
SysCtrlRegs.WDKEY=0x55;  // write to the register
asm(" EDIS");  // disable protected register access
```
Lab 5: System Initialization

- **Objective**

  The objective of this lab exercise is to perform the processor system initialization. Additionally, the peripheral interrupt expansion (PIE) vectors will be initialized and tested using the information discussed in the previous module. This initialization process will be used again in all of the lab exercises throughout this workshop. The system initialization for this lab will consist of the following:

  - Setup the clock module – PLL, LOSPCP = /4, low-power modes to default values, enable all module clocks
  - Disable the watchdog – clear WD flag, disable watchdog, WD prescale = 1
  - Setup the watchdog and system control registers – DO NOT clear WD OVERRIDE bit, configure WD to generate a CPU reset
  - Setup the shared I/O pins – set all GPIO pins to GPIO function (e.g. a “0” setting for GPIO group multiplexer “GPxGMUX1/2” and a “0” setting for GPIO multiplexer “GPxMUX1/2”)

  The first part of the lab exercise will setup the system initialization and test the watchdog operation by having the watchdog cause a reset. In the second part of the lab exercise the PIE vectors will be added and tested by using the watchdog to generate an interrupt. This lab will make use of the F2837xD C-code header files to simplify the programming of the device, as well as take care of the register definitions and addresses. Please review these files, and make use of them in the future, as needed.

- **Procedure**

  **Create a New Project**

  1. Create a new project (File → New → CCS Project) for this lab exercise. The top section should default to the options previously selected (setting the “Target” to “TMS320F28379D”, and leaving the “Connection” box blank). Name the project Lab5. Uncheck the “Use default location” box. Using the “Browse…” button navigate to: C:\C28x\Labs\Lab5\cpu01 then click OK. Set the “Linker Command File” to <none>, and be sure to set the “Project templates and examples” to “Empty Project”. Then click Finish.

  2. Right-click on Lab5 in the Project Explorer window and add (copy) the following files to the project (Add Files...) from C:\C28x\Labs\Lab5\source:

     - CodeStartBranch.asm
     - DelayUs.asm
     - F2837xD_GlobalVariableDefs.c
     - F2837xD_Headers_nonBIOS_cpu1.cmd
     - Gpio.c
     - Lab_5_6_7.cmd
     - Main_5.c
     - SysCtrl.c
     - Watchdog.c
     - Xbar.c

     Do not add DefaultIsr_5.c, PieCtrl.c, and PieVect.c. These files will be added and used with the interrupts in the second part of this lab exercise.
Project Build Options

3. Setup the build options by right-clicking on Lab5 in the Project Explorer window and select “Properties”. We need to setup the include search path to include the peripheral register header files and common lab header files. Under “C2000 Compiler” select “Include Options”. In the include search path box that opens (“Add dir to #include search path”) click the Add icon (first icon with green plus sign). Then in the “Add directory path” window type (one at a time):

${PROJECT_ROOT}/../../F2837xD_headers/include

${PROJECT_ROOT}/../../Lab_common/include

Click OK to include each search path.

4. Next, we need to setup the predefined symbols. Under “C2000 Compiler” select “Predefined Symbols”. In the predefined name box that opens (“Pre-define NAME”) click the Add icon (first icon with green plus sign). Then in the “Enter Value” window type CPU1. This name is used in the project to conditionally include the peripheral register header files code specific to CPU1. Click OK to include the name. Finally, click OK to save and close the Properties window.

Modify Memory Configuration

5. Open and inspect the linker command file Lab_5_6_7.cmd. Notice that the user defined section “codestart” is being linked to a memory block named BEGIN_M0. The codestart section contains code that branches to the code entry point of the project. The bootloader must branch to the codestart section at the end of the boot process. Recall that the emulation boot mode “SARAM” branches to address 0x000000 upon bootloader completion.

Notice that the linker command file Lab_5_6_7.cmd has a memory block named BEGIN_M0: origin = 0x000000, length = 0x0002, in program memory. The existing parts of memory blocks BOOT_RSVD and RAMM0 in data memory has been modified to avoid any overlaps with this memory block.

6. In the linker command file, notice that RESET in the MEMORY section has been defined using the “(R)” qualifier. This qualifier indicates read-only memory, and is optional. It will cause the linker to flag a warning if any uninitialized sections are linked to this memory. The (R) qualifier can be used with all non-volatile memories (e.g., flash, ROM, OTP), as you will see in later lab exercises. Close the Lab_5_6_7.cmd linker command file.

Setup System Initialization

7. Open and inspect SysCtrl.c. Notice that the clock sources, PLL, peripheral clocks, and low-power modes have been initialized.

8. Modify Watchdog.c to implement the system initialization as described in the objective for this lab exercise.

9. Open and inspect Gpio.c. Notice that the shared I/O pins have been set to the GPIO function. Also, in Xbar.c the crossbar switches have been set to their default values. Save your work.
Build and Load

10. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window.

11. Click the “Debug” button (green bug). A Launching Debug Session window will open. Select only CPU1 to load the program on (i.e. uncheck CPU2), and then click OK. Then the CCS Debug perspective view should open, the program will load automatically, and you should now be at the start of main().

12. After CCS loaded the program in the previous step, it set the program counter (PC) to point to _c_int00. It then ran through the C-environment initialization routine in the rts2800_fpu32.lib and stopped at the start of main(). CCS did not do a device reset, and as a result the bootloader was bypassed.

In the remaining parts of this lab exercise, the device will be undergoing a reset due to the watchdog timer. Therefore, we must configure the device by loading values into EMU_KEY and EMU BMODE so the bootloader will jump to “RAMM0” at address 0x000000. Set the bootloader mode using the menu bar by clicking:

Scripts → EMU Boot Mode Select → EMU_BOOT_SARAM

If the device is power cycled between lab exercises, or within a lab exercise, be sure to re-configure the boot mode to EMU_BOOT_SARAM.

Run the Code – Watchdog Reset Disabled

13. Place the cursor in the “main loop” section (on the asm(“NOP”); instruction line) and right click the mouse key and select Run To Line. This is the same as setting a breakpoint on the selected line, running to that breakpoint, and then removing the breakpoint.

14. Place the cursor on the first line of code in main() and set a breakpoint by double clicking in the line number field to the left of the code line. Notice that line is highlighted with a blue dot indicating that the breakpoint has been set. (Alternatively, you can set a breakpoint on the line by right-clicking the mouse and selecting Breakpoint (Code Composer Studio) → Breakpoint). The breakpoint is set to prove that the watchdog is disabled. If the watchdog causes a reset, code execution will stop at this breakpoint (or become trapped as explained in the watchdog hardware reset below).

15. Run your code for a few seconds by using the “Resume” button on the toolbar, or by using Run → Resume on the menu bar (or F8 key). After a few seconds halt your code by using the “Suspend” button on the toolbar, or by using Run → Suspend on the menu bar (or Alt-F8 key). Where did your code stop? Are the results as expected? If things went as expected, your code should be in the “main loop”.

Run the Code – CCS Issued CPU Reset

16. Perform a CCS CPU reset (soft reset) by clicking on the CPU Reset icon 🛠 (or by selecting Run → Reset → CPU Reset). The program counter should now be at the entry point of the boot ROM code at 0x3FF16A. To view the boot ROM code click on View Disassembly...

17. Run your code. Where did your code stop? Are the results as expected? If things went as expected, your code should have stopped at the breakpoint. What happened is as follows. The ROM bootloader began execution and since the device is in emulation boot mode (i.e. the emulator is connected) the bootloader read the EMU_KEY and
EMU_BMODE values from the PIE RAM. These values were previously set for boot to RAMM0 boot mode by CCS. Since these values did not change and are not affected by reset, the bootloader transferred execution to the beginning of our code at address 0x000000 in the RAMM0, and execution continued until the breakpoint was hit in main().

Run the Code – Watchdog Reset Enabled (Hardware Reset)

18. Open the Project Explorer window in the CCS Debug perspective view by selecting View -> Project Explorer. Modify the InitWatchdog() function to enable the watchdog (WDCR). This will enable the watchdog to function and cause a reset. Save the file.

19. Build the project by clicking Project -> Build Project. Select Yes to “Reload the program automatically”.

Alternatively, you add the “Build” button to the tool bar in the CCS Debug perspective (if it is not already there) so that it will available for future use. Click Window -> Perspective -> Customize Perspective... and then select the Tool Bar Visibility tab. Check the Code Composer Studio Project Build box. This will automatically select the “Build” button in the Tool Bar Visibility tab. Click OK.

20. Again, place the cursor in the “main loop” section (on the asm(" NOP"); instruction line) and right click the mouse key and select Run To Line.

21. This time we will have the watchdog issue a reset that will toggle the XRSn pin (i.e. perform a hard reset). Now run your code. Where did your code stop? Why did your code stop at an assembly ESTOP0 instruction in the boot ROM at 0x3FE493 and not as we expected at the breakpoint in main()? Here is what happened. While the code was running, the watchdog timed out and reset the processor. The reset vector was then fetched and the ROM bootloader began execution. Since the device is in emulation boot mode, it read the EMU_KEY and EMU_BMODE values from the PIE RAM which was previously set to RAMM0 boot mode. Again, note that these values do not change and are not affected by reset. When the F28x7x devices undergo a hardware reset (e.g. watchdog reset), the boot ROM code clears the RAM memory blocks. As a result, after the bootloader transferred execution to the beginning of our code at address 0x000000 in RAMM0, the memory block was cleared. The processor was then issued an illegal instruction which trapped us back in the boot ROM.

This only happened because we are executing out of RAM. In a typical application, the Flash memory contains the program and the reset process would run as we would expect. This should explain why we did not see this behavior with the CCS CPU reset (soft reset where the RAM was not cleared). So what is the advantage of clearing memory during a hardware reset? This ensures that after the reset the original program code and data values will be in a known good state to provide a safer operation. It is important to understand that the watchdog did not behave differently depending on which type of reset was issued. It is the reset process that behaved differently from the different type of resets.

22. Since the watchdog reset in the previous step cleared the RAM blocks, we will now need to reload the program for the second part of this lab exercise. Reload the program by selecting:

Run -> Load -> Reload Program
Setup PIE Vector for Watchdog Interrupt

The first part of this lab exercise used the watchdog to generate a CPU reset. This was tested using a breakpoint set at the beginning of main(). Next, we are going to use the watchdog to generate an interrupt. This part will demonstrate the interrupt concepts learned in the previous module.

23. Add (copy) the following files to the project from \C:\C28x\Labs\Lab5\source:

   DefaultIsr_5.c
   PieCtrl.c
   PieVect.c

   Check your files list to make sure the files are there.

24. In Main_5.c, add code to call the InitPieCtrl() function. There are no passed parameters or return values, so the call code is simply:

       InitPieCtrl();

25. Using the “PIE Interrupt Assignment Table” shown in the previous module find the location for the watchdog interrupt, "WAKE". This will be used in the next step.

       PIE group #: __________  # within group: __________

26. Modify main() to do the following:
- Enable global interrupts (INTM bit)

       Then modify InitWatchdog() to do the following:
- Enable the “WAKE” interrupt in the PIE (Hint: use the PieCtrlRegs structure)
- Enable the appropriate core interrupt in the IER register

27. In Watchdog.c modify the system control and status register (SCSR) to cause the watchdog to generate a WAKE interrupt rather than a reset. Save all changes to the files.

28. Open and inspect DefaultIsr_5.c. This file contains interrupt service routines. The ISR for WAKE interrupt has been trapped by an emulation breakpoint contained in an inline assembly statement using “ESTOP0”. This gives the same results as placing a breakpoint in the ISR. We will run the lab exercise as before, except this time the watchdog will generate an interrupt. If the registers have been configured properly, the code will be trapped in the ISR.

29. Open and inspect PieCtrl.c. This file is used to initialize the PIE RAM and enable the PIE. The interrupt vector table located in PieVect.c is copied to the PIE RAM to setup the vectors for the interrupts.

Build and Load

30. Build the project by clicking Project → Build Project, or by clicking on the "Build" button (if it has been added to the tool bar). Select Yes to “Reload the program automatically”.

Run the Code – Watchdog Interrupt

31. Place the cursor in the “main loop” section, right click the mouse key and select Run To Line.

32. Run your code. Where did your code stop? Are the results as expected? If things went as expected, your code should stop at the “ESTOP0” instruction in the WAKE interrupt ISR.

Terminate Debug Session and Close Project

33. Terminate the active debug session using the Terminate button. This will close the debugger and return Code Composer Studio to the CCS Edit perspective view.

34. Next, close the project by right-clicking on Lab5 in the Project Explorer window and select Close Project.

End of Exercise

Note: By default, the watchdog timer is enabled out of reset. Code in the file CodeStartBranch.asm has been configured to disable the watchdog. This can be important for large C code projects. During this lab exercise, the watchdog was actually re-enabled (or disabled again) in the file Watchdog.c.
Introduction

The Analog Subsystem consists of the Analog-to-Digital Converter (ADC), Comparator Subsystem (CMPSS), Digital-to-Analog Converter (DAC), and the Sigma Delta Filter Module (SDFM). This module will explain the operation of each subsystem. Even though the SDFM is a digital peripheral, it will be covered in this module.

Module Objectives

- Understand the operation of the:
  - Analog-to-Digital Converter (ADC)
  - Comparator Subsystem (CMPSS)
  - Digital-to-Analog Converter (DAC)
  - Sigma Delta Filter Module (SDFM)
- Use the ADC to perform data acquisition

Note: Even though the SDFM is a digital peripheral, it will be covered in this module

- Analog Subsystem:
  - Up to Four dual-mode ADCs
    - 16-bit mode
      - 1 MSPS each (up to 4 MSPS system)
      - Differential inputs
      - External reference
    - 12-bit mode
      - 3.5 MSPS each (up to 14 MSPS system)
      - Single-ended
      - External reference
  - Up to Eight comparator subsystems
    - Each contains:
      - Two 12-bit reference DACs
      - Two comparators
      - Digital glitch filter
  - Three 12-bit buffered DAC outputs
  - Sigma-Delta Filter Module (SDFM)
Chapter Topics

Analog Subsystem........................................................................................................................................ 6-1

Analog-to-Digital Converter (ADC) ........................................................................................................... 6-4
ADC Block and Functional Diagrams ........................................................................................................ 6-5
ADC Triggering ........................................................................................................................................ 6-7
ADC Conversion Priority ............................................................................................................................ 6-8
Post Processing Block ............................................................................................................................... 6-11
ADC Clocking Flow .................................................................................................................................. 6-14
ADC Registers ........................................................................................................................................ 6-14
Signed Input Voltages ............................................................................................................................... 6-19
ADC Calibration and Reference ................................................................................................................ 6-20

Comparator Subsystem (CMPSS) .............................................................................................................. 6-22
Comparator Subsystem Block Diagram ..................................................................................................... 6-23

Digital-to-Analog Converter (DAC) .......................................................................................................... 6-24
Buffered DAC Block Diagram .................................................................................................................. 6-25

Sigma Delta Filter Module (SDFM) ........................................................................................................... 6-26
SDFM Block Diagram ................................................................................................................................ 6-27

Lab 6: Analog-to-Digital Converter ........................................................................................................ 6-28
Analog-to-Digital Converter (ADC)

The F2837xD includes four independent high-performance ADC modules which can be accessed by both CPU subsystems, allowing the device to efficiently manage multiple analog signals for enhanced overall system throughput. Each ADC module has a single sample-and-hold (S/H) circuit and using multiple ADC modules enables simultaneous sampling or independent operation (sequential sampling). The ADC module is implemented using a successive approximation (SAR) type ADC with a configurable resolution of either 16-bits or 12-bits. For 16-bit resolution, the ADC performs differential signal conversions with a performance of 1.1 MSPS, yielding 4.4 MSPS for the device. In differential signal mode, a pair of pins (positive input ADCINxP and negative input ADCINxN) is sampled and the input applied to the converter is the difference between the two pins (ADCINxP – ADCINxN). A benefit of differential signaling mode is the ability to cancel noise that may be introduced common to both inputs. For 12-bit resolution, the ADC performs single-ended signal conversions with a performance of 3.5 MSPS, yielding 14 MSPS for the device. In single-ended mode, a single pin (ADCINx) is sampled and applied to the input of the converter.
The ADC triggering and conversion sequencing is managed by a series of start-of-conversion (SOCx) configuration registers. Each SOCx register configures a single channel conversion, where the SOCx register specifies the trigger source that starts the conversion, the channel to convert, and the acquisition sample window duration. Multiple SOCx registers can be configured for the same trigger, channel, and/or acquisition window. Configuring multiple SOCx registers to use the same trigger will cause that trigger to perform a sequence of conversions, and configuring multiple SOCx registers for the same trigger and channel can be used to oversample the signal.

The various trigger sources that can be used to start an ADC conversion include the General-Purpose Timers from each CPU subsystem, the ePWM modules, an external pin, and by software. Also, the flag setting of either ADCINT1 or ADCINT2 can be configured as a trigger source which can be used for continuous conversion operation. The ADC interrupt logic can generate up to four interrupts. The results for SOC 0 through 15 appear in result registers 0 through 15, respectively.
The figure above is a conceptual view highlighting a single ADC start-of-conversion functional flow from triggering to interrupt generation. This figure is replicated 16 times and the red text indicates the register names.
ADC Triggering

**Example – ADC Triggering**

Sample A1 → A3 → A5 when ePWM1 SOCB/D is generated and then generate ADCINT1:

- **SOCB/D (ETPWM1)**
  - SOC0
    - Channel A1: Sample 20 cycles, Result0, no interrupt
  - SOC1
    - Channel A3: Sample 26 cycles, Result1, no interrupt
  - SOC2
    - Channel A5: Sample 22 cycles, Result2

Sample A2 → A4 → A6 continuously and generate ADCINT2:

- Software Trigger
  - Sample all channels continuously and provide Ping-Pong interrupts to CPU/system:
  - SOC0
    - Channel B0: Sample 20 cycles, Result0, no interrupt
  - SOC1
    - Channel B1: Sample 20 cycles, Result1, no interrupt
  - SOC2
    - Channel B2: Sample 20 cycles, Result2, ADCINT1
  - SOC3
    - Channel B3: Sample 20 cycles, Result3, no interrupt
  - SOC4
    - Channel B4: Sample 20 cycles, Result4, no interrupt
  - SOC5
    - Channel B5: Sample 20 cycles, Result5, ADCINT2

The top example in the figure above shows channels A1, A3, and A5 being converted with a trigger from EPWM1. After A5 is converted, ADCINT1 is generated. The bottom example shows channels A2, A4, and A6 being converted initially by a software trigger. Then, after A6 is converted, ADCINT2 is generated and also fed back as a trigger to start the process again.

**Example – ADC Ping-Pong Triggering**

Sample all channels continuously and provide Ping-Pong interrupts to CPU/system:

Note: setting ADCINT2 flag does not need to generate an interrupt.
The ADC ping-pong triggering example in the figure above shows channels B0 through B5 being converted, triggered initially by software. After channel B2 is converted, ADCINT1 is generated, which also triggers channel B3. After channel B5 is converted, ADCINT2 is generated and is also fed back to start the process again from the beginning. Additionally, ADCINT1 and ADCINT2 are being used to manage the ping-pong interrupts for the interrupt service routines.

### ADC Conversion Priority

**ADC Conversion Priority**

- **When multiple SOC flags are set at the same time – priority determines the order in which they are converted**

  - **Round Robin Priority (default)**
    - No SOC has an inherent higher priority than another
    - Priority depends on the round robin pointer
  
  - **High Priority**
    - High priority SOC will interrupt the round robin wheel after current conversion completes and insert itself as the next conversion
    - After its conversion completes, the round robin wheel will continue where it was interrupted
  
  - **Round Robin Burst Mode**
    - Allows a single trigger to convert one or more SOCs in the round robin wheel
    - Uses BURSTTRIG instead of TRIGSEL for all round robin SOCs (not high priority)

When multiple triggers are received at the same time, the ADC conversion priority determines the order in which they are converted. Three different priority modes are supported. The default priority mode is round robin, where no start-of-conversion has an inherently higher priority over another, and the priority depends upon a round robin pointer. The round robin pointer operates in a circular fashion, constantly wrapping around to the beginning. In high priority mode, one or more than one start-of-conversion is assigned as high priority. The high priority start-of-conversion can then interrupt the round robin wheel, and after it has been converted the wheel will continue where it was interrupted. High priority mode is assigned first to the lower number start-of-conversion and then in increasing numerical order. If two high priority start-of-conversion triggers occur at the same time, the lower number will take precedence. Burst mode allows a single trigger to convert one or more than one start-of-conversion sequentially at a time. This mode uses a separate Burst Control register to select the burst size and trigger source.
In this conversion priority functional diagram, the Start-of-Conversion Priority Control Register contains two bit fields. The Start-of-Conversion Priority bit fields determine the cutoff point between high priority and round robin mode, whereas the Round-Robin Pointer bit fields contain the last converted round robin start-of-conversion which determines the order of conversions.

**Round Robin Priority Example**

- **SOCPRIORITY** configured as 0; **RRPOINTER** configured as 15; **SOC0** is highest RR priority
  - **SOC7** trigger received
  - **SOC7** is converted; **RRPOINTER** now points to **SOC7**; **SOC8** is now highest RR priority
  - **SOC2** & **SOC12** triggers received simultaneously
  - **SOC12** is converted; **RRPOINTER** points to **SOC12**; **SOC13** is now highest RR priority
  - **SOC2** is converted; **RRPOINTER** points to **SOC2**; **SOC3** is now highest RR priority
High Priority Example

SOC\textsubscript{PRIORITY} configured as 4; RR\textsubscript{POINTER} configured as 15; SOC4 is highest RR priority

SOC7 trigger received
SOC7 is converted; RR\textsubscript{POINTER} points to SOC7; SOC8 is now highest RR priority

SOC2 & SOC12 triggers received simultaneously
SOC2 is converted; RR\textsubscript{POINTER} stays pointing to SOC7

SOC12 is converted; RR\textsubscript{POINTER} points to SOC12; SOC13 is now highest RR priority

Round Robin Burst Mode Diagram

The Round-Robin Burst mode utilizes an ADC Burst Control Register to enable the burst mode, determine the burst size, and select the burst trigger source.
Round Robin Burst Mode with High Priority Example

SOCPrioriry configured as 4; RRPointer configured as 15; SOC4 is highest RR priority
BURSTTRIG trigger received
SOC4 & SOC5 is converted; RRPointer points to SOC5; SOC8 is now highest RR priority
BURSTTRIG & SOC1 triggers received simultaneously
SOC1 is converted; RRPointer stays pointing to SOC5
SOC6 & SOC7 is converted; RRPointer points to SOC7; SOC8 is now highest RR priority

Note: BURSTEN = 1, BURSTSIZE = 1

Post Processing Block

Purpose of the Post Processing Block

- Offset Correction
  - Remove an offset associated with an ADCIN channel possibly caused by external sensors and signal sources
  - Zero-overhead; saving cycles

- Error from Setpoint Calculation
  - Subtract out a reference value which can be used to automatically calculate an error from a set-point or expected value
  - Reduces the sample to output latency and software overhead

- Limit and Zero-Crossing Detection
  - Automatically perform a check against a high/low limit or zero-crossing and can generate a trip to the ePWM and/or an interrupt
  - Decreases the sample to ePWM latency and reduces software overhead; trip the ePWM based on an out of range ADC conversion without CPU intervention

- Trigger-to-Sample Delay Capture
  - Capable of recording the delay between when the SOC is triggered and when it begins to be sampled
  - Allows software techniques to reduce the delay error
To further enhance the capabilities of the ADC, each ADC module incorporates four post-processing blocks (PPB), and each PPB can be linked to any of the ADC result registers. The PPBs can be used for offset correction, calculating an error from a set-point, detecting a limit and zero-crossing, and capturing a trigger-to-sample delay. Offset correction can simultaneously remove an offset associated with an ADCIN channel that was possibly caused by external sensors or signal sources with zero-overhead, thereby saving processor cycles. Error calculation can automatically subtract out a computed error from a set-point or expected result register value, reducing the sample to output latency and software overhead. Limit and zero-crossing detection automatically performs a check against a high/low limit or zero-crossing and can generate a trip to the ePWM and/or generate an interrupt. This lowers the sample to ePWM latency and reduces software overhead. Also, it can trip the ePWM based on an out-of-range ADC conversion without any CPU intervention which is useful for safety conscious applications. Sample delay capture records the delay between when the SOCx is triggered and when it begins to be sampled. This can enable software techniques to be used for reducing the delay error.
Post Processing Block Interrupt Event

- Each ADC module contains four (4) Post Processing Blocks
- Each Post Processing Block can be associated with any of the 16 ADCRESULTx registers
ADC Clocking Flow

ADC Clocking Flow

ADC Registers

Analog-to-Digital Converter Registers

Refer to the Technical Reference Manual for a complete listing of registers
ADC Control Register 1
AdczRegs.ADCCTL1 (z = a, b, c, or d)

ADC Busy
0 = ADC available
1 = ADC busy

ADC Busy Channel
When ADCBSY = 0: last channel converted
1: channel currently processing

INT Pulse Generation Control
0 = beginning of conversion
1 = one cycle prior to result

ADC Busy Channel
00h = ADCIN0
01h = ADCIN1
02h = ADCIN2
03h = ADCIN3
04h = ADCIN4
05h = ADCIN5
06h = ADCIN6
07h = ADCIN7
08h = ADCIN9
09h = ADCIN10
0Ah = ADCIN11
0Bh = ADCIN12
0Ch = ADCIN13
0Dh = ADCIN14
0Eh = ADCIN15
0Fh = ADCIN16

ADC Power Down
Analog circuitry is:
0 = powered down
1 = powered up

ADC Control Register 2
AdczRegs.ADCCTL2 (z = a, b, c, or d)

SIGNALMODE RESOLUTION
0 = single-ended
1 = differential

PRESCALE
0000 = Input Clock / 1.0
0001 = Invalid
0010 = Input Clock / 2.0
0011 = Input Clock / 2.5
0100 = Input Clock / 3.0
0101 = Input Clock / 3.5
0110 = Input Clock / 4.0
1000 = Input Clock / 4.5
1001 = Input Clock / 5.0
1010 = Input Clock / 5.5
1011 = Input Clock / 6.0
1100 = Input Clock / 6.5
1101 = Input Clock / 7.0
1110 = Input Clock / 7.5
1111 = Input Clock / 8.0

ADC Clock Prescale
ADCCLK equals:
0000 = Input Clock / 1.0
0001 = Invalid
0010 = Input Clock / 2.0
0011 = Input Clock / 2.5
0100 = Input Clock / 3.0
0101 = Input Clock / 3.5
0110 = Input Clock / 4.0
1000 = Input Clock / 4.5
1001 = Input Clock / 5.0
1010 = Input Clock / 5.5
1011 = Input Clock / 6.0
1100 = Input Clock / 6.5
1101 = Input Clock / 7.0
1110 = Input Clock / 7.5
1111 = Input Clock / 8.0

ADC Resolution
0 = 12-bit resolution
1 = 16-bit resolution

Signaling Mode
0 = single-ended
1 = differential

Configured by AdcSetMode() function in source code

Definitions for selecting ADC signaling mode and resolution defined in F2837xD_Adc_defines.h
### ADC SOC0 – SOC15 Control Registers

<table>
<thead>
<tr>
<th>ADCx Regs.ADCSOCxCTL (z = a, b, c, \text{ or } d)\</th>
<th>SOCx Trigger Source Select</th>
<th>SOCx Channel Select</th>
<th>SOCx Acquisition Prescale ((S/H \text{ window}))</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOCx Trigger Source Select</td>
<td>SOCx Channel Select</td>
<td>SOCx Acquisition</td>
<td>Prescale ((S/H \text{ window}))</td>
</tr>
<tr>
<td>SOCx Acquisition Prescale</td>
<td></td>
<td></td>
<td>8 - 0</td>
</tr>
<tr>
<td>reserved</td>
<td>TRIGSEL</td>
<td>reserved</td>
<td>ACQPS</td>
</tr>
<tr>
<td>reserved</td>
<td>reserved</td>
<td>reserved</td>
<td></td>
</tr>
<tr>
<td>00h = software</td>
<td>01h = ePWM6SOCB/D</td>
<td>0h = ADCIN0</td>
<td>0/1h = ADCIN0&amp;1</td>
</tr>
<tr>
<td>01h = CPU1 Timer 0</td>
<td>02h = CPU1 Timer 1</td>
<td>1h = ADCIN1</td>
<td>2/3h = ADCIN2&amp;3</td>
</tr>
<tr>
<td>02h = CPU1 Timer 1</td>
<td>03h = CPU1 Timer 2</td>
<td>2h = ADCIN2</td>
<td>4/5h = ADCIN4&amp;5</td>
</tr>
<tr>
<td>03h = CPU1 Timer 2</td>
<td>04h = ADCEXTSOC</td>
<td>3h = ADCIN3</td>
<td>6/7h = ADCIN6&amp;7</td>
</tr>
<tr>
<td>04h = ADCEXTSOC</td>
<td>05h = ePWM1SOCB/C</td>
<td>4h = ADCIN4</td>
<td>8/9h = ADCIN8&amp;9</td>
</tr>
<tr>
<td>05h = ePWM1SOCB/C</td>
<td>06h = ePWM1SOCB/D</td>
<td>5h = ADCIN5</td>
<td>002h = 3 SYSCLK</td>
</tr>
<tr>
<td>06h = ePWM1SOCB/D</td>
<td>07h = ePWM2SOCB/C</td>
<td>6h = ADCIN6</td>
<td>003h = 4 SYSCLK</td>
</tr>
<tr>
<td>07h = ePWM2SOCB/C</td>
<td>08h = ePWM2SOCB/D</td>
<td>7h = ADCIN7</td>
<td>004h = 5 SYSCLK</td>
</tr>
<tr>
<td>08h = ePWM2SOCB/D</td>
<td>09h = ePWM3SOCB/C</td>
<td>8h = ADCIN8</td>
<td>0FFh = 512 SYSCLK</td>
</tr>
<tr>
<td>09h = ePWM3SOCB/C</td>
<td>0Ah = ePWM3SOCB/D</td>
<td>9h = ADCIN9</td>
<td></td>
</tr>
<tr>
<td>0Ah = ePWM3SOCB/D</td>
<td>0Bh = ePWM4SOCB/C</td>
<td>Ah = ADCIN10</td>
<td></td>
</tr>
<tr>
<td>0Bh = ePWM4SOCB/C</td>
<td>0Ch = ePWM4SOCB/D</td>
<td>Bh = ADCIN11</td>
<td></td>
</tr>
<tr>
<td>0Ch = ePWM4SOCB/D</td>
<td>0Dh = ePWM5SOCB/C</td>
<td>Ch = ADCIN12</td>
<td></td>
</tr>
<tr>
<td>0Dh = ePWM5SOCB/C</td>
<td>0 Eh = ePWM5SOCB/D</td>
<td>Dh = ADCIN13</td>
<td></td>
</tr>
<tr>
<td>0 Eh = ePWM5SOCB/D</td>
<td>1Fh = CPU2 Timer 2</td>
<td>Eh = ADCIN14</td>
<td></td>
</tr>
<tr>
<td>0Fh = ePWM6SOCB/C</td>
<td></td>
<td>Fh = ADCIN15</td>
<td></td>
</tr>
</tbody>
</table>

**Single-Ended** (SIGNALMODE=0)  **Differential** (SIGNALMODE=1)  **Sampling Window**

- **Single-Ended** (SIGNALMODE=0)
  - 000h = 1 SYSCLK cycles wide
  - 001h = 2 SYSCLK cycles wide
  - 002h = 3 SYSCLK cycles wide
  - 003h = 4 SYSCLK cycles wide
  - 0FFh = 512 SYSCLK cycles wide

- **Differential** (SIGNALMODE=1)
  - 000h = 1 SYSCLK cycles wide
  - 001h = 2 SYSCLK cycles wide
  - 002h = 3 SYSCLK cycles wide

### ADC Interrupt Trigger SOC Select Registers 1 & 2

**ADCINTSOCSEL2**

<table>
<thead>
<tr>
<th>ADCINTSOCSEL2</th>
<th>SOC15</th>
<th>SOC14</th>
<th>SOC13</th>
<th>SOC12</th>
<th>SOC11</th>
<th>SOC10</th>
<th>SOC9</th>
<th>SOC8</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 - 14</td>
<td>13 - 12</td>
<td>11 - 10</td>
<td>9 - 8</td>
<td>7 - 6</td>
<td>5 - 4</td>
<td>3 - 2</td>
<td>1 - 0</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SOC7</th>
<th>SOC6</th>
<th>SOC5</th>
<th>SOC4</th>
<th>SOC3</th>
<th>SOC2</th>
<th>SOC1</th>
<th>SOC0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**ADCINTSOCSEL1**

<table>
<thead>
<tr>
<th>ADCINTSOCSEL1</th>
<th>SOC7</th>
<th>SOC6</th>
<th>SOC5</th>
<th>SOC4</th>
<th>SOC3</th>
<th>SOC2</th>
<th>SOC1</th>
<th>SOC0</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 - 14</td>
<td>13 - 12</td>
<td>11 - 10</td>
<td>9 - 8</td>
<td>7 - 6</td>
<td>5 - 4</td>
<td>3 - 2</td>
<td>1 - 0</td>
<td></td>
</tr>
</tbody>
</table>

|      |      |      |      |      |      |      |      |      |

**SOCx ADC Interrupt Select**

Selects which, if any, ADCINT triggers SOCx

- 00 = no ADCINT will trigger SOCx (TRIGSEL field determines SOCx trigger)
- 01 = ADCINT1 will trigger SOCx (TRIGSEL field ignored)
- 10 = ADCINT2 will trigger SOCx (TRIGSEL field ignored)
- 11 = invalid selection

---

**Analog-to-Digital Converter (ADC)**
### SOC Priority Control Register

| AdcReg$\text{SOSPRICTL}$ (z = a, b, c, or d) |
|---|---|---|---|
| 15 - 10 | 9 - 5 | 4 - 0 |
| reserved | RRPOINTER | SOC_PRIORITY |

- **Round Robin Pointer**
  - Points to the last converted round robin SOCx and determines order of conversions
- **SOC Priority**
  - Determines cutoff point for high priority and round robin mode

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00h</td>
<td>SOC0 last converted, SOC1 highest priority</td>
</tr>
<tr>
<td>01h</td>
<td>SOC1 last converted, SOC2 highest priority</td>
</tr>
<tr>
<td>02h</td>
<td>SOC2 last converted, SOC3 highest priority</td>
</tr>
<tr>
<td>03h</td>
<td>SOC3 last converted, SOC4 highest priority</td>
</tr>
<tr>
<td>04h</td>
<td>SOC4 last converted, SOC5 highest priority</td>
</tr>
<tr>
<td>05h</td>
<td>SOC5 last converted, SOC6 highest priority</td>
</tr>
<tr>
<td>06h</td>
<td>SOC6 last converted, SOC7 highest priority</td>
</tr>
<tr>
<td>07h</td>
<td>SOC7 last converted, SOC8 highest priority</td>
</tr>
<tr>
<td>08h</td>
<td>SOC8 last converted, SOC9 highest priority</td>
</tr>
<tr>
<td>09h</td>
<td>SOC9 last converted, SOC10 highest priority</td>
</tr>
<tr>
<td>0Ah</td>
<td>SOC10 last converted, SOC11 highest priority</td>
</tr>
<tr>
<td>0Bh</td>
<td>SOC11 last converted, SOC12 highest priority</td>
</tr>
<tr>
<td>0Ch</td>
<td>SOC12 last converted, SOC13 highest priority</td>
</tr>
<tr>
<td>0Dh</td>
<td>SOC13 last converted, SOC14 highest priority</td>
</tr>
<tr>
<td>0Eh</td>
<td>SOC14 last converted, SOC15 highest priority</td>
</tr>
<tr>
<td>0Fh</td>
<td>SOC15 last converted, SOC0 highest priority</td>
</tr>
<tr>
<td>10h</td>
<td>reset value (no SOC has been converted)</td>
</tr>
<tr>
<td>11h</td>
<td>invalid selection</td>
</tr>
</tbody>
</table>

### ADC Burst Control Register

| AdcReg$\text{SADCBURSTCTL}$ (z = a, b, c, or d) |
|---|---|---|---|
| 15 | 14 - 12 | 11 - 8 | 7 - 6 | 5 - 0 |
| BURSTEN | reserved | BURSTSIZE | reserved | BURSTTRIGSEL |

- **SOC Burst Mode Enable**
  - Determines how many SOCs are converted when sequence is started
  - 0 = disable
  - 1 = enable

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0h</td>
<td>1 SOC converted</td>
</tr>
<tr>
<td>1h</td>
<td>2 SOCs converted</td>
</tr>
<tr>
<td>2h</td>
<td>3 SOCs converted</td>
</tr>
<tr>
<td>3h</td>
<td>4 SOCs converted</td>
</tr>
<tr>
<td>4h</td>
<td>5 SOCs converted</td>
</tr>
<tr>
<td>5h</td>
<td>6 SOCs converted</td>
</tr>
<tr>
<td>6h</td>
<td>7 SOCs converted</td>
</tr>
<tr>
<td>7h</td>
<td>8 SOCs converted</td>
</tr>
<tr>
<td>8h</td>
<td>9 SOCs converted</td>
</tr>
<tr>
<td>9h</td>
<td>10 SOCs converted</td>
</tr>
<tr>
<td>Ah</td>
<td>11 SOCs converted</td>
</tr>
<tr>
<td>Bh</td>
<td>12 SOCs converted</td>
</tr>
<tr>
<td>Ch</td>
<td>13 SOCs converted</td>
</tr>
<tr>
<td>Dh</td>
<td>14 SOCs converted</td>
</tr>
<tr>
<td>Eh</td>
<td>15 SOCs converted</td>
</tr>
<tr>
<td>Fh</td>
<td>16 SOCs converted</td>
</tr>
</tbody>
</table>

- **SOC Burst Size Select**
  - Configures trigger to start a burst conversion sequence

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00h</td>
<td>software</td>
</tr>
<tr>
<td>01h</td>
<td>CPU1 Timer 0</td>
</tr>
<tr>
<td>02h</td>
<td>CPU1 Timer 1</td>
</tr>
<tr>
<td>03h</td>
<td>CPU1 Timer 2</td>
</tr>
<tr>
<td>04h</td>
<td>ADCEXTSOC</td>
</tr>
<tr>
<td>05h</td>
<td>ePWM1SOC/A/C</td>
</tr>
<tr>
<td>06h</td>
<td>ePWM1SOC/B/D</td>
</tr>
<tr>
<td>07h</td>
<td>ePWM2SOC/A/C</td>
</tr>
<tr>
<td>08h</td>
<td>ePWM2SOC/B/D</td>
</tr>
<tr>
<td>09h</td>
<td>ePWM3SOC/A/C</td>
</tr>
<tr>
<td>Ah</td>
<td>ePWM3SOC/B/D</td>
</tr>
<tr>
<td>Bh</td>
<td>ePWM4SOC/A/C</td>
</tr>
<tr>
<td>Ch</td>
<td>ePWM4SOC/B/D</td>
</tr>
<tr>
<td>Dh</td>
<td>ePWM5SOC/A/C</td>
</tr>
<tr>
<td>Eh</td>
<td>ePWM5SOC/B/D</td>
</tr>
<tr>
<td>Fh</td>
<td>ePWM6SOC/A/C</td>
</tr>
</tbody>
</table>

- **SOC Burst Trigger Source Select**
  - Configures trigger to start a burst conversion sequence

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0h</td>
<td>ePWM6SOCB/D</td>
</tr>
<tr>
<td>1h</td>
<td>ePWM7SOCB/C</td>
</tr>
<tr>
<td>12h</td>
<td>ePWM7SOCB/D</td>
</tr>
<tr>
<td>13h</td>
<td>ePWM8SOCB/C</td>
</tr>
<tr>
<td>14h</td>
<td>ePWM8SOCB/D</td>
</tr>
<tr>
<td>15h</td>
<td>ePWM9SOCB/C</td>
</tr>
<tr>
<td>16h</td>
<td>ePWM9SOCB/D</td>
</tr>
<tr>
<td>17h</td>
<td>ePWM10SOCB/C</td>
</tr>
<tr>
<td>18h</td>
<td>ePWM10SOCB/D</td>
</tr>
<tr>
<td>19h</td>
<td>ePWM11SOCB/C</td>
</tr>
<tr>
<td>1Ah</td>
<td>ePWM11SOCB/D</td>
</tr>
<tr>
<td>1Bh</td>
<td>ePWM12SOCB/C</td>
</tr>
<tr>
<td>1Ch</td>
<td>ePWM12SOCB/D</td>
</tr>
<tr>
<td>1Dh</td>
<td>ePWM13SOCB/C</td>
</tr>
<tr>
<td>1Eh</td>
<td>ePWM13SOCB/D</td>
</tr>
<tr>
<td>1Fh</td>
<td>ePWM14SOCB/C</td>
</tr>
<tr>
<td>1Fh</td>
<td>ePWM14SOCB/D</td>
</tr>
</tbody>
</table>
### Interrupt Select x and y Register

AdczsRegs.INTSELxNy \( (z = a, b, c, \text{ or } d) \)

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11 - 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>INTyCONT</td>
<td>INTyE</td>
<td>reserved</td>
<td>INTySEL</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>3 - 0</td>
</tr>
<tr>
<td>reserved</td>
<td>INTxCONT</td>
<td>INTxE</td>
<td>reserved</td>
<td>INTxSEL</td>
</tr>
</tbody>
</table>

**ADCINTx/y Continuous Mode Enable**
- 0 = one-shot pulse generated (until flag cleared by user)
- 1 = pulse generated for each EOC

**ADCINTx/y Interrupt Enable**
- 0 = disable
- 1 = enable

**ADCINTx/y EOC Source Select**
- 00h = EOC0 is trigger for ADCINTx/y
- 01h = EOC1 is trigger for ADCINTx/y
- 02h = EOC2 is trigger for ADCINTx/y
- 03h = EOC3 is trigger for ADCINTx/y
- 04h = EOC4 is trigger for ADCINTx/y
- 05h = EOC5 is trigger for ADCINTx/y
- 06h = EOC6 is trigger for ADCINTx/y
- 07h = EOC7 is trigger for ADCINTx/y
- 08h = EOC8 is trigger for ADCINTx/y
- 09h = EOC9 is trigger for ADCINTx/y
- 0Ah = EOC10 is trigger for ADCINTx/y
- 0Bh = EOC11 is trigger for ADCINTx/y
- 0Ch = EOC12 is trigger for ADCINTx/y
- 0Dh = EOC13 is trigger for ADCINTx/y
- 0Eh = EOC14 is trigger for ADCINTx/y
- 0Fh = EOC15 is trigger for ADCINTx/y

### ADC Conversion Result Registers

**12-Bit Mode**

AdcnResultRegs.ADCRESULTx \( n = a - d \) \( x = 0 - 15 \)

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ADCINx Voltage</th>
<th>Digital Results</th>
<th>AdcnResultRegs. ADCRESULTx</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.0V</td>
<td>FFFh</td>
<td>0000</td>
</tr>
<tr>
<td>1.5V</td>
<td>7FFh</td>
<td>0000</td>
</tr>
<tr>
<td>0.00073V</td>
<td>1h</td>
<td>0000</td>
</tr>
<tr>
<td>0V</td>
<td>0h</td>
<td>0000</td>
</tr>
</tbody>
</table>

- Single-ended – one input pin (ADCINx)
- External reference (VREFHI and VREFLO)
ADC Conversion Result Registers
16-Bit Mode

\[ n = a - d \quad x = 0 - 15 \]

<table>
<thead>
<tr>
<th>ADC(x)P Voltage</th>
<th>ADC(x)N Voltage</th>
<th>Digital Results</th>
<th>ADC(n)ResultRegs. ADCRESULT(x)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.0V</td>
<td>0V</td>
<td>FFFFh</td>
<td>1111</td>
</tr>
<tr>
<td>1.5V</td>
<td>1.5V</td>
<td>7FFFh</td>
<td>0111</td>
</tr>
<tr>
<td>45(\mu)V</td>
<td>3.0V - 45(\mu)V</td>
<td>1h</td>
<td>0000</td>
</tr>
<tr>
<td>0V</td>
<td>3.0V</td>
<td>0h</td>
<td>0000</td>
</tr>
</tbody>
</table>

- Differential – two input pins (ADC\(x\)P & ADC\(x\)N)
- Input voltage is the difference between the two pins
- External reference (VREFHI and VREFLO)

Signed Input Voltages

How Can We Handle Signed Input Voltages?

Example: \(-1.5 \leq V_{in} \leq +1.5 \) V

1) Add 1.5 volts to the analog input

2) Subtract “1.5” from the digital result

```c
#include "F2837xD_Device.h"
#define offset 0x07FF
void main(void)
{
    int16 value; // signed
    value = AdcaResultRegs.ADCRESULT0 - offset;
}
```
ADC Calibration and Reference

**Built-In ADC Calibration**

- TI reserved OTP contains device specific calibration data for the ADC, internal oscillators and buffered DAC
- The Boot ROM contains a Device_cal() routine that copies the calibration data to their respective registers
- Device_cal() must be run to meet the specifications in the datasheet
  - The Bootloader automatically calls Device_cal() such that no action is normally required by the user
  - If the Bootloader is bypassed (e.g. during development) Device_cal() should be called by the application:

  ```c
  #define Device_cal (void (*)(void))0x70282
  void main(void)
  {
    (*Device_cal)();       // call Device_cal()
  }
  ```

- AdcSetMode() function is called in the source code to trim the ADC

**Manual ADC Calibration**

- If the offset and gain errors in the datasheet are unacceptable for your application, or you want to also compensate for board level errors (e.g. sensor or amplifier offset), you can manually calibrate
  - **Offset error (12-bit mode)**
    - Compensated in analog with the ADCOFFTRIM register
    - No reduction in full-scale range
    - Configure input to VREFLO, set ADCOFFTRIM to maximum offset error, and take a reading
    - Re-adjust ADCOFFTRIM to make result zero
  - **Gain error**
    - Compensated in software
    - Some loss in full-scale range
    - Requires use of a second ADC input pin and an upper-range reference voltage on that pin; see “TMS320x280x and TMS320x2801x ADC Calibration” appnote #SPRAAD8A for more information
Analog Subsystem External Reference

Reference Generation

Voltage Reference

REF3230
REF3225
REF3030
REF3025
(or similar)

Non-Inverting Buffers

ADC

VREFHIA
VREFLOA
VREFHIB
VREFLOB
VREFHIC
VREFLOC
VREFHID
VREFLOD
The F2837xD includes eight independent Comparator Subsystem (CMPSS) modules that are useful for supporting applications such as peak current mode control, switched-mode power, power factor correction, and voltage trip monitoring. The Comparator Subsystem modules have the ability to synchronize with a PWMSYNC event.
Each CMPSS module is designed around a pair of analog comparators which generates a digital output indicating if the voltage on the positive input is greater than the voltage on the negative input. The positive input to the comparator is always driven from an external pin. The negative input can be driven by either an external pin or an internal programmable 12-bit digital-to-analog (DAC) as a reference voltage. Values written to the DAC can take effect immediately or be synchronized with ePWM events. A falling-ramp generator is optionally available to the control the internal DAC reference value for one comparator in the module. Each comparator output is feed through a programmable digital filter that can remove spurious trip signals. The output of the CMPSS generates trip signals to the ePWM event trigger submodule and GPIO structure.
Digital-to-Analog Converter (DAC)

- Three buffered 12-bit DACs
- Provides a programmable reference output voltage
- Capable of driving an external load
- Ability to be synchronized with PWMSYNC events
- Selectable reference voltage

The F2837xD includes three buffered 12-bit DAC modules that can provide a programmable reference output voltage capable of driving an external load. Values written to the DAC can take effect immediately or be synchronized with ePWM events.
Two sets of DACVAL registers are present in the buffered DAC module: DACVALA and DACVALS. DACVALA is a read-only register that actively controls the DAC value. DACVALS is a writable shadow register that loads into DACVALA either immediately or synchronized with the next PWMSYNC event. The ideal output of the internal DAC can be calculated as shown in the equation below.
Sigma Delta Filter Module (SDFM)

SDFM is a four-channel digital filter designed specifically for current measurement and resolver position decoding in motor control applications.

- Each channel can receive an independent modulator bit stream.
- Bit streams are processed by four individually programmable digital decimation filters.
- Filters include a fast comparator for immediate digital threshold comparisons for over-current monitoring.
- Filter-bypass mode available to enable data logging, analysis, and customized filtering.

The SDFM is a four-channel digital filter designed specifically for current measurement and resolver position decoding in motor control applications. Each channel can receive an independent delta-sigma modulator bit stream which is processed by four individually programmable digital decimation filters. The filters include a fast comparator for immediate digital threshold comparisons for over-current and under-current monitoring. Also, a filter-bypass mode is available to enable data logging, analysis, and customized filtering. The SDFM pins are configured using the GPIO multiplexer. A key benefit of the SDFM is it enables a simple, cost-effective, and safe high-voltage isolation boundary.
SDFM Block Diagram

Sigma Delta Filter Module (SDFM)
Lab 6: Analog-to-Digital Converter

**Objective**

The objective of this lab exercise is to become familiar with the programming and operation of the on-chip analog-to-digital converter (ADC). The microcontroller (MCU) will be setup to sample a single ADC input channel at a prescribed sampling rate and store the conversion result in a circular memory buffer. In the second part of this lab exercise, the digital-to-analog converter (DAC) will be explored.

Recall that there are three basic ways to initiate an ADC start of conversion (SOC):

1. **Using software**
   - SOCx bit (where \( x = 0 \) to 15) in the ADC SOC Force 1 Register (ADCSOCFRC1) causes a software initiated conversion

2. **Automatically triggered on user selectable conditions**
   - CPU Timer 0/1/2 interrupt
   - ePWMxSOCA / ePWMxSOCB (where \( x = 1 \) to 12)
     - ePWM underflow (CTR = 0)
     - ePWM period match (CTR = PRD)
     - ePWM underflow or period match (CTR = 0 or PRD)
     - ePWM compare match (CTRU/D = CMPA/B/C/D)
   - ADC interrupt ADCINT1 or ADCINT2
     - triggers SOCx (where \( x = 0 \) to 15) selected by the ADC Interrupt Trigger SOC Select1/2 Register (ADCINTSOCSEL1/2)

3. **Externally triggered using a pin**
   - ADCSOC pin (GPIO/ADCEXTSOC)

One or more of these methods may be applicable to a particular application. In this lab exercise, we will be using the ADC for data acquisition. Therefore, one of the ePWMs (ePWM2) will be configured to automatically trigger the SOCA signal at the desired sampling rate (ePWM period match CTR = PRD SOC method 2b above). The ADC end-of-conversion interrupt will be used to...
prompt the CPU to copy the results of the ADC conversion into a results buffer in memory. This buffer pointer will be managed in a circular fashion, such that new conversion results will continuously overwrite older conversion results in the buffer. In order to generate an interesting input signal, the code also alternately toggles a GPIO pin (GPIO18) high and low in the ADC interrupt service routine. The ADC ISR will also toggle LED D9 on the LaunchPad as a visual indication that the ISR is running. This pin will be connected to the ADC input pin, and sampled. After taking some data, Code Composer Studio will be used to plot the results. A flow chart of the code is shown in the following slide.

### Lab 6: Code Flow Diagram

![Lab 6: Code Flow Diagram](image)

**Start**
- **General Initialization**
  - PLL and clocks
  - Watchdog configure
  - GPIO setup
  - PIE initialization

**ADC Initialization**
- convert channel A0 on ePWM2 period match
- send interrupt on EOC to trigger ADC ISR
- setup a results buffer in memory

**ePWM2 Initialization**
- clear counter
- set period register
- set to trigger ADC on period match
- set the clock prescaler
- enable the timer

**Main Loop**
```c
while(1)
{
}
```

**ADC ISR**
- read the ADC result
- write to result buffer
- adjust the buffer pointer
- toggle the GPIO pin
- return from interrupt

**Notes**

- Program performs conversion on ADC channel A0 (ADCINA0 pin)
- ADC conversion is set at a 50 kHz sampling rate
- ePWM2 is triggering the ADC on period match using SOCA trigger
- Data is continuously stored in a circular buffer
- GPIO18 pin is also toggled in the ADC ISR
- ADC ISR will also toggle the LaunchPad LED D9 as a visual indication that it is running
## Procedure

### Open the Project

1. A project named `Lab6` has been created for this lab exercise. Open the project by clicking on `Project → Import CCS Projects`. The “Import CCS Eclipse Projects” window will open then click `Browse...` next to the “Select search-directory” box. Navigate to `C:\C28x\Labs\Lab6\cpu01` and click `OK`. Then click `Finish` to import the project. All build options have been configured the same as the previous lab exercise. The files used in this lab exercise are:

   - `Adc.c`
   - `Gpio.c`
   - `CodeStartBranch.asm`
   - `Lab_5_6_7.cmd`
   - `Dac.c`
   - `Main_6.c`
   - `DefaultIsr_6.c`
   - `PieCtrl.c`
   - `DelayUs.asm`
   - `PieVect.c`
   - `EPwm_6.c`
   - `Sinetable.c`
   - `F28x7xD_Adcc.c`
   - `SysCtrl.c`
   - `F2837xD_GlobalVariableDefs.c`
   - `Watchdog.c`
   - `F2837xD_Headers_nonBIOS_cpu1.cmd`
   - `Xbar.c`

   **Note:** The `Dac.c` and `SineTable.c` files are used to generate a sine waveform in the second part of this lab exercise.

### Setup ADC Initialization and Enable Core/PIE Interrupts

2. In `Main_6.c` add code to call the `InitAdca()`, `InitEPwm()` and `InitDacb()` functions. The `InitEPwm()` function is used to configure ePWM2 to trigger the ADC at a 50 kHz rate. Details about the ePWM and control peripherals will be discussed in the next module. The `InitDacb()` function will be used in the second part of this lab exercise.

3. Edit `Adc.c` to configure SOC0 in the ADC as follows:
   - SOC0 converts input ADCINA0 in single-sample mode
   - SOC0 has a 20 SYSCLK cycle acquisition window
   - SOC0 is triggered by the ePWM2 SOCA
   - SOC0 triggers ADCINT1 on end-of-conversion
   - All SOCs run round-robin

   Be sure to modify `Adc.c` and *not* `F2837xD_Adcc.c` which is used for the ADC calibration.

4. Using the “PIE Interrupt Assignment Table” find the location for the ADC interrupt “ADCA1” and fill in the following information:

   **PIE group #:** __________  # within group: __________

   This information will be used in the next step.

5. Modify the end of `Adc.c` to do the following:
   - Enable the “ADCA1” interrupt in the PIE (Hint: use the PieCtrlRegs structure)
   - Enable the appropriate core interrupt in the IER register

6. Open and inspect `DefaultIsr_6.c`. This file contains the ADC interrupt service routine. Save your work.
Build and Load

7. Click the "Build" button and watch the tools run in the Console window. Check for errors in the Problems window.

8. Click the "Debug" button (green bug). A Launching Debug Session window will open. Select only CPU1 to load the program on (i.e. uncheck CPU2), and then click OK. Then the CCS Debug perspective view should open, the program will load automatically, and you should now be at the start of main(). If the device has been power cycled since the last lab exercise, be sure to configure the boot mode to EMU_BOOT_SARAM using the Scripts menu.

Run the Code

9. In Main_6.c place the cursor in the "main loop" section, right click on the mouse key and select Run To Line.

Open a memory browser to view some of the contents of the ADC results buffer. The address label for the ADC results buffer is AdcBuf (type &AdcBuf) in the “Data” memory page. Then <enter> to view the contents of the ADC result buffer.

Note: Exercise care when connecting any jumper wires to the LaunchPad header pins since the power to the USB connector is on!

Refer to the following diagram for the location of the pins that will need to be connected:

10. Using a jumper wire, connect the ADCINA0 (header J3, pin #30) to “GND” (header J2, pin #20) on the LaunchPad. Then run the code again, and halt it after a few seconds. Verify that the ADC results buffer contains the expected value of ~0x0000. Note that you may not get exactly 0x0000 if the device you are using has positive offset error.

11. Adjust the jumper wire to connect the ADCINA0 (header J3, pin #30) to “+3.3V” (header J1, pin #3; GPIO-19) on the LaunchPad. (Note: pin # GPIO-19 has been set to “1” in Gpio.c). Then run the code again, and halt it after a few seconds. Verify that the ADC results buffer contains the expected value of ~0x0FFF. Note that you may not get exactly 0x0FFF if the device you are using has negative offset error.

12. Adjust the jumper wire to connect the ADCINA0 (header J3, pin #30) to GPIO18 (header J1, pin #4) on the LaunchPad. Then run the code again, and halt it after a few seconds. Examine the contents of the ADC results buffer (the contents should be alternating ~0x0000 and ~0x0FFF values). Are the contents what you expected?

13. Open and setup a graph to plot a 50-point window of the ADC results buffer. Click: Tools → Graph → Single Time and set the following values:
Lab 6: Analog-to-Digital Converter

<table>
<thead>
<tr>
<th>Acquisition Buffer Size</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>50000</td>
</tr>
<tr>
<td>Start Address</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Display Data Size</td>
<td>50</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>μs</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.

14. Recall that the code toggled the GPIO18 pin alternately high and low. (Also, the ADC ISR is toggling the LED D9 on the LaunchPad as a visual indication that the ISR is running). If you had an oscilloscope available to display GPIO18, you would expect to see a square-wave. Why does Code Composer Studio plot resemble a triangle wave? What is the signal processing term for what is happening here?

15. Recall that the program toggled the GPIO18 pin at a 50 kHz rate. Therefore, a complete cycle (toggle high, then toggle low) occurs at half this rate, or 25 kHz. We therefore expect the period of the waveform to be 40 μs. Confirm this by measuring the period of the triangle wave using the "measurement marker mode" graph feature. In the graph window toolbar, left-click on the ruler icon with the red arrow. Note when you hover your mouse over the icon, it will show "Toggle Measurement Marker Mode". Move the mouse to the first measurement position and left-click. Again, left-click on the Toggle Measurement Marker Mode icon. Move the mouse to the second measurement position and left-click. The graph will automatically calculate the difference between the two values taken over a complete waveform period. When done, clear the measurement points by right-clicking on the graph and select Remove All Measurement Marks (or Ctrl+Alt+M).

Using Real-time Emulation

Real-time emulation is a special emulation feature that offers two valuable capabilities:

A. Windows within Code Composer Studio can be updated at up to a 10 Hz rate while the MCU is running. This not only allows graphs and watch windows to update, but also allows the user to change values in watch or memory windows, and have those changes affect the MCU behavior. This is very useful when tuning control law parameters on-the-fly, for example.

B. It allows the user to halt the MCU and step through foreground tasks, while specified interrupts continue to get serviced in the background. This is useful when debugging portions of a real-time system (e.g., serial port receive code) while keeping critical parts of your system operating (e.g., commutation and current loops in motor control).

We will only be utilizing capability “A” above during the workshop. Capability “B” is a particularly advanced feature, and will not be covered in the workshop.

16. The memory and graph windows displaying AdcBuf should still be open. The jumper wire between ADCINA0 (header J3, pin #30) and GPIO18 (header J1, pin #4) should still be connected. In real-time mode, we will have our window continuously refresh at the default rate. To view the refresh rate click:
Window → Preferences…

and in the section on the left select the “Code Composer Studio” category. Click the plus sign (+) to the left of “Code Composer Studio” and select “Debug”. In the section on the right notice the default setting:

- “Continuous refresh interval (milliseconds)” = 500

Click OK.

Note: Decreasing the “Continuous refresh interval” causes all enabled continuous refresh windows to refresh at a faster rate. This can be problematic when a large number of windows are enabled, as bandwidth over the emulation link is limited. Updating too many windows can cause the refresh frequency to bog down. In this case you can just selectively enable continuous refresh for the individual windows of interest.

17. Next we need to enable the graph window for continuous refresh. Select the “Single Time” graph. In the graph window toolbar, left-click on the yellow icon with the arrows rotating in a circle over a pause sign. Note when you hover your mouse over the icon, it will show “Enable Continuous Refresh”. This will allow the graph to continuously refresh in real-time while the program is running.

18. Enable the Memory Browser for continuous refresh using the same procedure as the previous step.

19. Code Composer Studio includes Scripts that are functions which automate entering and exiting real-time mode. Four functions are available:
   - Run_Realtime_with_Reset (reset CPU, enter real-time mode, run CPU)
   - Run_Realtime_with_Restart (restart CPU, enter real-time mode, run CPU)
   - Full_Halt (exit real-time mode, halt CPU)
   - Full_Halt_with_Reset (exit real-time mode, halt CPU, reset CPU)

These Script functions are executed by clicking:

Scripts → Realtime Emulation Control → Function

In the remaining lab exercises we will be using the first and third above Script functions to run and halt the code in real-time mode. Alternatively, the CPU Reset, Real-time mode, Resume, and Suspend buttons on the Code Composer Studio tool bar can be used.

20. Run the code and watch the windows update in real-time mode. Click:

Scripts → Realtime Emulation Control → Run_Realtime_with_Reset

21. Carefully remove and replace the jumper wire from GPIO18 (header J1, pin #4). Are the values updating in the Memory Browser and Single Time graph as expected?

22. Fully halt the CPU in real-time mode. Click:

Scripts → Realtime Emulation Control → Full_Halt

23. So far, we have seen data flowing from the MCU to the debugger in realtime. In this step, we will flow data from the debugger to the MCU.
   - Open and inspect Main_6.c. Notice that the global variable DEBUG_TOGGLE is used to control the toggling of the GPIO18 pin. This is the pin being read with the ADC.
• Highlight DEBUG_TOGGLE with the mouse, right click and select "Add Watch Expression..." and then select OK. The global variable DEBUG_TOGGLE should now be in the Expressions window with a value of “1”.
• Enable the Expressions window for continuous refresh
• Run the code in real-time mode and change the value to “0”. Are the results shown in the memory and graph window as expected? Change the value back to “1”. As you can see, we are modifying data memory contents while the processor is running in real-time (i.e., we are not halting the MCU nor interfering with its operation in any way)! When done, fully halt the CPU.

Setup DAC to Generate a Sine Waveform

Next, we will configure DACB to generate a fixed frequency sine wave. This signal will appear on an analog output pin of the device (ADC-A1). Then using the jumper wire we will connect the DACB output to the ADCA input (ADC-A0) and display the sine wave in a graph window.

24. Notice the following code lines in the ADCA1 ISR in DefaultIsr_6.c:

```c
//--- Write to DAC-B to create input to ADC-A0
if(SINE_ENABLE == 1)
{
    DacOutput = DacOffset + ((QuadratureTable[iQuadratureTable++] ^ 0x8000) >> 5);
} else
{
    DacOutput = DacOffset;
}
if(iQuadratureTable > (SINE_PTS-1))       // Wrap the index
    iQuadratureTable = 0;
DacbRegs.DACVALS.all = DacOutput;
```

The variable DacOffset allows the user to adjust the DC output of DACB from the Expressions window in CCS. The variable Sine_Enable is a switch which adds a fixed frequency sine wave to the DAC offset. The sine wave is generated using a 25-point look-up table contained in the SineTable.c file. We will plot the sine wave in a graph window while manually adjusting the offset.

25. Open and inspect SineTable.c. (If needed, open the Project Explorer window in the CCS Debug perspective view by clicking View → Project Explorer). The file consists of an array of 25 signed integer points which represent four quadrants of sinusoidal data. The 25 points are a complete cycle. In the source code we need to sequentially access each of the 25 points in the array, converting each one from signed 16-bit to un-signed 12-bit format before writing it to the DACVALS register of DACB.

26. Add the following variables to the Expressions window:

• Sine_Enable

• DacOffset

27. Adjust the jumper wire to connect the ADCINA0 (header J3, pin #30) to DACB (header J7, pin #70) on the LaunchPad. Refer to the following diagram for the pins that need to be connected.
28. Run the code (real-time mode) using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset.

29. At this point, the graph should be displaying a DC signal near zero. Click on the dacOffset variable in the Expressions window and change the value to 800. This changes the DC output of the DAC which is applied to the ADC input. The level of the graph display should be about 800 and this should be reflected in the value shown in the memory buffer (note: 800 decimal = 0x320 hex).

30. Enable the sine generator by changing the variable Sine_Enable in the Expressions window to 1.

31. You should now see sinusoidal data in the graph window.

32. Try removing and re-connecting the jumper wire to show this is real data is running in real-time emulation mode. Also, you can try changing the DC offset variable to move the input waveform to a different average value (the maximum distortion free offset is about 2000).

33. Fully halt the code (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

**Terminate Debug Session and Close Project**

34. Terminate the active debug session using the Terminate button. This will close the debugger and return Code Composer Studio to the CCS Edit perspective view.

35. Next, close the project by right-clicking on Lab6 in the Project Explorer window and select Close Project.

**Optional Exercise**

If you finish early, you might want to experiment with the code by observing the effects of changing the OFFTRIM value. Open a watch window to the AdcaRegs.ADCOFFTRIM register and change the OFFTRIM value. If you did not get 0x0000 in step 11, you can calibrate out the offset of your device. If you did get 0x0000, you can determine if you actually had zero offset, or
if the offset error of your device was negative. (If you do not have time to work on this optional exercise, you may want to try this later).

End of Exercise
Control Peripherals

Introduction

The C2000 high-performance control peripherals are an integral component for all digital control systems, and within the F2837xD these peripherals are common between the two CPU subsystems. After reset they are connected to the CPU1 subsystem, and a series of CPU Select registers are used to configure each peripheral individually to be either controlled CPU1 subsystem or CPU2 subsystem. This module starts with a review of pulse width modulation (PWM) and then explains how the ePWM is used for generating PWM waveforms. Also, the use of the eCAP and the eQEP will be discussed.

Module Objectives

- Pulse Width Modulation (PWM) review
- Generate a PWM waveform with the Pulse Width Modulator Module (ePWM)
- Use the Capture Module (eCAP) to measure the width of a waveform
- Explain the function of Quadrature Encoder Pulse Module (eQEP)

Note: Different numbers of ePWM, eCAP, and eQEP modules are available on F28x7x devices. See the device datasheet for more information.
Chapter Topics

Control Peripherals ..................................................................................................................... 7-1

PWM Review.............................................................................................................................. 7-3

ePWM .................................................................................................................................... 7-5
  ePWM Time-Base Sub-Module ......................................................................................... 7-7
  ePWM Compare Sub-Module ......................................................................................... 7-11
  ePWM Action Qualifier Sub-Module ........................................................................ 7-14
  Asymmetric and Symmetric Waveform Generation using the ePWM .................. 7-22
  PWM Computation Example ......................................................................................... 7-23
  ePWM Dead-Band Sub-Module ................................................................................... 7-24
  ePWM Chopper Sub-Module ......................................................................................... 7-27
  ePWM Trip-Zone and Digital Compare Sub-Modules .............................................. 7-30
  ePWM Event-Trigger Sub-Module ............................................................................... 7-38
  High Resolution PWM (HRPWM) ............................................................................. 7-40

  eCAP .............................................................................................................................. 7-41

  eQEP ............................................................................................................................ 7-47

Lab 7: Control Peripherals ...................................................................................................... 7-50
PWM Review

What is Pulse Width Modulation?

- PWM is a scheme to represent a signal as a sequence of pulses
- fixed carrier frequency
- fixed pulse amplitude
- pulse width proportional to instantaneous signal amplitude
- PWM energy \( \approx \) original signal energy

Pulse width modulation (PWM) is a method for representing an analog signal with a digital approximation. The PWM signal consists of a sequence of variable width, constant amplitude pulses which contain the same total energy as the original analog signal. This property is valuable in digital motor control as sinusoidal current (energy) can be delivered to the motor using PWM signals applied to the power converter. Although energy is input to the motor in discrete packets, the mechanical inertia of the rotor acts as a smoothing filter. Dynamic motor motion is therefore similar to having applied the sinusoidal currents directly.
Why use PWM with Power Switching Devices?

- Desired output currents or voltages are known
- Power switching devices are transistors
  - Difficult to control in proportional region
  - Easy to control in saturated region
- PWM is a digital signal ⇒ easy for MCU to output

Power switching devices can be difficult to control when operating in the proportional region, but are easy to control in the saturation and cutoff regions. Since PWM is a digital signal by nature and easy for an MCU to generate, it is ideal for use with power switching devices. Essentially, PWM performs a DAC function, where the duty cycle is equivalent to the DAC analog amplitude value.
The ePWM modules are highly programmable, extremely flexible, and easy to use, while being capable of generating complex pulse width waveforms with minimal CPU overhead or intervention. Each ePWM module is identical with two PWM outputs, EPWMxA and EPWMxB, and multiple modules can synchronize to operate together as required by the system application design. The generated PWM waveforms are available as outputs on the GPIO pins. Additionally, the EPWM module can generate ADC starter conversion signals and generate interrupts to the PIE block. External trip zone signals can trip the output, as well as generate interrupts. The outputs of the comparators are used as inputs to the ePWM X-Bar. Next, the internal details of the ePWM module will be covered.
Various ePWM modules (and eCAP units) can be grouped together for synchronization.

The ePWM module consists of eight submodules: time-base, counter-compare, action-qualifier, dead-band generator, PWM chopper, trip-zone, digital-compare, and event-trigger.
The time-base submodule consists of a dedicated 16-bit counter, along with built-in synchronization logic to allow multiple ePWM modules to work together as a single system. A clock pre-scaler divides the EPWM clock to the counter and a period register is used to control the frequency and period of the generated waveform. The period register has a shadow register, which acts like a buffer to allow the register updates to be synchronized with the counter, thus avoiding corruption or spurious operation from the register being modified asynchronously by the software.
The time-base counter operates in three modes: up-count, down-count, and up-down-count. In up-count mode the time-base counter starts counting from zero and increments until it reaches the period register value, then the time-base counter resets to zero and the count sequence starts again. Likewise, in down-count mode the time-base counter starts counting from the period register value and decrements until it reaches zero, then the time-base counter is loaded with the period value and the count sequence starts again. In up-down-count mode the time-base counter starts counting from zero and increments until it reaches the period register value, then the time-base counter decrements until it reaches zero and the count sequence repeats. The up-count and down-count modes are used to generate asymmetrical waveforms, and the up-down-count mode is used to generate symmetrical waveforms.
Synchronization allows multiple ePWM modules to work together as a single system. The synchronization is based on a synch-in signal, time-base counter equals zero, or time-base counter equals compare B register. Additionally, the waveform can be phase-shifted.

**ePWM Time-Base Sub-Module Registers**  
(lab file: EPwm.c)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>TBCTL</td>
<td>Time-Base Control</td>
<td>EPwmRegs.TBCTL.all =</td>
</tr>
<tr>
<td>TBCTL2</td>
<td>Time-Base Control</td>
<td>EPwmRegs.TBCTL2.all =</td>
</tr>
<tr>
<td>TBSTS</td>
<td>Time-Base Status</td>
<td>EPwmRegs.TBSTS.all =</td>
</tr>
<tr>
<td>TBPHS</td>
<td>Time-Base Phase</td>
<td>EPwmRegs.TBPHS =</td>
</tr>
<tr>
<td>TBCTR</td>
<td>Time-Base Counter</td>
<td>EPwmRegs.TBCTR =</td>
</tr>
<tr>
<td>TBPRD</td>
<td>Time-Base Period</td>
<td>EPwmRegs.TBPRD =</td>
</tr>
</tbody>
</table>
**ePWM Time-Base Control Register**  
EPwm\_x\_Regs.TBCTL

### Upper Register:

#### Phase Direction
- 0 = count down after sync
- 1 = count up after sync

#### TBCLK = EPWMCLK / (HSPCLKDIV \* CLKDIV)

<table>
<thead>
<tr>
<th>Register</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREE_SOFT</td>
<td>15 - 14</td>
</tr>
<tr>
<td>PHSDIR</td>
<td>13</td>
</tr>
<tr>
<td>CLKDIV</td>
<td>12 - 10</td>
</tr>
<tr>
<td>HSPCLKDIV</td>
<td>9 - 7</td>
</tr>
</tbody>
</table>

#### Emulation Halt Behavior
- 00 = stop after next CTR inc/dec
- 01 = stop when:
  - Up Mode; CTR = PRD
  - Down Mode; CTR = 0
  - Up/Down Mode; CTR = 0
- 1x = free run (do not stop)

#### TB Clock Prescale
- 000 = /1 (default)
- 001 = /2
- 010 = /4
- 011 = /8
- 100 = /16
- 101 = /32
- 110 = /64
- 111 = /128

#### High Speed TB Clock Prescale
- 000 = /1 (default)
- 001 = /2
- 010 = /4
- 011 = /6
- 100 = /8
- 101 = /10
- 110 = /12
- 111 = /14

(HSPCLKDIV is for legacy compatibility)

### Lower Register:

#### Software Force Sync Pulse
- 0 = no action
- 1 = force one-time sync

#### Counter Mode
- 00 = count up
- 01 = count down
- 10 = count up and down
- 11 = stop – freeze (default)

#### Period Shadow Load
- 0 = load on CTR = 0
- 1 = load immediately

#### Sync Output Select
- 00 = EPWMxSYNCI
- 01 = CTR = 0
- 10 = CTR = CMPB *
- 11 = disable SyncOut

* CMPC and CMPD option available in TBCTL2 register
The counter-compare submodule continuously compares the time-base count value to four counter compare registers (CMPA, CMPB, CMPC, and CMPD) and generates four independent compare events (i.e. time-base counter equals a compare register value) which are fed to the action-qualifier and event-trigger submodules. The counter compare registers are shadowed to prevent corruption or glitches during the active PWM cycle. Typically CMPA and CMPB are used to control the duty cycle of the generated PWM waveform, and all four compare registers can be used to start an ADC conversion or generate an ePWM interrupt. For the up-count and down-count modes, a counter match occurs only once per cycle, however for the up-down-count mode a counter match occurs twice per cycle since there is a match on the up count and down count.
The above ePWM Compare Event Waveform diagram shows the compare matches which are fed into the action qualifier. Notice that with the count up and countdown mode, there are matches on the up-count and down-count.

### ePWM Compare Sub-Module Registers

*(lab file: EPwm.c)*

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMPCTL</td>
<td>Compare Control</td>
<td>EPwmRegs.CMPCTL.all =</td>
</tr>
<tr>
<td>CMPCTL2</td>
<td>Compare Control</td>
<td>EPwmRegs.CMPCTL2.all =</td>
</tr>
<tr>
<td>CMPA</td>
<td>Compare A</td>
<td>EPwmRegs.CMPA =</td>
</tr>
<tr>
<td>CMPB</td>
<td>Compare B</td>
<td>EPwmRegs.CMPB =</td>
</tr>
<tr>
<td>CMPC</td>
<td>Compare C</td>
<td>EPwmRegs.CMPC =</td>
</tr>
<tr>
<td>CMPD</td>
<td>Compare D</td>
<td>EPwmRegs.CMPD =</td>
</tr>
</tbody>
</table>
### ePWM Compare Control Register
**EPwm\_\_Regs.CMPCTL**

<table>
<thead>
<tr>
<th>15 - 10</th>
<th>9</th>
<th>8</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>SHDWBFULL</td>
<td>SHDWAFULL</td>
<td>reserved</td>
</tr>
</tbody>
</table>

#### CMPA and CMPB Shadow Full Flag
*bit automatically clears on load*
- 0 = shadow not full
- 1 = shadow full

#### CMPA and CMPB Operating Mode
- 0 = shadow mode; double buffer w/ shadow register
- 1 = immediate mode; shadow register not used

#### CMPA and CMPB Shadow Load Mode
- 00 = load on CTR = 0
- 01 = load on CTR = PRD
- 10 = load on CTR = 0 or PRD
- 11 = freeze (no load possible)

### ePWM Compare Control Register
**EPwm\_\_Regs.CMPCTL2**

<table>
<thead>
<tr>
<th>15 - 14</th>
<th>13 - 12</th>
<th>11 - 10</th>
<th>9 - 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>LOADDSYNC</td>
<td>LOADCSYNC</td>
<td>reserved</td>
</tr>
</tbody>
</table>

#### CMPC and CMPD Shadow Load on Sync Event
- 00 = no sync – use LOADCMODE/LOADDMODE
- 01 = when sync occurs and LOADCMODE/LOADDMODE
- 10 = only when sync is received
- 11 = reserved

#### CMPC and CMPD Operating Mode
- 0 = shadow mode; double buffer w/ shadow register
- 1 = immediate mode; shadow register not used

#### CMPC and CMPD Shadow Load Mode
- 00 = load on CTR = 0
- 01 = load on CTR = PRD
- 10 = load on CTR = 0 or PRD
- 11 = freeze (no load possible)
The action-qualifier submodule is the key element in the ePWM module which is responsible for constructing and generating the switched PWM waveforms. It utilizes match events from the time-base and counter-compare submodules for performing actions on the EPWMxA and EPWMxB output pins. These first three submodules are the main blocks which are used for generating a basic PWM waveform.
The Action Qualifier actions are setting the pin high, clearing the pin low, toggling the pin, or do nothing to the pin, based independently on count-up and count-down time-base match event. The match events are when the time-base counter equals the period register value, the time-base counter is zero, the time-base counter equals CMPA, the time-base counter equals CMPB, or a Trigger event (T1 and T2) based on a comparator, trip, or sync signal. Note that zero and period actions are fixed in time, whereas CMPA and CMPB actions are moveable in time by programming their respective registers. Actions are configured independently for each output using shadowed registers, and any or all events can be configured to generate actions on either output. Also, the output pins can be forced to any action using software.

<table>
<thead>
<tr>
<th>S/W Force</th>
<th>Time-Base Counter equals:</th>
<th>Trigger Events:</th>
<th>EPWM Output Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zero</td>
<td>CMPA</td>
<td>CMPB</td>
</tr>
<tr>
<td>SW X</td>
<td>Z</td>
<td>X</td>
<td>CA</td>
</tr>
<tr>
<td>SW ^</td>
<td>Z</td>
<td>X</td>
<td>CA</td>
</tr>
<tr>
<td>SW T</td>
<td>Z</td>
<td>T</td>
<td>CA</td>
</tr>
</tbody>
</table>

Do Nothing
Clear Low
Set High
Toggle

Tx Event Sources = DCAEV1, DCAEV2, DCBEVT1, DCBEVT2, TZ1, TZ2, TZ3, EPWMxSYNCIN
The next few figures show how the setting of the action qualifier with the compare matches are used to modulate the output pins. Notice that the output pins for EPWMA and EPWMB are completely independent. In the example above, the EPWMA output is being set high on the zero match and cleared low on the compare A match. The EPWMB output is being set high on the zero match and cleared low on the compare B match.
In the example above, the EPWMA output is being set high on the compare A match and being cleared low on the compare B match, while the EPWMB output is being toggled on the zero match.

In the example above, there are different output actions on the up-count and down-count using a single compare register. The EPWMA and EPWMB outputs are being set high on the compare A and B up-count matches and cleared low on the compare A and B down-count matches.
And finally in the example above, again using different output actions on the up-count and down-count, the EPWMA output is being set high on the compare A up-count match and being cleared low on the compare B down-count match. The EPWMB output is being cleared low on the zero match and being set high on the period match.

### ePWM Action Qualifier Sub-Module Registers

(name file: EPwm.c)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>AQCTL</td>
<td>AQ Control Register</td>
<td>EPwmXRegs.AQCTL.all =</td>
</tr>
<tr>
<td>AQCTLA</td>
<td>AQ Control Output A</td>
<td>EPwmXRegs.AQCTLA2.all =</td>
</tr>
<tr>
<td>AQCTLA2</td>
<td>AQ Control Output A</td>
<td>EPwmXRegs.AQCTLB.all =</td>
</tr>
<tr>
<td>AQCTLB</td>
<td>AQ Control Output B</td>
<td>EPwmXRegs.AQCTLB2.all =</td>
</tr>
<tr>
<td>AQTSRCSEL</td>
<td>AQ T Source Select</td>
<td>EPwmXRegs.AQTSRCSEL =</td>
</tr>
<tr>
<td>AQSFRC</td>
<td>AQ S/W Force</td>
<td>EPwmXRegs.AQSFRC.all =</td>
</tr>
<tr>
<td>AQCSFRC</td>
<td>AQ Cont. S/W Force</td>
<td>EPwmXRegs.AQCSFRC.all =</td>
</tr>
</tbody>
</table>

### ePWM Action Qualifier Control Register

EPwmXRegs.CTL

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 - 12</td>
<td>reserved</td>
</tr>
<tr>
<td>11 - 10</td>
<td>SYNC</td>
</tr>
<tr>
<td>9 - 8</td>
<td>SYNC</td>
</tr>
<tr>
<td>7</td>
<td>reserved</td>
</tr>
<tr>
<td>6</td>
<td>SHDOAQ</td>
</tr>
<tr>
<td>5</td>
<td>reserved</td>
</tr>
<tr>
<td>4</td>
<td>SHDWAO</td>
</tr>
<tr>
<td>3 - 2</td>
<td>reserved</td>
</tr>
<tr>
<td>1 - 0</td>
<td>LDAQB MODE/ LDAQA MODE</td>
</tr>
</tbody>
</table>

**Action Qualifier A / Action Qualifier B**

**Operating Mode**

0 = shadow mode; double buffer w/ shadow register
1 = immediate mode; shadow register not used

**Action Qualifier A / Action Qualifier B**

**Shadow Load Mode**

00 = load on CTR = 0
01 = load on CTR = PRD
10 = load on CTR = 0 or PRD
11 = freeze (no load possible)
**ePWM Action Qualifier Control Register**

`EPwmxRegs.AQCTLy (y = A or B)`

- **Action when CTR = CMPB on UP Count**
  - 15 - 12: reserved
  - 11 - 10: CBDF
  - 9 - 8: CB
  - 7 - 6: CAD
  - 5 - 4: CAU
  - 3 - 2: PRD
  - 1 - 0: ZRO

- **Action when CTR = CMPA on UP Count**
  - 15 - 12: reserved
  - 11 - 10: CBDF
  - 9 - 8: CB
  - 7 - 6: CAD
  - 5 - 4: CAU
  - 3 - 2: PRD
  - 1 - 0: ZRO

- **Action when CTR = PRD**
  - 15 - 12: reserved
  - 11 - 10: CBDF
  - 9 - 8: CB
  - 7 - 6: CAD
  - 5 - 4: CAU
  - 3 - 2: PRD
  - 1 - 0: ZRO

**Note:**
- 00 = do nothing (action disabled)
- 01 = clear (low)
- 10 = set (high)
- 11 = toggle (low → high; high → low)

---

**ePWM Action Qualifier Control Register**

`EPwmxRegs.AQCTL2y (y = A or B)`

- **Action when Event occurs on T2 in UP Count**
  - 15 - 8: reserved
  - 7 - 6: T2D
  - 5 - 4: T2U
  - 3 - 2: T1D
  - 1 - 0: T1U

- **Action when Event occurs on T1 in UP Count**
  - 15 - 8: reserved
  - 7 - 6: T2D
  - 5 - 4: T2U
  - 3 - 2: T1D
  - 1 - 0: T1U

**Note:**
- 00 = do nothing (action disabled)
- 01 = clear (low)
- 10 = set (high)
- 11 = toggle (low → high; high → low)
ePWM Action Qualifier Trigger Event Source Select Register
EPwmxRegs.AQTSRCSEL

<table>
<thead>
<tr>
<th></th>
<th>15 - 8</th>
<th>7 - 4</th>
<th>3 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>T2SEL</td>
<td>T1SEL</td>
<td></td>
</tr>
</tbody>
</table>

- **T2 Event Source Select**
- **T1 Event Source Select**

0000 = DCAEVT1
0001 = DCAEVT2
0010 = DCBEVT1
0011 = DCBEVT2
0100 = TZ1
0101 = TZ2
0110 = TZ3
0111 = EPWMxSYNCIN

---

ePWM Action Qualifier S/W Force Register
EPwmxRegs.AQSFRCC

- **One-Time S/W Force on Output B / A**
  - 0 = no action
  - 1 = single s/w force event

<table>
<thead>
<tr>
<th></th>
<th>15 - 8</th>
<th>7 - 6</th>
<th>5</th>
<th>4 - 3</th>
<th>2</th>
<th>1 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>RLDCSF</td>
<td>OTSFB</td>
<td>ACTSFB</td>
<td>OTSFA</td>
<td>ACTSFA</td>
<td></td>
</tr>
</tbody>
</table>

- **AQSFRCC Shadow Reload Options**
  - 00 = load on event CTR = 0
  - 01 = load on event CTR = PRD
  - 10 = load on event CTR = 0 or CTR = PRD
  - 11 = load immediately (from active reg.)

- **Action on One-Time S/W Force B / A**
  - 00 = do nothing (action disabled)
  - 01 = clear (low)
  - 10 = set (high)
  - 11 = toggle (low → high; high → low)
Continuous S/W Force on Output B / A
00 = forcing disabled
01 = force continuous low on output
10 = force continuous high on output
11 = forcing disabled
Asymmetric and Symmetric Waveform Generation using the ePWM

PWM switching frequency:

The PWM carrier frequency is determined by the value contained in the time-base period register, and the frequency of the clocking signal. The value needed in the period register is:

Asymmetric PWM: \[ \text{period register} = \left( \frac{\text{switching period}}{\text{timer period}} \right) - 1 \]

Symmetric PWM: \[ \text{period register} = \frac{\text{switching period}}{2(\text{timer period})} \]

Notice that in the symmetric case, the period value is half that of the asymmetric case. This is because for up/down counting, the actual timer period is twice that specified in the period register (i.e. the timer counts up to the period register value, and then counts back down).

PWM resolution:

The PWM compare function resolution can be computed once the period register value is determined. The largest power of 2 is determined that is less than (or close to) the period value. As an example, if asymmetric was 1000, and symmetric was 500, then:

Asymmetric PWM: approx. 10 bit resolution since \(2^{10} = 1024 \approx 1000\)

Symmetric PWM: approx. 9 bit resolution since \(2^{9} = 512 \approx 500\)

PWM duty cycle:

Duty cycle calculations are simple provided one remembers that the PWM signal is initially inactive during any particular timer period, and becomes active after the (first) compare match occurs. The timer compare register should be loaded with the value as follows:

Asymmetric PWM: \( \text{TxCMPR} = (100\% \text{- duty cycle}) \ast \text{TxPR} \)

Symmetric PWM: \( \text{TxCMPR} = (100\% \text{- duty cycle}) \ast \text{TxPR} \)

Note that for symmetric PWM, the desired duty cycle is only achieved if the compare registers contain the computed value for both the up-count compare and down-count compare portions of the time-base period.
PWM Computation Example

**Symmetric PWM Computation Example**

- Determine TBPRD and CMPA for 100 kHz, 25% duty symmetric PWM from a 100 MHz time base clock

\[
\text{TBPRD} = \frac{1}{2} \cdot \frac{f_{\text{TBCLK}}}{f_{\text{PWM}}} = \frac{1}{2} \cdot \frac{100 \text{ MHz}}{100 \text{ kHz}} = 500
\]

\[
\text{CMPA} = (100\% - \text{duty cycle}) \cdot \text{TBPRD} = 0.75 \times 500 = 375
\]

**Asymmetric PWM Computation Example**

- Determine TBPRD and CMPA for 100 kHz, 25% duty asymmetric PWM from a 100 MHz time base clock

\[
\text{TBPRD} = \frac{f_{\text{TBCLK}}}{f_{\text{PWM}}} - 1 = \frac{100 \text{ MHz}}{100 \text{ kHz}} - 1 = 999
\]

\[
\text{CMPA} = (100\% - \text{duty cycle}) \times (\text{TBPRD}+1) - 1 = 0.75 \times (999+1) - 1 = 749
\]
ePWM Dead-Band Sub-Module

The dead-band sub-module provides a means to delay the switching of a gate signal, thereby allowing time for gates to turn off and preventing a short circuit. This sub-module supports independently programmable rising-edge and falling-edge delays with various options for generating the appropriate signal outputs on EPWMxA and EPWMxB.

Motivation for Dead-Band

- Transistor gates turn on faster than they shut off
- Short circuit if both gates are on at the same time!
To explain further, power-switching devices turn on faster than they shut off. This issue would momentarily provide a path from supply rail to ground, giving us a short circuit. The dead-band sub-module alleviates this issue.

Dead-band control provides a convenient means of combating current shoot-through problems in a power converter. Shoot-through occurs when both the upper and lower gates in the same phase of a power converter are open simultaneously. This condition shorts the power supply and results in a large current draw. Shoot-through problems occur because transistors open faster than they close, and because high-side and low-side power converter gates are typically switched in a complimentary fashion. Although the duration of the shoot-through current path is finite during PWM cycling, (i.e. the closing gate will eventually shut), even brief periods of a short circuit condition can produce excessive heating and over stress in the power converter and power supply.

Two basic approaches exist for controlling shoot-through: modify the transistors, or modify the PWM gate signals controlling the transistors. In the first case, the opening time of the transistor gate must be increased so that it (slightly) exceeds the closing time. One way to accomplish this is by adding a cluster of passive components such as resistors and diodes in series with the transistor gate, as shown in the next figure.

The resistor acts to limit the current rise rate towards the gate during transistor opening, thus increasing the opening time. When closing the transistor however, current flows unimpeded from the gate via the by-pass diode and closing time is therefore not affected. While this passive...
approach offers an inexpensive solution that is independent of the control microprocessor, it is imprecise, the component parameters must be individually tailored to the power converter, and it cannot adapt to changing system conditions.

The second approach to shoot-through control separates transitions on complimentary PWM signals with a fixed period of time. This is called dead-band. While it is possible to perform software implementation of dead-band, the C28x offers on-chip hardware for this purpose that requires no additional CPU overhead. Compared to the passive approach, dead-band offers more precise control of gate timing requirements. In addition, the dead time is typically specified with a single program variable that is easily changed for different power converters or adapted on-line.

ePWM Dead-Band Sub-Module Registers

(lab file: EPwm.c)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBCTL</td>
<td>Dead-Band Control</td>
<td>EPwmRegs.DBCTL.all =</td>
</tr>
<tr>
<td>DBCTL2</td>
<td>Dead-Band Control 2</td>
<td>EPwmRegs.DBCTL2.all =</td>
</tr>
<tr>
<td>DBRED</td>
<td>14-bit Rising Edge Delay</td>
<td>EPwmRegs.DBRED =</td>
</tr>
<tr>
<td>DBFED</td>
<td>14-bit Falling Edge Delay</td>
<td>EPwmRegs.DBFED =</td>
</tr>
</tbody>
</table>

Rising Edge Delay = $T_{TBCLK} \times DBRED$
Falling Edge Delay = $T_{TBCLK} \times DBFED$
The PWM chopper submodule is used with pulse transformer-based gate drives to control the power switching devices. This submodule modulates a high-frequency carrier signal with the PWM waveform that is generated by the action-qualifier and dead-band submodules.
Programmable options are available to support the magnetic properties and characteristics of the transformer and associated circuitry.

**Purpose of the PWM Chopper**

- Allows a high frequency carrier signal to modulate the PWM waveform generated by the Action Qualifier and Dead-Band modules
- Used with pulse transformer-based gate drivers to control power switching elements

Shown in the figure below, a high-frequency carrier signal is ANDed with the ePWM outputs. Also, this circuit provides an option to include a larger, one-shot pulse width before the sustaining pulses.

**ePWM Chopper Waveform**

[Diagram of ePWM Chopper Waveform]

With One-Shot Pulse on EPWMxA and/or EPWMxB
### ePWM Chopper Sub-Module Registers

**(lab file: EPwm.c)**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCCTL</td>
<td>PWM-Chopper Control EPwmxRegs.PCCTL.all =</td>
<td></td>
</tr>
</tbody>
</table>

#### Chopper Control Register

**EPwmxRegs.PCCTL**

<table>
<thead>
<tr>
<th>Chopper Clk Duty Cycle</th>
<th>Chopper Clk Freq.</th>
<th>Chopper Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>000 = 1/8 (12.5%)</td>
<td>000 = SYSCLKOUT/8 ÷ 1</td>
<td>0 = disable (bypass)</td>
</tr>
<tr>
<td>001 = 2/8 (25.0%)</td>
<td>001 = SYSCLKOUT/8 ÷ 2</td>
<td>1 = enable</td>
</tr>
<tr>
<td>010 = 3/8 (37.5%)</td>
<td>010 = SYSCLKOUT/8 ÷ 3</td>
<td></td>
</tr>
<tr>
<td>011 = 4/8 (50.0%)</td>
<td>011 = SYSCLKOUT/8 ÷ 4</td>
<td></td>
</tr>
<tr>
<td>100 = 5/8 (62.5%)</td>
<td>100 = SYSCLKOUT/8 ÷ 5</td>
<td></td>
</tr>
<tr>
<td>101 = 6/8 (75.0%)</td>
<td>101 = SYSCLKOUT/8 ÷ 6</td>
<td></td>
</tr>
<tr>
<td>110 = 7/8 (87.5%)</td>
<td>110 = SYSCLKOUT/8 ÷ 7</td>
<td></td>
</tr>
<tr>
<td>111 = reserved</td>
<td>111 = SYSCLKOUT/8 ÷ 8</td>
<td></td>
</tr>
</tbody>
</table>

**One-Shot Pulse Width**

<table>
<thead>
<tr>
<th>Chopper Clk Duty Cycle</th>
<th>One-Shot Pulse Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000 = 1 x SYSCLKOUT/8</td>
<td>1000 = 9 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0001 = 2 x SYSCLKOUT/8</td>
<td>0101 = 10 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0010 = 3 x SYSCLKOUT/8</td>
<td>0110 = 11 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0011 = 4 x SYSCLKOUT/8</td>
<td>1011 = 12 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0100 = 5 x SYSCLKOUT/8</td>
<td>1100 = 13 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0101 = 6 x SYSCLKOUT/8</td>
<td>1101 = 14 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0110 = 7 x SYSCLKOUT/8</td>
<td>1110 = 15 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0111 = 8 x SYSCLKOUT/8</td>
<td>1111 = 16 x SYSCLKOUT/8</td>
</tr>
</tbody>
</table>
The trip zone and digital compare sub-modules provide a protection mechanism to protect the output pins from abnormalities, such as over-voltage, over-current, and excessive temperature rise.

**Trip-Zone Features**

- **Trip-Zone** has a fast, clock independent logic path to high-impedance the EPWMxA/B output pins
- **Interrupt latency** may not protect hardware when responding to over current conditions or short-circuits through ISR software
- **Supports**: #1) one-shot trip for major short circuits or over current conditions
  
  #2) cycle-by-cycle trip for current limiting operation
The trip-zone submodule utilizes a fast clock independent logic mechanism to quickly handle fault conditions by forcing the EPWMxA and EPWMxB outputs to a safe state, such as high, low, or high-impedance, thus avoiding any interrupt latency that may not protect the hardware when responding to over current conditions or short circuits through ISR software. It supports one-shot trips for major short circuits or over current conditions, and cycle-by-cycle trips for current limiting operation. The trip-zone signals can be generated externally from any GPIO pin which is mapped through the Input X-Bar (TZ1 – TZ3), internally from an inverted eQEP error signal (TZ4), system clock failure (TZ5), or from an emulation stop output from the CPU (TZ6). Additionally, numerous trip-zone source signals can be generated from the digital-compare subsystem.

The power drive protection is a safety feature that is provided for the safe operation of systems such as power converters and motor drives. It can be used to inform the monitoring program of motor drive abnormalities such as over-voltage, over-current, and excessive temperature rise. If the power drive protection interrupt is unmasked, the PWM output pins will be put in a safe immediately after the pin is driven low. An interrupt will also be generated.

The digital compare submodules receive their trip signals from the Input X-BAR and ePWM X-BAR.
The ePWM X-BAR is used to route various internal and external signals to the ePWM modules. Eight trip signals from the ePWM X-BAR are routed to all of the ePWM modules.

The ePWM X-BAR architecture block diagram shown below is replicated 8 times. The ePWM X-BAR can select a single signal or logically OR up to 32 signals. The table in the figure defines the various trip sources that can be multiplexed to the trip-zone and digital compare submodules.
Purpose of the Digital Compare Sub-Module

- Generates ‘compare’ events that can:
  - Trip the ePWM
  - Generate a Trip interrupt
  - Sync the ePWM
  - Generate an ADC start of conversion
- Digital compare module inputs are:
  - Input X-Bar
  - ePWM X-Bar
  - Trip-zone input pins
- A compare event is generated when one or more of its selected inputs are either high or low
- Optional ‘Blanking’ can be used to temporarily disable the compare action in alignment with PWM switching to eliminate noise effects

Digital Compare Sub-Module Signals

The digital-compare subsystem compares signals external to the ePWM module, such as a signal from the CMPSS analog comparators, to directly generate PWM events or actions which are then used by the trip-zone, time-base, and event-trigger submodules. These ‘compare’ events can trip the ePWM module, generate a trip interrupt, sync the ePWM module, or generate an ADC start of conversion.
conversion. A compare event is generated when one or more of its selected inputs are either high or low. The signals can originate from any external GPIO pin which is mapped through the Input X-Bar and from various internal peripherals which are mapped through the ePWM X-Bar. Additionally, an optional 'blanking' function can be used to temporarily disable the compare action in alignment with PWM switching to eliminate noise effects.

### Digital Compare Events

- The user selects the input for each of DCAH, DCAL, DCBH, DCBL
- Each A and B compare uses its corresponding DCyH/L inputs (y = A or B)
- The user selects the signal state that triggers each compare from the following choices:

<table>
<thead>
<tr>
<th></th>
<th>DCyH → low</th>
<th>DCyL → don’t care</th>
</tr>
</thead>
<tbody>
<tr>
<td>i.</td>
<td>DCyH → high</td>
<td>DCyL → don’t care</td>
</tr>
<tr>
<td>ii.</td>
<td>DCyL → low</td>
<td>DCyH → don’t care</td>
</tr>
<tr>
<td>iii.</td>
<td>DCyL → high</td>
<td>DCyH → don’t care</td>
</tr>
<tr>
<td>iv.</td>
<td>DCyL → high</td>
<td>DCyH → low</td>
</tr>
</tbody>
</table>

### ePWM Digital Compare and Trip-Zone Sub-Module Registers

*(lab file: EPwm.c)*

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCACCTL</td>
<td>DC A Control</td>
<td>EPwmRegs.DCACCTL.all =</td>
</tr>
<tr>
<td>DCBCCTL</td>
<td>DC B Control</td>
<td>EPwmRegs.DCBCCTL.all =</td>
</tr>
<tr>
<td>DCTRIPISEP</td>
<td>DC Trip Select</td>
<td>EPwmRegs.DCTRIPISEP.all =</td>
</tr>
<tr>
<td>DCAHTRIPISEP</td>
<td>AH OR Input Select</td>
<td>EPwmRegs.DCAHTRIPISEP.all =</td>
</tr>
<tr>
<td>DCAHTRIPISEP</td>
<td>AL OR Input Select</td>
<td>EPwmRegs.DCAHTRIPISEP.all =</td>
</tr>
<tr>
<td>DCBHTRIPISEP</td>
<td>BH OR Input Select</td>
<td>EPwmRegs.DCBHTRIPISEP.all =</td>
</tr>
<tr>
<td>DCLTRIPISEP</td>
<td>BL OR Input Select</td>
<td>EPwmRegs.DCLTRIPISEP.all =</td>
</tr>
<tr>
<td>TZDCSEL</td>
<td>Digital Compare</td>
<td>EPwmRegs.TZDCSEL.all =</td>
</tr>
<tr>
<td>TZCTL</td>
<td>Trip-Zone Control</td>
<td>EPwmRegs.TZCTL.all =</td>
</tr>
<tr>
<td>TZESEL</td>
<td>Trip-Zone Select</td>
<td>EPwmRegs.TZESEL.all =</td>
</tr>
<tr>
<td>TZEINT</td>
<td>Enable Interrupt</td>
<td>EPwmRegs.TZEINT.all =</td>
</tr>
</tbody>
</table>

*Refer to the Technical Reference Manual for a complete listing of registers*
### ePWM Digital Compare Trip Select Register

**EPwmxRegs.DCTRIPSEL**

<table>
<thead>
<tr>
<th>Digital Compare B Low Input Source Select</th>
<th>Digital Compare B High Input Source Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 - 12 DCBLCOMPSEL</td>
<td>11 - 8 DCBHCOMPSEL</td>
</tr>
<tr>
<td>7 - 4 DCALCOMPSEL</td>
<td>3 - 0 DCAHCOMPSEL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Digital Compare A Low Input Source Select</th>
<th>Digital Compare A High Input Source Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000 = TRIPIN1 &amp; TZ1</td>
<td>0100 = TRIPIN5</td>
</tr>
<tr>
<td>0001 = TRIPIN2 &amp; TZ2</td>
<td>0101 = TRIPIN6</td>
</tr>
<tr>
<td>0010 = TRIPIN3 &amp; TZ3</td>
<td>0110 = TRIPIN7</td>
</tr>
<tr>
<td>0011 = TRIPIN4</td>
<td>0111 = TRIPIN8</td>
</tr>
<tr>
<td>0000 = TRIPIN5</td>
<td>1000 = TRIPIN9</td>
</tr>
<tr>
<td>0010 = TRIPIN2 &amp; TZ2</td>
<td>1010 = TRIPIN11</td>
</tr>
<tr>
<td>0011 = TRIPIN3 &amp; TZ3</td>
<td>1011 = TRIPIN12</td>
</tr>
<tr>
<td>0001 = TRIPIN2 &amp; TZ2</td>
<td>1100 = reserved</td>
</tr>
<tr>
<td>0011 = TRIPIN4</td>
<td>1101 = TRIPIN14</td>
</tr>
<tr>
<td>0011 = TRIPIN4</td>
<td>1110 = TRIPIN15</td>
</tr>
<tr>
<td>0011 = TRIPIN4</td>
<td>1111 = TRIP Combo</td>
</tr>
</tbody>
</table>

### ePWM Trip-Zone Digital Compare Event Select Register

**EPwmxRegs.TZDCSEL**

<table>
<thead>
<tr>
<th>15 - 12</th>
<th>11 - 9</th>
<th>8 - 6</th>
<th>5 - 3</th>
<th>2 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>DCBEVT2</td>
<td>DCBEVT1</td>
<td>DCAEVT2</td>
<td>DCAEVT1</td>
</tr>
</tbody>
</table>

- Digital Compare Output B Event 2/1 Select
- Digital Compare Output A Event 2/1 Select

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>event disable</td>
</tr>
<tr>
<td>001</td>
<td>DCyH → low, DCyL → don't care</td>
</tr>
<tr>
<td>010</td>
<td>DCyH → high, DCyL → don’t care</td>
</tr>
<tr>
<td>011</td>
<td>DCyL → low, DCyH → don’t care</td>
</tr>
<tr>
<td>100</td>
<td>DCyL → high, DCyH → don’t care</td>
</tr>
<tr>
<td>101</td>
<td>DCyL → high, DCyH → low</td>
</tr>
<tr>
<td>11x</td>
<td>reserved</td>
</tr>
</tbody>
</table>

*where y = A or B*
### ePWM Digital Compare Control Register

**EPwmxRegs.DCyCTL (y = A or B)**

- **DCyEVT2 Source Force Sync Signal Select**
  - 0 = synchronous
  - 1 = asynchronous

- **DCyEVT1 Source Force Sync Signal Select**
  - 0 = synchronous
  - 1 = asynchronous

- **DCyEVT1 Source Force Sync Signal Select**
  - 0 = DCyEVT2 signal
  - 1 = DCEVTFILTER signal

<table>
<thead>
<tr>
<th>15-10</th>
<th>9</th>
<th>8</th>
<th>7-4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>EVT2FRC</td>
<td>SYNCSEL</td>
<td>reserved</td>
<td>EVT1SYNC</td>
<td>EVT1SOCE</td>
<td>EVT1FRC</td>
<td>SYNCSEL</td>
</tr>
<tr>
<td>EVT2SRC</td>
<td>SEL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **DCyEVT2 Source Signal Select**
  - 0 = synchronous
  - 1 = asynchronous

- **DCyEVT1 Source Signal Select**
  - 0 = disable
  - 1 = enable

- **EVT1 SOC Generation**
  - 0 = disable
  - 1 = enable

- **EVT1 SYNCE**
  - 0 = disable
  - 1 = enable

### ePWM Trip-Zone Control Register

**EPwmxRegs.TZCTL**

- **Digital Compare Output Event 2/1 Action on EPWMxB**
  - 00 = high impedance
  - 01 = force high
  - 10 = force low
  - 11 = do nothing (disable)

- **Digital Compare Output Event 2/1 Action on EPWMxA**
  - TZ1 to TZ6 Action on EPWMxB / EPWMxA

<table>
<thead>
<tr>
<th>15-12</th>
<th>11-10</th>
<th>9-8</th>
<th>7-6</th>
<th>5-4</th>
<th>3-2</th>
<th>1-0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>DCBEVT2</td>
<td>DCBEVT1</td>
<td>DCAEVT2</td>
<td>DCAEVT1</td>
<td>TZA</td>
<td>TZA</td>
</tr>
</tbody>
</table>
The document contains two sections on ePWM trip-zone settings for the TMS320F2837xD Microcontroller.

### ePWM Trip-Zone Select Register
EPwm\*Regs.TZSEL

#### One-Shot Trip Zone
(event only cleared under S/W control; remains latched)
0 = disable as trip source
1 = enable as trip source

#### Cycle-by-Cycle Trip Zone
(event cleared when CTR = 0; i.e. cleared every PWM cycle)
0 = disable as trip source
1 = enable as trip source

### ePWM Trip-Zone Enable Interrupt Register
EPwm\*Regs.TZEINT

#### Digital Compare Output B Event 2/1 Interrupt Enable
0 = disable
1 = enable

#### Digital Compare Output A Event 2/1 Interrupt Enable
0 = disable
1 = enable

#### One-Shot Interrupt Enable
0 = disable
1 = enable

#### Cycle-by-Cycle Interrupt Enable
0 = disable
1 = enable
The event-trigger submodule manages the events generated by the time-base, counter-compare, and digital-compare submodules for generating an interrupt to the CPU and/or a start of conversion pulse to the ADC when a selected event occurs.
These event triggers can occur when the time-base counter equals zero, period, zero or period, the up or down count match of a compare register. Recall that the digital-compare subsystem can also generate an ADC start of conversion based on one or more compare events. Notice counter up and down are independent and separate.

**ePWM Event-Trigger Sub-Module Registers**

(lab file: EPwm.c)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETSEL</td>
<td>Event-Trigger Selection</td>
<td>EPwmRegs.ETSEL.all</td>
</tr>
<tr>
<td>ETPS</td>
<td>Event-Trigger Pre-Scale</td>
<td>EPwmRegs.ETPS.all</td>
</tr>
<tr>
<td>ETFLG</td>
<td>Event-Trigger Flag</td>
<td>EPwmRegs.ETFLLG.all</td>
</tr>
<tr>
<td>ETCLR</td>
<td>Event-Trigger Clear</td>
<td>EPwmRegs.ETCLR.all</td>
</tr>
<tr>
<td>ETFRC</td>
<td>Event-Trigger Force</td>
<td>EPwmRegs.ETFRC.all</td>
</tr>
</tbody>
</table>


The event-trigger submodule also incorporates pre-scaling logic to issue an interrupt request or ADC start of conversion at every event or up to every fifteenth event.

**ePWM Event-Trigger Selection Register**

EPwmRegs.ETSEL

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Enable SOCB / A</td>
</tr>
<tr>
<td>14–12</td>
<td>Enable EPWMxINT</td>
</tr>
<tr>
<td>11</td>
<td>SOCBEN</td>
</tr>
<tr>
<td>10–8</td>
<td>SOCBSEL</td>
</tr>
<tr>
<td>7–4</td>
<td>SOCAEN</td>
</tr>
<tr>
<td>3</td>
<td>SOCASEL</td>
</tr>
<tr>
<td>2–0</td>
<td>reserved</td>
</tr>
<tr>
<td>3</td>
<td>INTEEN</td>
</tr>
<tr>
<td>2–0</td>
<td>INTSEL</td>
</tr>
</tbody>
</table>

EPWMxSOCB / A Select

- 000 = DCBEVT1 / DCAET1
- 001 = CTR = 0
- 010 = CTR = PRD
- 011 = CTR = 0 or PRD
- 100 = CTRU = CMPA
- 101 = CTRD = CMPA
- 110 = CTRU = CMPB
- 111 = CTRD = CMPB

EPWMxINT Select

- 000 = reserved
- 001 = CTR = 0
- 010 = CTR = PRD
- 011 = CTR = 0 or PRD
- 100 = CTRU = CMPA
- 101 = CTRD = CMPA
- 110 = CTRU = CMPB
- 111 = CTRD = CMPB
High Resolution PWM (HRPWM)

- Significantly increases the resolution of conventionally derived digital PWM
- Uses 8-bit extensions to Compare registers (CMPxHR), Period register (TBPRDHR) and Phase register (TBPHSHR) for edge positioning control
- Typically used when PWM resolution falls below ~9-10 bits which occurs at frequencies greater than ~200 kHz (with system clock of 100 MHz)
- Not all ePWM outputs support HRPWM feature (see device datasheet)

The ePWM module is capable of significantly increase its time resolution capabilities over the standard conventionally derived digital PWM. This is accomplished by adding 8-bit extensions to the counter compare register (CMPxHR), period register (TBPRDHR), and phase register (TBPHSHR), providing a finer time granularity for edge positioning control. This is known as high-resolution PWM (HRPWM) and it is based on micro edge positioner (MEP) technology. The MEP logic is capable of positioning an edge very finely by sub-dividing one coarse system clock of the conventional PWM generator with time step accuracy on the order of 150 pico-seconds. A self-checking software diagnostics mode is used to determine if the MEP logic is running optimally, under all operating conditions such as for variations caused by temperature, voltage, and process. HRPWM is typically used when the PWM resolution falls below approximately 9 or 10 bits which occurs at frequencies greater than approximately 200 kHz with an EPWMCLK of 100 MHz.
eCAP

The capture units allow time-based logging of external signal transitions. It is used to accurately time external events by timestamping transitions on the capture input pin. It can be used to measure the speed of a rotating machine, determine the elapsed time between pulses, calculate the period and duty cycle of a pulse train signal, and decode current/voltage measurements derived from duty cycle encoded current/voltage sensors.

Capture units can be configured to trigger an A/D conversion that is synchronized with an external event. There are several potential advantages to using the capture for this function over the ADCSOC pin associated with the ADC module. First, the ADCSOC pin is level triggered, and therefore only low to high external signal transitions can start a conversion. The capture unit does not suffer from this limitation since it is edge triggered and can be configured to start a conversion on either rising edges or falling edges. Second, if the ADCSOC pin is held high longer than one conversion period, a second conversion will be immediately initiated upon completion of the first. This unwanted second conversion could still be in progress when a desired conversion is needed. In addition, if the end-of-conversion ADC interrupt is enabled, this second conversion will trigger an unwanted interrupt upon its completion. These two problems are not a concern with the capture unit. Finally, the capture unit can send an interrupt request to the CPU while it simultaneously initiates the A/D conversion. This can yield a time savings when computations are driven by an external event since the interrupt allows preliminary calculations to begin at the start-of-conversion, rather than at the end-of-conversion using the ADC end-of-conversion interrupt. The ADCSOC pin does not offer a start-of-conversion interrupt. Rather, polling of the ADCSOC bit in the control register would need to be performed to trap the externally initiated start of conversion.
The eCAP module captures signal transitions on a dedicated input pin and sequentially loads a 32-bit time-base counter value in up to four 32-bit time-stamp capture registers (CAP1 – CAP4). By using a 32-bit counter, rollover is minimized. Independent edge polarity can be configured as rising or falling edge, and the module can be run in either one-shot mode for up to four time-stamp events or continuous mode to capture up to four time-stamp events operating as a circular buffer. The capture input pin is routed through the Input X-Bar, allowing any GPIO pin on the device to be used as the input. Also, the input capture signal can be pre-scaled and interrupts can be generated on any of the four capture events. The time-base counter can be run in either absolute or difference (delta) time-stamp mode. In absolute mode the counter runs continuously, whereas in difference mode the counter resets on each capture.
If the module is not used in capture mode, the eCAP module can be configured to operate as a single channel asymmetrical PWM module (i.e. time-base counter operates in count-up mode).

### eCAP Module Registers

**Name** | **Description** | **Structure**
--- | --- | ---
ECCTL1 | Capture Control 1 | ECapRegs.ECCTL1.all =
ECCTL2 | Capture Control 2 | ECapRegs.ECCTL2.all =
TSCTR | Time-Stamp Counter | ECapRegs.TSCTR =
CTRPHS | Counter Phase Offset | ECapRegs.CTRPHS =
CAP1 | Capture 1 | ECapRegs.CAP1 =
CAP2 | Capture 2 | ECapRegs.CAP2 =
CAP3 | Capture 3 | ECapRegs.CAP3 =
CAP4 | Capture 4 | ECapRegs.CAP4 =
ECEINT | Enable Interrupt | ECapRegs.ECEINT.all =
ECFLG | Interrupt Flag | ECapRegs.ECFLG.all =
ECCLR | Interrupt Clear | ECapRegs.ECCLR.all =
ECFRC | Interrupt Force | ECapRegs.ECFRC.all =
**eCAP Control Register 1**

**Upper Register:**

<table>
<thead>
<tr>
<th>Bit 15-14</th>
<th>Bit 13-9</th>
<th>Bit 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREE_SOFT</td>
<td>PRESCALE</td>
<td>CAPLDEN</td>
</tr>
</tbody>
</table>

- **Emulation Control**
  - 00 = TSCTR stops immediately
  - 01 = TSCTR runs until equals 0
  - 1X = free run (do not stop)

- **Event Filter Prescale Counter**
  - 00000 = divide by 1 (bypass)
  - 00001 = divide by 2
  - 00010 = divide by 4
  - 00011 = divide by 6
  - 00100 = divide by 8
  - …
  - 11110 = divide by 60
  - 11111 = divide by 62

**eCAP Control Register 1**

**Lower Register:**

- **Counter Reset on Capture Event**
  - 0 = no reset (absolute time stamp mode)
  - 1 = reset after capture (difference mode)

- **Capture Event Polarity**
  - 0 = trigger on rising edge
  - 1 = trigger on falling edge
### eCAP Control Register 2

**ECapRegs.ECCTL2**

#### Upper Register:

<table>
<thead>
<tr>
<th>Bit</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15-11</td>
<td>reserved</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>APWM POL</td>
<td>APWM Output Polarity (valid only in APWM mode)</td>
</tr>
<tr>
<td>9</td>
<td>CAP_APWM</td>
<td>Capture / APWM mode</td>
</tr>
<tr>
<td>8</td>
<td>SWSYNC</td>
<td>Software Force</td>
</tr>
<tr>
<td>7-6</td>
<td>SYNO_SEL</td>
<td>Sync-Out Select</td>
</tr>
<tr>
<td>5</td>
<td>SYNCI_EN</td>
<td>Counter Sync-In</td>
</tr>
<tr>
<td>4</td>
<td>TSCTRSTOP</td>
<td>Time Stamp Counter Stop</td>
</tr>
<tr>
<td>3</td>
<td>REARM</td>
<td>Re-arm</td>
</tr>
<tr>
<td>2-1</td>
<td>STOP_WRAP</td>
<td>Stop Value for One-Shot Mode/ Wrap Value for Continuous Mode</td>
</tr>
<tr>
<td>0</td>
<td>CONT_ONESHT</td>
<td>Continuous/One-Shot Mode</td>
</tr>
</tbody>
</table>

- **APWM Output Polarity**: 0 = active high output, 1 = active low output
- **Capture / APWM mode**: 0 = capture mode, 1 = APWM mode
- **Software Force Counter Synchronization**: 0 = no effect, 1 = TSCTR load of current module and other modules if SYNCO_SEL bits = 00
- **Sync-Out Select**: 00 = sync-in to sync-out, 01 = CTR = PRD event generates sync-out, 1X = disable
- **Time Stamp Counter Stop**: 0 = stop, 1 = run
- **Stop Value for One-Shot Mode/ Wrap Value for Continuous Mode**: 00 = stop/wrap after capture event 1, 01 = stop/wrap after capture event 2, 10 = stop/wrap after capture event 3, 11 = stop/wrap after capture event 4
The capture unit interrupts offer immediate CPU notification of externally captured events. In situations where this is not required, the interrupts can be masked and flag testing/polling can be used instead. This offers increased flexibility for resource management. For example, consider a servo application where a capture unit is being used for low-speed velocity estimation via a pulsing sensor. The velocity estimate is not used until the next control law calculation is made, which is driven in real-time using a timer interrupt. Upon entering the timer interrupt service routine, software can test the capture interrupt flag bit. If sufficient servo motion has occurred since the last control law calculation, the capture interrupt flag will be set and software can proceed to compute a new velocity estimate. If the flag is not set, then sufficient motion has not occurred and some alternate action would be taken for updating the velocity estimate. As a second example, consider the case where two successive captures are needed before a computation proceeds (e.g. measuring the width of a pulse). If the width of the pulse is needed as soon as the pulse ends, then the capture interrupt is the best option. However, the capture interrupt will occur after each of the two captures, the first of which will waste a small number of cycles while the CPU is interrupted and then determines that it is indeed only the first capture. If the width of the pulse is not needed as soon as the pulse ends, the CPU can check, as needed, the capture registers to see if two captures have occurred, and proceed from there.
What is an Incremental Quadrature Encoder?

A digital (angular) position sensor

Incremental Optical Encoder

Quadrature Output from Photo Sensors

The eQEP module interfaces with a linear or rotary incremental encoder for determining position, direction, and speed information from a rotating machine that is typically found in high-performance motion and position-control systems.

How is Position Determined from Quadrature Signals?

Position resolution is $\theta/4$ degrees

Quadrature Decoder State Machine
A quadrature decoder state machine is used to determine position from two quadrature signals.

The inputs include two pins (QEPA and QEPB) for quadrature-clock mode or direction-count mode, an index pin (QEPI), and a strobe pin (QEPS). These pins are configured using the GPIO multiplexer and need to be enabled for synchronous input. In quadrature-clock mode, two square wave signals from a position encoder are inputs to QEPA and QEPB which are 90 electrical degrees out of phase. This phase relationship is used to determine the direction of rotation. If the position encoder provides direction and clock outputs, instead of quadrature outputs, then direction-count mode can be used. QEPA input will provide the clock signal and QEPB input will have the direction information. The QEPI index signal occurs once per revolution and can be used to indicate an absolute start position from which position information is incrementally encoded using quadrature pulses. The QEPS strobe signal can be connected to a sensor or limit switch to indicate that a defined position has been reached.
The above figure shows a summary of the connections to the eQEP module.
Lab 7: Control Peripherals

- **Objective**

  The objective of this lab exercise is to become familiar with the programming and operation of the control peripherals and their interrupts. ePWM1A will be setup to generate a 2 kHz, 25% duty cycle symmetrical PWM waveform. The waveform will then be sampled with the on-chip analog-to-digital converter and displayed using the graphing feature of Code Composer Studio. Next, eCAP1 will be setup to detect the rising and falling edges of the waveform. This information will be used to determine the width of the pulse and duty cycle of the waveform. The results of this step will be viewed numerically in a memory window.

- **Procedure**

  Open the Project

  1. A project named Lab7 has been created for this lab exercise. Open the project by clicking on **Project → Import CCS Projects**. The "Import CCS Eclipse Projects" window will open then click **Browse...** next to the "Select search-directory" box. Navigate to: C:\C28x\Labs\Lab7\cpu01 and click **OK**. Then click **Finish** to import the project.

    All build options have been configured the same as the previous lab exercise. The files used in this lab exercise are:
Lab 7: Control Peripherals

Setup Shared I/O and ePWM1

2. Edit Gpio.c and adjust the shared I/O pin in GPIO0 for the PWM1A function.

3. In EPwm.c, setup ePWM1 to implement the PWM waveform as described in the objective for this lab exercise. The following registers need to be modified: TBCTL (set clock prescales to divide-by-1, no software force, sync and phase disabled), TBPRD, CMPA, CMPCTL (load on 0 or PRD), and AQCTLA (set on up count and clear on down count for output A). Software force, deadband, PWM chopper and trip action has been disabled. (Hint – notice the last steps enable the timer count mode and enable the clock to the ePWM module). Directly make use of the global variable names for the TBPRD and CMPA values which have been set using #define in the beginning of Lab.h file. Within the Project Explorer window, the Lab.h file is located in the include folder under /Lab_common/include. (As a challenge, you could calculate the values for TBPRD and CMPA). Notice that ePWM2 has been initialized earlier in the code for the ADC lab exercise. Save your work.

Build and Load

4. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window.

5. Click the “Debug” button (green bug). A Launching Debug Session window will open. Select only CPU1 to load the program on (i.e. uncheck CPU2), and then click OK. Then the CCS Debug perspective view should open, the program will load automatically, and you should now be at the start of main(). If the device has been power cycled since the last lab exercise, be sure to configure the boot mode to EMU_BOOT_SARAM using the Scripts menu.

Run the Code – PWM Waveform

6. Using a jumper wire, connect the PWM1A (header J4, pin #40) to ADCINA0 (header J3, pin #30) on the LaunchPad. Refer to the following diagram for the pins that need to be connected.

Note: The ECap.c file will be added and used with eCAP1 to detect the rising and falling edges of the waveform in the second part of this lab exercise.
7. Open a memory browser to view some of the contents of the ADC results buffer. The address label for the ADC results buffer is `AdcBuf` (type `&AdcBuf`) in the “Data” memory page. We will be running our code in real-time mode, and we will need to have the memory window continuously refresh.

8. Run the code (real-time mode) using the Script function: Scripts → Realtime Emulation Control → Run Realtime with Reset. Watch the window update. Verify that the ADC result buffer contains the updated values.

9. Open and setup a graph to plot a 50-point window of the ADC results buffer. Click: Tools → Graph → Single Time and set the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Buffer Size</td>
<td>50</td>
</tr>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>50000</td>
</tr>
<tr>
<td>Start Address</td>
<td><code>AdcBuf</code></td>
</tr>
<tr>
<td>Display Data Size</td>
<td>50</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>μs</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.

10. The graphical display should show the generated 2 kHz, 25% duty cycle symmetric PWM waveform. The period of a 2 kHz signal is 500 μs. You can confirm this by measuring the period of the waveform using the “measurement marker mode” graph feature. Disable continuous refresh for the graph before taking the measurements. In the graph window toolbar, left-click on the ruler icon with the red arrow. Note when you hover your mouse over the icon, it will show “Toggle Measurement Marker Mode”. Move the mouse to the first measurement position and left-click. Again, left-click on the Toggle Measurement Marker Mode icon. Move the mouse to the second measurement position and left-click. The graph will automatically calculate the difference between the two values taken over a complete waveform period. When done, clear the measurement points by right-clicking on the graph and select Remove All Measurement Marks. Then enable continuous refresh for the graph.

**Frequency Domain Graphing Feature of Code Composer Studio**

11. Code Composer Studio also has the ability to make frequency domain plots. It does this by using the PC to perform a Fast Fourier Transform (FFT) of the DSP data. Let's make
a frequency domain plot of the contents in the ADC results buffer (i.e. the PWM waveform).

Click: Tools → Graph → FFT Magnitude and set the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Buffer Size</td>
<td>50</td>
</tr>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>50000</td>
</tr>
<tr>
<td>Start Address</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Data Plot Style</td>
<td>Bar</td>
</tr>
<tr>
<td>FFT Order</td>
<td>10</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.

12. On the plot window, hold the mouse left-click key and move the marker line to observe the frequencies of the different magnitude peaks. Do the peaks occur at the expected frequencies?

13. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

**Setup eCAP1 to Measure Width of Pulse**

The first part of this lab exercise generated a 2 kHz, 25% duty cycle symmetric PWM waveform which was sampled with the on-chip analog-to-digital converter and displayed using the graphing feature of Code Composer Studio. Next, eCAP1 will be setup to detect the rising and falling edges of the waveform. This information will be used to determine the period and duty cycle of the waveform. The results of this step will be viewed numerically in a memory window and can be compared to the results obtained using the graphing features of Code Composer Studio.

14. Add (copy) ECap.c to the project from C:\C28x\Labs\Lab7\source.

15. In Main_7.c, add code to call the InitECap() function. There are no passed parameters or return values, so the call code is simply:

InitECap();

16. Edit Xbar.c and adjust the input selection register INPUT7SELECT for GPIO24 (header J4, pin #34) to feed the eCAP1 function. Simply set the register to 24.

17. Open and inspect the eCAP1 interrupt service routine (ECAP1_INT_ISR) in the file DefaultIsr_7.c. Notice that PwmDuty is calculated by CAP2 – CAP1 (rising to falling edge) and that PwmPeriod is calculated by CAP3 – CAP1 (rising to rising edge).

18. In ECap.c, setup eCAP1 to calculate PWM_duty and PWM_period. The following registers need to be modified: ECCTL2 (continuous mode, re-arm disable, and sync disable), ECCTL1 (set prescale to divide-by-1, configure capture event polarity without resetting the counter), and ECEINT (enable desired eCAP interrupt).

19. Using the “PIE Interrupt Assignment Table” find the location for the eCAP1 interrupt “ECAP1_INT” and fill in the following information:

PIE group #: ___________  # within group: ___________
This information will be used in the next step.

20. Modify the end of ECap.c to do the following:
   - Enable the “ECAP1” interrupt in the PIE (Hint: use the PieCtrlRegs structure)
   - Enable the appropriate core interrupt in the IER register

Build and Load

21. Save all changes to the files and build the project by clicking Project → Build Project, or by clicking on the "Build" button if you have added it to the tool bar. Select Yes to “Reload the program automatically”.

Run the Code – Pulse Width Measurement

22. Using a jumper wire, connect the PWM1A (header J4, pin #40) to ECAP1 (header J4, pin #34, feed from the Input X-bar using GPIO24) on the LaunchPad. Refer to the following diagram for the pins that need to be connected.

23. Open a memory browser to view the address label PwmPeriod. (Type &PwmPeriod in the address box). The address label PwmDuty (address &PwmDuty) should appear in the same memory browser window. Scroll the window up, if needed.

24. Set the memory browser properties format to “32-Bit Unsigned Int”. We will be running our code in real-time mode, and we will need to have the memory browser continuously refresh.

25. Run the code (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset. Notice the values for PwmDuty and PwmPeriod.

26. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

Questions:

- How do the captured values for PwmDuty and PwmPeriod relate to the compare register CMPA and time-base period TBPRD settings for ePWM1A?
- What is the value of PwmDuty in memory?
- What is the value of PwmPeriod in memory?
- How does it compare with the expected value?
Optional Exercise – Modulate the PWM Waveform

If you finish early, you might want to experiment with the code by observing the effects of changing the ePWM1 CMPA register using real-time emulation. Be sure that the jumper wire is connecting PWM1A (header J4, pin #40) to ADCINA0 (header J3, pin #30), and the Single Time graph is displayed. The graph must be enabled for continuous refresh.

a) Run the code in real-time mode.
b) Open an Expressions window to the EPwm1Regs.CMPA register – in EPwm.c highlight the “EPwm1Regs” structure and right click, then select Add Watch Expression… and then OK.
c) In the Expressions window open “EPwm1Regs”, then open “CMPA” and open “bit”.
d) The Expressions window must be enabled for continuous refresh.
e) Under “bit” change the “CMPA” 18750 value (within a range of 2500 and 22500).
f) Notice the effect on the PWM waveform in the graph.

You have just modulated the PWM waveform by manually changing the CMPA value. Next, we will modulate the PWM automatically by having the ADC ISR change the CMPA value.

a) In DefaultIsr_7.c notice the code in the ADCA1 interrupt service routine used to modulate the PWM1A output between 10% and 90% duty cycle.
b) In Main.c add “PWM_MODULATE” to the Expressions window using the same procedure above.
c) Then with the code running in real-time mode, change the “PWM_MODULATE” from 0 to 1 and observe the PWM waveform in the graph. Also, in the Expressions window notice the CMPA value being updated.

(If you do not have time to work on this optional exercise, you may want to try this later).

Terminate Debug Session and Close Project

27. Terminate the active debug session using the Terminate button. This will close the debugger and return Code Composer Studio to the CCS Edit perspective view.

28. Next, close the project by right-clicking on Lab7 in the Project Explorer window and select Close Project.

End of Exercise
Direct Memory Access

Introduction

This module explains the operation of the direct memory access (DMA) controller. The DMA has six channels with independent PIE interrupts.

Module Objectives

- Understand the operation of the Direct Memory Access (DMA) controller
- Show how to use the DMA to transfer data between peripherals and/or memory without intervention from the CPU

The DMA module provides a hardware method of transferring data between peripherals and/or memory without intervention from the CPU, effectively freeing up the CPU for other functions. Each CPU subsystem has its own DMA and using the DMA is ideal when an application requires a significant amount of time spent moving large amounts of data from off-chip memory to on-chip memory, or from a peripheral such as the ADC result register to a memory RAM block, or between two peripherals. Additionally, the DMA is capable of rearranging the data for optimal CPU processing such as binning and “ping-pong” buffering.

Specifically, the DMA can read data from the ADC result registers, transfer to or from memory blocks G0 through G15, IPC RAM, EMIF, transfer to or from the McBSP and SPI, and also modify registers in the ePWM. A DMA transfer is started by a peripheral or software trigger. There are six independent DMA channels, where each channel can be configured individually and each DMA channel has its own unique PIE interrupt for CPU servicing. All six DMA channels operate the same way, except channel 1 can be configured at a higher priority over the other five channels. At its most basic level the DMA is a state machine consisting of two nested loops and tightly coupled address control logic which gives the DMA the capability to rearrange the blocks of data during the transfer for post processing. When a DMA transfers is completed, the DMA can generate an interrupt.
Chapter Topics

Direct Memory Access

Direct Memory Access (DMA) .......................................................... 8-3
Basic Operation .............................................................................. 8-4
DMA Examples ............................................................................... 8-6
Channel Priority Modes .............................................................. 8-9
DMA Throughput .......................................................................... 8-10
DMA Registers .............................................................................. 8-11

Lab 8: Servicing the ADC with DMA ........................................... 8-15
Direct Memory Access (DMA)

DMA Triggers, Sources, and Destinations

- ADC
- GS0 RAM
- GS15 RAM
- IPC MSG RAM
- EMIF
- PIE
- DINTCH1-6
- McBSP
- SPI
- SDFM
- PWM1
- PWM2
- PWM11
- PWM12
- CAP
- QEP
- CMPSS
- SPI
- CAP
- QEP
- CMPSS
- DAC
- ADC
- GS0 RAM
- GS15 RAM
- IPC MSG RAM
- EMIF
- PIE
- DINTCH1-6
- McBSP
- SPI
- SDFM
- PWM1
- PWM2
- PWM11
- PWM12
- CAP
- QEP
- CMPSS
- SPI
- CAP
- QEP
- CMPSS
- DAC
- ADC
- GS0 RAM
- GS15 RAM
- IPC MSG RAM
- EMIF
- PIE
- DINTCH1-6
- McBSP
- SPI
- SDFM
- PWM1
- PWM2
- PWM11
- PWM12
- CAP
- QEP
- CMPSS
- SPI
- CAP
- QEP
- CMPSS
- DAC
- ADC
- GS0 RAM
- GS15 RAM
- IPC MSG RAM
- EMIF
- PIE
- DINTCH1-6
- McBSP
- SPI
- SDFM
- PWM1
- PWM2
- PWM11
- PWM12
- CAP
- QEP
- CMPSS
- SPI
- CAP
- QEP
- CMPSS
- DAC

DMA / CLA Common Peripheral Access

Common peripherals can be accessed by the CPU and either DMA or CLA

- CPUx
- CPUx.CLA
- CPUx.DMA
- CPUx.SECMSEL
- CPUSELx.PERy
- CLA Access / DMA Access
- ePWM/HRPWM, eCAP, eQEP, CMPSS, DAC, SDFM
- SPI A/B/C, McBSP A/B, uPP
  (uPP has no DMA access)

CpuSysRegs.SECMSEL

<table>
<thead>
<tr>
<th>15 - 4</th>
<th>3 - 2</th>
<th>1 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>PF2SEL</td>
<td>PF1SEL</td>
</tr>
</tbody>
</table>

Note: CPUSELx bit associated with each peripheral defines if the peripheral is connected to CPU1 or CPU2

* Default (lock bit protected)
Basic Operation

DMA Definitions

- **Word**
  - 16 or 32 bits
  - Word size is configurable per DMA channel

- **Burst**
  - Consists of multiple words
  - Smallest amount of data transferred at one time

- **Burst Size**
  - Number of words per burst
  - Specified by BURST_SIZE register
    - 5-bit ‘N-1’ value (maximum of 32 words/burst)

- **Transfer**
  - Consists of multiple bursts

- **Transfer Size**
  - Number of bursts per transfer
  - Specified by TRANSFER_SIZE register
    - 16-bit ‘N-1’ value - exceeds any practical requirements

Simplified State Machine Operation

_The DMA state machine at its most basic level is two nested loops_

![State Machine Diagram](image)

- **Start Transfer**
- **Move Word**
- **Burst Size times**
- **Transfer Size times**
- **End Transfer**
- **DMA can be configured to re-initialize at the end of the transfer (continuous mode)**
Direct Memory Access (DMA)

**Basic Address Control Registers**

- **Active pointers**
  - SRC_ADDR
  - DST_ADDR

- **Pointer shadow registers**
  - SRC_ADDR_SHADOW
  - DST_ADDR_SHADOW

- **Signed value added to active pointer after each word**
  - SRC_BURST_STEP
  - DST_BURST_STEP

- **Signed value added to active pointer after each burst**
  - SRC_TRANSFER_STEP
  - DST_TRANSFER_STEP

---

**Simplified State Machine Example**

- **3 words/burst**
- **2 bursts/transfer**

Start Transfer → Wait for event to start/continue transfer

Read/Write Data → Move "Burst Size" Words?

- Y → End Transfer
- N → Add Burst Step to Address Pointer

Add Burst Step to Address Pointer → Move "Transfer Size" Bursts?

- Y → End Transfer
- N → Add Transfer Step to Address Pointer
Direct Memory Access (DMA)

DMA Interrupts

- Each DMA channel has its own PIE interrupt
- The mode for each interrupt can be configured individually
- The CHINTMODE bit in the MODE register selects the interrupt mode

Mode #1: Interrupt at start of transfer

Mode #2: Interrupt at end of transfer

End Transfer

Read/Write Data

Moved “Burst Size” Words?

Moved “Transfer Size” Bursts?

Add Transfer Step to Address Pointer

Add Burst Step to Address Pointer

Wait for event to start/continue transfer

Start Transfer

DMA Examples

Simple Example

Objective: Move 4 words from memory location 0xF000 to memory location 0x4000 and interrupt CPU at end of transfer

<table>
<thead>
<tr>
<th>SRC_ADDR_SHADOW</th>
<th>Addr</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00000000</td>
<td>0xFF00</td>
<td>0x1111</td>
</tr>
<tr>
<td>0x0001</td>
<td>0xF001</td>
<td>0x2222</td>
</tr>
<tr>
<td>0x0002</td>
<td>0xF002</td>
<td>0x3333</td>
</tr>
<tr>
<td>0x0003</td>
<td>0xF003</td>
<td>0x4444</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SRC_TRANSFER_STEP</th>
<th>Addr</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0000</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x0001</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x0002</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x0003</td>
<td>0x0000</td>
<td></td>
</tr>
</tbody>
</table>

Size registers are N-1

BURST_SIZE* 0x0001
TRANSFER_SIZE* 0x0001

2 words/burst
2 bursts/transfer

<table>
<thead>
<tr>
<th>DST_ADDR_SHADOW</th>
<th>Addr</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00000000</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x00040000</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x00040001</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x00040002</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x00040003</td>
<td>0x0000</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DST_BURST_STEP</th>
<th>Addr</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00000000</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x0001</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x0002</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>0x0003</td>
<td>0x0000</td>
<td></td>
</tr>
</tbody>
</table>

Destination Registers

Note: This example could also have been done using 1 word/burst and 4 bursts/transfer, or 4 words/burst and 1 burst/transfer. This would affect Round-Robin progression, but not interrupts.
## Data Binning Example

**Objective:** Bin 3 samples of 5 ADC channels, then interrupt the CPU

### ADCA Results

<table>
<thead>
<tr>
<th>CH0</th>
<th>CH1</th>
<th>CH2</th>
<th>CH3</th>
<th>CH4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xF000</td>
<td>0xF001</td>
<td>0xF002</td>
<td>0xF003</td>
<td>0xF004</td>
</tr>
<tr>
<td>0xF005</td>
<td>0xF006</td>
<td>0xF007</td>
<td>0xF008</td>
<td>0xF009</td>
</tr>
<tr>
<td>0xF010</td>
<td>0xF011</td>
<td>0xF012</td>
<td>0xF013</td>
<td>0xF014</td>
</tr>
<tr>
<td>0xF015</td>
<td>0xF016</td>
<td>0xF017</td>
<td>0xF018</td>
<td>0xF019</td>
</tr>
<tr>
<td>0xF01A</td>
<td>0xF01B</td>
<td>0xF01C</td>
<td>0xF01D</td>
<td>0xF01E</td>
</tr>
</tbody>
</table>

3rd Conversion Sequence

<table>
<thead>
<tr>
<th>0x0B00</th>
<th>0x0B01</th>
<th>0x0B02</th>
<th>0x0B03</th>
<th>0x0B04</th>
</tr>
</thead>
</table>

### Data Binning Example Register Setup

**Objective:** Bin 3 samples of 5 ADC channels, then interrupt the CPU

#### ADC Registers:

SOC0 – SOC4 configured to CH0 – CH4, respectively, ADCA configured to re-trigger (continuous conversion)

#### DMA Registers:

<table>
<thead>
<tr>
<th>BURST_SIZE*</th>
<th>TRANSFER_SIZE*</th>
<th>SRC_ADDR_SHADOW</th>
<th>SRC_BURST_STEP</th>
<th>SRC_TRANSFER_STEP</th>
<th>DST_ADDR_SHADOW</th>
<th>DST_BURST_STEP</th>
<th>DST_TRANSFER_STEP</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0004</td>
<td>0x0002</td>
<td>0x00008B00</td>
<td>0x0001</td>
<td>0xFFF6 (-4)</td>
<td>0x0000F000</td>
<td>0x0003</td>
<td>0xFFF5 (-11)</td>
</tr>
</tbody>
</table>

**GS3 RAM**

<table>
<thead>
<tr>
<th>CH0</th>
<th>CH1</th>
<th>CH2</th>
<th>CH3</th>
<th>CH4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xF000</td>
<td>0xF001</td>
<td>0xF002</td>
<td>0xF003</td>
<td>0xF004</td>
</tr>
<tr>
<td>0xF005</td>
<td>0xF006</td>
<td>0xF007</td>
<td>0xF008</td>
<td>0xF009</td>
</tr>
<tr>
<td>0xF010</td>
<td>0xF011</td>
<td>0xF012</td>
<td>0xF013</td>
<td>0xF014</td>
</tr>
<tr>
<td>0xF015</td>
<td>0xF016</td>
<td>0xF017</td>
<td>0xF018</td>
<td>0xF019</td>
</tr>
</tbody>
</table>

* Size registers are N-1
** Typically use a relocatable symbol in your code, not a hard value
Ping-Pong Buffer Example

**Objective:** Buffer ADC ch. 0 ping-pong style, 50 samples per buffer

ADCA Result Register
0x0B00 ADCRESULT0
SOC0 configured to ADCINA0 with 1 conversion per trigger

GS0 RAM
0xC140
50 word 'Ping' buffer
DMA Interrupt
50 word 'Pong' buffer
DMA Interrupt

Ping-Pong Example Register Setup

**Objective:** Buffer ADC ch. 0 ping-pong style, 50 samples per buffer

**ADC Registers:**
Convert ADCA Channel ADCINA0 – 1 conversion per trigger (i.e. ePWM2SOCA)

**DMA Registers:**

<table>
<thead>
<tr>
<th>Register</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BURST_SIZE*</td>
<td>0x0000</td>
<td>1 word/burst</td>
</tr>
<tr>
<td>TRANSFER_SIZE*</td>
<td>0x0031</td>
<td>50 bursts/transfer</td>
</tr>
<tr>
<td>SRC_ADDR_SHADOW</td>
<td>0x00000B00</td>
<td>starting address</td>
</tr>
<tr>
<td>SRC_BURST_STEP</td>
<td>don't care</td>
<td>since BURST_SIZE = 0</td>
</tr>
<tr>
<td>SRC_TRANSFER_STEP</td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>DST_ADDR_SHADOW</td>
<td>0x00000C140</td>
<td>starting address**</td>
</tr>
<tr>
<td>DST_BURST_STEP</td>
<td>don't care</td>
<td>since BURST_SIZE = 0</td>
</tr>
<tr>
<td>DST_TRANSFER_STEP</td>
<td>0x0001</td>
<td></td>
</tr>
</tbody>
</table>

Other: DMA configured to re-init after transfer (CONTINUOUS = 1)

* Size registers are N-1
** DST_ADDR_SHADOW must be changed between ping and pong buffer address in the DMA ISR. Typically use a relocatable symbol in your code, not a hard value.
Channel Priority Modes

- **Round Robin Mode:**
  - All channels have equal priority
  - After each enabled channel has transferred a *burst of words*, the next enabled channel is serviced in round robin fashion

- **Channel 1 High Priority Mode:**
  - Same as Round Robin except CH1 can interrupt DMA state machine
  - If CH1 trigger occurs, the current word (*not the complete burst*) on any other channel is completed and execution is halted
  - CH1 is serviced for complete burst
  - When completed, execution returns to previous active channel
  - This mode is intended primarily for the ADC, but can be used by any DMA event configured to trigger CH1

Priority Modes and the State Machine

- Start Transfer
  - Wait for event to start/continue transfer
  - Add Burst Step to Address Pointer
  - Add Transfer Step to Address Pointer
  - End Transfer

- Point where CH1 can interrupt other channels in CH1 Priority Mode

- Point where other pending channels are serviced
Direct Memory Access (DMA)

DMA Throughput

**DMA Throughput**

- **4 cycles/word** (5 for McBSP reads)
- **1 cycle delay to start each burst**
- **1 cycle delay returning from CH1 high priority interrupt**
- **32-bit transfer doubles throughput**
  (except McBSP, which supports 16-bit transfers only)

<table>
<thead>
<tr>
<th>Example: 128 16-bit words from ADC to RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 bursts * [(4 cycles/word * 16 words/burst) + 1] = <strong>520 cycles</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example: 64 32-bit words from ADC to RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 bursts * [(4 cycles/word * 8 words/burst) + 1] = <strong>264 cycles</strong></td>
</tr>
</tbody>
</table>

DMA vs. CPU Access Arbitration

- **DMA has priority over CPU**
  - If a multi-cycle CPU access is already in progress, DMA stalls until current CPU access finishes
  - The DMA will interrupt back-to-back CPU accesses
- **Can the CPU be locked out?**
  - Generally No!
  - DMA is multi-cycle transfer; CPU will sneak in an access when the DMA is accessing the other end of the transfer (e.g. while DMA accesses destination location, the CPU can access the source location)
DMA Registers

### DMA Registers

<table>
<thead>
<tr>
<th>DmaRegs.name (lab file: Dma.c)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>DMACTRL</td>
</tr>
<tr>
<td>PRIORITYCTRL1</td>
</tr>
<tr>
<td>MODE</td>
</tr>
<tr>
<td>CONTROL</td>
</tr>
<tr>
<td>BURST_SIZE</td>
</tr>
<tr>
<td>BURST_COUNT</td>
</tr>
<tr>
<td>SRC_BURST_STEP</td>
</tr>
<tr>
<td>DST_BURST_STEP</td>
</tr>
<tr>
<td>TRANSFER_SIZE</td>
</tr>
<tr>
<td>TRANSFER_COUNT</td>
</tr>
<tr>
<td>SRC_TRANSFER_STEP</td>
</tr>
<tr>
<td>DST_TRANSFER_STEP</td>
</tr>
<tr>
<td>SRC_ADDR_SHADOW</td>
</tr>
<tr>
<td>SRC_ADDR</td>
</tr>
<tr>
<td>DST_ADDR_SHADOW</td>
</tr>
<tr>
<td>DST_ADDR</td>
</tr>
<tr>
<td>DMACHSRCSELx (x = 1 or 2)</td>
</tr>
</tbody>
</table>

Refer to the Technical Reference Manual for a complete listing of registers

### DMA Control Register

DmaRegs.DMACTRL

<table>
<thead>
<tr>
<th>Hard Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = writes ignored (always reads back 0)</td>
</tr>
<tr>
<td>1 = reset DMA module</td>
</tr>
</tbody>
</table>

15 - 2 1 0

<table>
<thead>
<tr>
<th>reserved</th>
<th>PRIORITYRESET</th>
<th>HARDRESET</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Priority Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = writes ignored (always reads back 0)</td>
</tr>
<tr>
<td>1 = reset state-machine after any pending burst transfer complete</td>
</tr>
</tbody>
</table>
Direct Memory Access (DMA)

Priority Control Register 1
DmaRegs.PRIORITYCTRL1

<table>
<thead>
<tr>
<th>15 - 1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>CH1PRIORITY</td>
</tr>
</tbody>
</table>

DMA CH1 Priority
- 0 = same priority as other channels
- 1 = highest priority channel

Mode Register
DmaRegs.CHx.MODE

<table>
<thead>
<tr>
<th>Channel Interrupt</th>
<th>Data Size Mode</th>
<th>One Shot Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = disable</td>
<td>0 = 16-bit transfer</td>
<td>0 = one burst transfer per trigger</td>
</tr>
<tr>
<td>1 = enable</td>
<td>1 = 32-bit transfer</td>
<td>1 = subsequent burst transfers occur without additional trigger</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHINT</th>
<th>DATASIZE</th>
<th>reserved</th>
<th>CONTINUOUS</th>
<th>ONESHOT</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>14</td>
<td>13 - 12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Peripheral Interrupt Trigger</th>
<th>Overflow Interrupt Enable</th>
<th>Continuous Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = disable</td>
<td>0 = disable</td>
<td>0 = DMA stops</td>
</tr>
<tr>
<td>1 = enable</td>
<td>1 = enable</td>
<td>1 = DMA re-initializes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHINT</th>
<th>PERNTE</th>
<th>OVRNT</th>
<th>reserved</th>
<th>PERNINSEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>8</td>
<td>7</td>
<td>6 - 5</td>
<td>4 - 0</td>
</tr>
</tbody>
</table>

Channel Interrupt Generation
- 0 = at beginning of transfer
- 1 = at end of transfer

Peripheral Interrupt Source Select
Set bits to the channel number
See Trigger Sources on next slide
DMA Trigger Source Selection Registers

- **Selects the Trigger Source for each DMA channel**
- Each channel can be triggered by up to 256 interrupt sources
- Select 'no peripheral' if trigger is generated by software
- Default value = 0x00
- See “Peripheral Interrupt Trigger Sources” table on next slide

### DmaClSrcSelRegs.DMACHSRCSCEL1

<table>
<thead>
<tr>
<th>31 - 24</th>
<th>23 - 16</th>
<th>15 - 8</th>
<th>7 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH4</td>
<td>CH3</td>
<td>CH2</td>
<td>CH1</td>
</tr>
</tbody>
</table>

### DmaClSrcSelRegs.DMACHSRCSCEL2

<table>
<thead>
<tr>
<th>31 - 24</th>
<th>23 - 16</th>
<th>15 - 8</th>
<th>7 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>reserved</td>
<td>CH6</td>
<td>CH5</td>
</tr>
</tbody>
</table>

Note: DMACHSRCSELLOCK register can be used to lock above registers (lock bit for each register)

### Peripheral Interrupt Trigger Sources

<table>
<thead>
<tr>
<th></th>
<th>No Peripheral</th>
<th>ADCINT3</th>
<th>EPWM1SOCA</th>
<th>EPWM1SOCB</th>
<th>70</th>
<th>TINT2</th>
<th>109</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>ADCINT1</td>
<td>ADCINT4</td>
<td>EPWM1SOCA</td>
<td>EPWM1SOCB</td>
<td>71</td>
<td>MXEVT4</td>
<td>110</td>
</tr>
<tr>
<td>2</td>
<td>ADCINT2</td>
<td>ADCINT3</td>
<td>EPWM2SOCA</td>
<td>EPWM2SOCB</td>
<td>72</td>
<td>MREVTA</td>
<td>111</td>
</tr>
<tr>
<td>3</td>
<td>ADCINT3</td>
<td>ADCINT1</td>
<td>EPWM3SOCA</td>
<td>EPWM3SOCB</td>
<td>73</td>
<td>MXETB</td>
<td>112</td>
</tr>
<tr>
<td>4</td>
<td>ADCINT4</td>
<td>ADCINT2</td>
<td>EPWM4SOCA</td>
<td>EPWM4SOCB</td>
<td>74</td>
<td>MREVTC</td>
<td>113</td>
</tr>
<tr>
<td>5</td>
<td>ADCINT1</td>
<td>ADCINT3</td>
<td>EPWM5SOCA</td>
<td>EPWM5SOCB</td>
<td>95</td>
<td>SD1FT1</td>
<td>114</td>
</tr>
<tr>
<td>6</td>
<td>ADCINT2</td>
<td>ADCINT4</td>
<td>EPWM6SOCA</td>
<td>EPWM6SOCB</td>
<td>96</td>
<td>SD1FT2</td>
<td>115</td>
</tr>
<tr>
<td>7</td>
<td>ADCINT3</td>
<td>ADCINT1</td>
<td>EPWM7SOCA</td>
<td>EPWM7SOCB</td>
<td>97</td>
<td>SD1FT3</td>
<td>116</td>
</tr>
<tr>
<td>8</td>
<td>ADCINT4</td>
<td>ADCINT2</td>
<td>EPWM8SOCA</td>
<td>EPWM8SOCB</td>
<td>98</td>
<td>SD1FT4</td>
<td>117</td>
</tr>
<tr>
<td>9</td>
<td>ADCINT1</td>
<td>XINT1</td>
<td>EPWM9SOCA</td>
<td>EPWM9SOCB</td>
<td>99</td>
<td>SD2FT1</td>
<td>118</td>
</tr>
<tr>
<td>10</td>
<td>ADCINT2</td>
<td>XINT2</td>
<td>EPWM10SOCA</td>
<td>EPWM10SOCB</td>
<td>100</td>
<td>SD2FT2</td>
<td>119</td>
</tr>
<tr>
<td>11</td>
<td>ADCINT3</td>
<td>XINT3</td>
<td>EPWM11SOCA</td>
<td>EPWM11SOCB</td>
<td>101</td>
<td>SD2FT3</td>
<td>120</td>
</tr>
<tr>
<td>12</td>
<td>ADCINT4</td>
<td>XINT4</td>
<td>EPWM12SOCA</td>
<td>EPWM12SOCB</td>
<td>102</td>
<td>SD2FT4</td>
<td>121</td>
</tr>
</tbody>
</table>

Note: values not shown in table are reserved

```c
// Set DMA Channel 2 to trigger on EPWM1SOCA
DmaClSrcSelRegs.DMACHSRCSCEL1.bit.CH2 = 36;
```
### Control Register

**DmaRegs.CHx.CONTROL**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Overflow Flag *</td>
<td>0 = no overflow, 1 = overflow</td>
</tr>
<tr>
<td>14</td>
<td>Burst Status *</td>
<td>0 = no activity, 1 = servicing burst</td>
</tr>
<tr>
<td>13</td>
<td>Run Status *</td>
<td>0 = channel disabled, 1 = channel enabled</td>
</tr>
<tr>
<td>12</td>
<td>Transfer Status *</td>
<td>0 = no activity, 1 = transferring</td>
</tr>
<tr>
<td>11</td>
<td>Peripheral Interrupt Trigger Flag *</td>
<td>0 = no interrupt event trigger, 1 = interrupt event trigger</td>
</tr>
<tr>
<td>10 - 9</td>
<td>reserved</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Error Clear</td>
<td>0 = no effect, 1 = clear SYNCERR</td>
</tr>
<tr>
<td>7</td>
<td>Peripheral Interrupt Force</td>
<td>0 = no effect, 1 = sets event and PERINTFLG</td>
</tr>
<tr>
<td>6 - 5</td>
<td>reserved</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Run</td>
<td>0 = no effect, 1 = run</td>
</tr>
<tr>
<td>3</td>
<td>HALT</td>
<td>0 = no effect, 1 = halt</td>
</tr>
<tr>
<td>2</td>
<td>SOFTRESET</td>
<td>0 = no effect, 1 = default state</td>
</tr>
<tr>
<td>1</td>
<td>Peripheral Interrupt Clear</td>
<td>0 = no effect, 1 = clears event and PERINTFLG</td>
</tr>
<tr>
<td>0</td>
<td>Soft Reset</td>
<td>0 = no effect, 1 = default state</td>
</tr>
</tbody>
</table>

* = read-only
Lab 8: Servicing the ADC with DMA

Objective

The objective of this lab exercise is to become familiar with operation of the DMA. In the previous lab exercise, the CPU was used to store the ADC conversion result in the memory buffer during the ADC ISR. In this lab exercise the DMA will be configured to transfer the results directly from the ADC result registers to the memory buffer. ADC channel A0 will be buffered ping-pong style with 50 samples per buffer. As an operational test, the 2 kHz, 25% duty cycle symmetric PWM waveform (ePWM1A) will be displayed using the graphing feature of Code Composer Studio.

Lab 8: Servicing the ADC with DMA

Objective:
Configure the DMA to buffer ADCA Channel A0 ping-pong style with 50 samples per buffer

Procedure

Open the Project

1. A project named Lab8 has been created for this lab exercise. Open the project by clicking on Project → Import CCS Projects. The "Import CCS Eclipse Projects" window will open then click Browse... next to the “Select search-directory” box. Navigate to: C:\C28x\Labs\Lab8\cpu01 and click OK. Then click Finish to import the project. All build options have been configured the same as the previous lab exercise. The files used in this lab exercise are:
Inspect Lab_8.cmd

2. Open and inspect Lab_8.cmd. Notice that a section called “dmaMemBufs” is being linked to RAMGS4. This section links the destination buffer for the DMA transfer to a DMA accessible memory space. Close the inspected file.

Setup DMA Initialization

The DMA controller needs to be configured to buffer ADC channel A0 ping-pong style with 50 samples per buffer. One conversion will be performed per trigger with the ADC operating in single sample mode.

3. Edit Dma.c to implement the DMA operation as described in the objective for this lab exercise. Configure the DMA Channel 1 Mode Register (MODE) so that the peripheral interrupt source select is set to channel 1. Enable the peripheral interrupt trigger and set the channel for interrupt generation at the start of transfer. Configure for 16-bit data transfers with one burst per trigger and auto re-initialization at the end of the transfer. Enable the channel interrupt. Configure the DMA Trigger Selection Register (DMACHSRCSELx) so that the ADCAINT1 is the peripheral interrupt trigger source. In the DMA Channel 1 Control Register (CONTROL) clear the error and peripheral interrupt bits. Enable the channel to run.

4. Open Main_8.c and add a line of code in main() to call the InitDma() function. There are no passed parameters or return values. You just type

   InitDma();

   at the desired spot in main().

Setup PIE Interrupt for DMA

Recall that ePWM2 is triggering the ADC at a 50 kHz rate. In the previous lab exercise, the ADC generated an interrupt to the CPU, and the CPU read the ADC result register in the ADC ISR. For this lab exercise, the ADC is instead triggering the DMA, and the DMA will generate an interrupt to the CPU. The CPU will read the ADC result register in the DMA ISR.

5. Edit Adc.c to comment out the code used to enable the ADCA1 interrupt in PIE group 1. This is no longer being used. The DMA interrupt will be used instead.

6. Using the “PIE Interrupt Assignment Table” find the location for the DMA Channel 1 interrupt “DMA_CH1” and fill in the following information:

   PIE group #: ___________  # within group: ___________

   This information will be used in the next step.
7. Modify the end of `Dma.c` to do the following:
   - Enable the "DMA_CH1" interrupt in the PIE (Hint: use the `PieCtrlRegs` structure)
   - Enable the appropriate core interrupt in the IER register

8. Open and inspect `DefaultIsr_8.c`. Notice that this file contains the DMA interrupt service routine. Save all modified files.

**Build and Load**

9. Click the "Build" button and watch the tools run in the Console window. Check for errors in the Problems window.

10. Click the "Debug" button (green bug). A Launching Debug Session window will open. Select only CPU1 to load the program on (i.e. uncheck CPU2), and then click OK. Then the CCS Debug perspective view should open, the program will load automatically, and you should now be at the start of `main()`. If the device has been power cycled since the last lab exercise, be sure to configure the boot mode to EMU_BOOT_SARAM using the Scripts menu.

**Run the Code – Test the DMA Operation**

**Note:** For the next step, check to be sure that the jumper wire connecting PWM1A (header J4, pin #40) to ADCINA0 (header J3, pin #30) is in place on the LaunchPad.

11. Run the code in real-time mode using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset. Open and watch the memory browser update. Verify that the ADC result buffer contains updated values.

12. Open and setup a graph to plot a 50-point window of the ADC results buffer. Click: Tools → Graph → Single Time and set the following values:

<table>
<thead>
<tr>
<th>Acquisition Buffer Size</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>50000</td>
</tr>
<tr>
<td>Start Address</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Display Data Size</td>
<td>50</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>µs</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.

13. The graphical display should show the generated 2 kHz, 25% duty cycle symmetric PWM waveform. Notice that the results match the previous lab exercise.

14. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.
Terminate Debug Session and Close Project

15. Terminate the active debug session using the Terminate button. This will close the debugger and return Code Composer Studio to the CCS Edit perspective view.

16. Next, close the project by right-clicking on Lab8 in the Project Explorer window and select Close Project.

End of Exercise
Control Law Accelerator

Introduction

This module explains the operation of the control law accelerator (CLA). The CLA is an independent, fully programmable, 32-bit floating-point math processor. It executes algorithms independently and in parallel with the CPU. This extends the capabilities of the C28x CPU by adding parallel processing. The CLA has direct access to the ADC result registers. Additionally, the CLA has access to all ePWM, high-resolution PWM, eCAP, eQEP, CMPSS, DAC, SDFM, SPI, McBSP, uPP and GPIO data registers. This allows the CLA to read ADC samples “just-in-time” and significantly reduces the ADC sample to output delay enabling faster system response and higher frequency operation. The CLA responds to peripheral interrupts independently of the CPU. Utilizing the CLA for time-critical tasks frees up the CPU to perform other system, diagnostics, and communication functions concurrently.

Module Objectives

- Explain the purpose and operation of the Control Law Accelerator (CLA)
- Describe the CLA initialization procedure
- Review the CLA registers, instruction set, and programming flow
## Chapter Topics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Law Accelerator</td>
<td>9-1</td>
</tr>
<tr>
<td>Control Law Accelerator (CLA)</td>
<td>9-3</td>
</tr>
<tr>
<td>CLA Block Diagram</td>
<td>9-4</td>
</tr>
<tr>
<td>CLA Memory and Register Access</td>
<td>9-4</td>
</tr>
<tr>
<td>CLA Tasks</td>
<td>9-5</td>
</tr>
<tr>
<td>CLA Control and Execution Registers</td>
<td>9-6</td>
</tr>
<tr>
<td>CLA Registers</td>
<td>9-7</td>
</tr>
<tr>
<td>CLA Initialization</td>
<td>9-10</td>
</tr>
<tr>
<td>CLA Task Programming</td>
<td>9-11</td>
</tr>
<tr>
<td>CLA C Language Implementation and Restrictions</td>
<td>9-11</td>
</tr>
<tr>
<td>CLA Assembly Language Implementation</td>
<td>9-14</td>
</tr>
<tr>
<td>CLA Code Debugging</td>
<td>9-17</td>
</tr>
<tr>
<td>Lab 9: CLA Floating-Point FIR Filter</td>
<td>9-18</td>
</tr>
</tbody>
</table>
**Control Law Accelerator (CLA)**

The CLA is an independent 32-bit floating-point math hardware accelerator which executes real-time control algorithms in parallel with the main C28x CPU, effectively doubling the computational performance. Each CPU subsystem has its own CLA that responds directly to peripheral triggers, which can free up the C28x CPU for other tasks, such as communications and diagnostics. With direct access to the various control and communication peripherals, the CLA minimizes latency, enables a fast trigger response, and avoids CPU overhead. Also, with direct access to the ADC results registers, the CLA is able to read the result on the same cycle that the ADC sample conversion is completed, providing “just-in-time” reading, which reduces the sample to output delay.

- The CLA is a 32-bit floating-point processor that responds to peripheral triggers and executes code independent of the main CPU
- Designed for fast trigger response and oriented toward math computations
- Direct access to ePWM, HRPWM, eCAP, eQEP, ADC result, CMPSS, DAC, SDFM, SPI, McBSP, GPIO and uPP registers
- Frees up the CPU for other tasks (communications and diagnostics)
The CLA has access to the LSx RAM blocks and each memory block can be configured to be either dedicated to the CPU or shared between the CPU and CLA. After reset the memory block...
is mapped to the CPU, where it can be initialized by the CPU before being shared with the CLA. Once it is shared between the CPU and CLA it then can be configured to be either program memory or data memory. When configured as program memory it contains the CLA program code, and when configured as data memory it contains the variable and coefficients that are used by the CLA program code. Additionally, dedicated message RAMs are used to pass data between the CPU and CLA, and CLA and CPU.

**CLA Tasks**

- A *Task* is similar to an interrupt service routine
- CLA supports 8 Tasks (Task1-8)
- A task is started by a peripheral interrupt trigger
  - Triggers are enabled in the CLA1TASKSRCSELx register
- When a trigger occurs the CLA begins execution at the associated task vector entry (MVECT1-8)
- Once a task begins it runs to completion (no nesting)

Programming the CLA consists of initialization code, which is performed by the CPU, and tasks. A task is similar to an interrupt service routine, and once started it runs to completion. Tasks can be written in C or assembly code, where typically the user will use assembly code for high performance time-critical tasks, and C for non-critical tasks. Each task is capable of being triggered by a variety of peripherals without CPU intervention, which makes the CLA very efficient since it does not use interrupts for hardware synchronization, nor must the CLA do any context switching. Unlike the traditional interrupt-based scheme, the CLA approach becomes deterministic. The CLA supports eight independent tasks and each is mapped back to an event trigger. Since the CLA is a software programmable accelerator, it is very flexible and can be modified for different applications.
Software Triggering a Task

 Tasks can also be started by a software trigger using the CPU

 Method #1: Write to Interrupt Force Register (MIFRC) register

```
asm(" EALLOW");              //enable protected register access
Cla1Regs.MIFRC.bit.INT4 = 1; //start task 4
asm(" EDIS");                //disable protected register access
```

 Method #2: Use IACK instruction

```
asm(" IACK #0x0008");        //set bit 3 in MIFRC to start task 4
```

More efficient – does not require EALLOW

Note: Use of IACK requires Cla1Regs.MCTL.bit.IACKE = 1

CLA Control and Execution Registers

CLA Control and Execution Registers

- CLA1TASKSRCSELx – Task Interrupt Source Select (Task 1-8)
- MVECT1-8 – Task Interrupt Vector (MVECT1/2/3/4/5/6/7/8)
- LSxCLAPGM – Memory Map Configuration (LS0 – LS5 RAM)
- MPC – 16-bit Program Counter (initialized by appropriate MVECTx register)
- MR0-3 – CLA Floating-Point Result Registers (32 bit)
- MAR0-1 – CLA Auxiliary Registers (16 bit)
**CLA Registers**

### CLA Registers

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCTL</td>
<td>Control Register</td>
</tr>
<tr>
<td>LSxMSEL</td>
<td>Memory Selection CPU/CLA Register</td>
</tr>
<tr>
<td>LSxCLAPGM</td>
<td>CLA Program/Data Memory Register</td>
</tr>
<tr>
<td>CLA1TASKSRCSElx</td>
<td>Task Source Select Register (x = 1-2)</td>
</tr>
<tr>
<td>MIFR</td>
<td>Interrupt Flag Register</td>
</tr>
<tr>
<td>MIER</td>
<td>Interrupt Enable Register</td>
</tr>
<tr>
<td>MIIFRC</td>
<td>Interrupt Force Register</td>
</tr>
<tr>
<td>MICLR</td>
<td>Interrupt Flag Clear Register</td>
</tr>
<tr>
<td>MIOVF</td>
<td>Interrupt Overflow Flag Register</td>
</tr>
<tr>
<td>MIOVF</td>
<td>Interrupt Overflow Flag Clear Register</td>
</tr>
<tr>
<td>MIRUN</td>
<td>Interrupt Run Status Register</td>
</tr>
<tr>
<td>MVECTx</td>
<td>Task x Interrupt Vector (x = 1-8)</td>
</tr>
<tr>
<td>MPC</td>
<td>CLA 16-bit Program Counter</td>
</tr>
<tr>
<td>MARx</td>
<td>CLA Auxiliary Register x (x = 0-1)</td>
</tr>
<tr>
<td>MRx</td>
<td>CLA Floating-Point 32-bit Result Register (x = 0-3)</td>
</tr>
<tr>
<td>MSTF</td>
<td>CLA Floating-Point Status Register</td>
</tr>
</tbody>
</table>

#### CLA Control Register

**Cla1Regs.MCTL**

<table>
<thead>
<tr>
<th>Bit 15-3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>IACK</td>
<td>SOFTRESET</td>
<td>HARDRESET</td>
</tr>
</tbody>
</table>

- **IACK Enable**
  - 0 = CPU IACK instruction ignored
  - 1 = CPU IACK instruction triggers a task

- **Hard Reset**
  - 0 = no effect
  - 1 = CLA reset (registers set to default state)

- **Soft Reset**
  - 0 = no effect
  - 1 = CLA reset (stop current task)
CLA Memory Configuration Registers

MemCfgRegs.LSxMSEL

<table>
<thead>
<tr>
<th>31 - 12</th>
<th>reserved</th>
<th>MSEL_LS5</th>
<th>MSEL_LS4</th>
<th>MSEL_LS3</th>
<th>MSEL_LS2</th>
<th>MSEL_LS1</th>
<th>MSEL_LS0</th>
</tr>
</thead>
</table>

Master Select for LS RAM
- 00 = memory is dedicated to CPU
- 01 = memory is shared between CPU and CLA
- 1x = reserved

MemCfgRegs.LSxCLAPGM

<table>
<thead>
<tr>
<th>31 - 6</th>
<th>reserved</th>
<th>CLAPGM_LS5</th>
<th>CLAPGM_LS4</th>
<th>CLAPGM_LS3</th>
<th>CLAPGM_LS2</th>
<th>CLAPGM_LS1</th>
<th>CLAPGM_LS0</th>
</tr>
</thead>
</table>

Selects LS RAM as program or data CLA memory
- 0 = CLA data memory
- 1 = CLA program memory

Note: register lock protected

CLA Task Source Selection Registers

✈ Selects the Trigger Source for each Task
- Each task can be triggered by up to 256 interrupt sources
- Select ‘Software’ if task is unused or software triggered
- Default value = Software = 0x00
- See “CLA Interrupt Trigger Sources” table on next slide

DmaClaSrcSelRegs.CLA1TASKSRCSEL1

<table>
<thead>
<tr>
<th>31 - 24</th>
<th>23 - 16</th>
<th>15 - 8</th>
<th>7 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>TASK4</td>
<td>TASK3</td>
<td>TASK2</td>
<td>TASK1</td>
</tr>
</tbody>
</table>

DmaClaSrcSelRegs.CLA1TASKSRCSEL2

<table>
<thead>
<tr>
<th>31 - 24</th>
<th>23 - 16</th>
<th>15 - 8</th>
<th>7 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>TASK8</td>
<td>TASK7</td>
<td>TASK6</td>
<td>TASK5</td>
</tr>
</tbody>
</table>

Note: CLA1TASKSRCSELLOCK register can be used to lock above registers (lock bit for each register)
### CLA Task Interrupt Trigger Sources

<table>
<thead>
<tr>
<th>Task</th>
<th>Trigger Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Software</td>
</tr>
<tr>
<td>1</td>
<td>ADCAINT1</td>
</tr>
<tr>
<td>2</td>
<td>ADCAINT2</td>
</tr>
<tr>
<td>3</td>
<td>ADCAINT3</td>
</tr>
<tr>
<td>4</td>
<td>ADCAINT4</td>
</tr>
<tr>
<td>5</td>
<td>ADCAEVT</td>
</tr>
<tr>
<td>6</td>
<td>ADCBINT1</td>
</tr>
<tr>
<td>7</td>
<td>ADCBINT2</td>
</tr>
<tr>
<td>8</td>
<td>ADCBINT3</td>
</tr>
<tr>
<td>9</td>
<td>ADCBINT4</td>
</tr>
<tr>
<td>10</td>
<td>ADCBEVT</td>
</tr>
<tr>
<td>11</td>
<td>ADCCINT1</td>
</tr>
<tr>
<td>12</td>
<td>ADCCINT2</td>
</tr>
<tr>
<td>13</td>
<td>ADCCINT3</td>
</tr>
<tr>
<td>14</td>
<td>ADCCINT4</td>
</tr>
<tr>
<td>15</td>
<td>ADCCINT5</td>
</tr>
<tr>
<td>36</td>
<td>EPWM1INT</td>
</tr>
<tr>
<td>37</td>
<td>EPWM2INT</td>
</tr>
<tr>
<td>38</td>
<td>EPWM3INT</td>
</tr>
<tr>
<td>39</td>
<td>EPWM4INT</td>
</tr>
<tr>
<td>40</td>
<td>EPWM5INT</td>
</tr>
<tr>
<td>41</td>
<td>EPWM6INT</td>
</tr>
<tr>
<td>42</td>
<td>EPWM7INT</td>
</tr>
<tr>
<td>43</td>
<td>EPWM8INT</td>
</tr>
<tr>
<td>44</td>
<td>EPWM9INT</td>
</tr>
<tr>
<td>45</td>
<td>EPWM10INT</td>
</tr>
<tr>
<td>46</td>
<td>EPWM11INT</td>
</tr>
<tr>
<td>47</td>
<td>EPWM12INT</td>
</tr>
<tr>
<td>48</td>
<td>TINT1</td>
</tr>
<tr>
<td>49</td>
<td>TINT2</td>
</tr>
<tr>
<td>50</td>
<td>TINT3</td>
</tr>
<tr>
<td>51</td>
<td>TINT4</td>
</tr>
<tr>
<td>52</td>
<td>TINT5</td>
</tr>
<tr>
<td>53</td>
<td>TINT6</td>
</tr>
<tr>
<td>54</td>
<td>EQEP1INT</td>
</tr>
<tr>
<td>55</td>
<td>EQEP2INT</td>
</tr>
<tr>
<td>56</td>
<td>EQEP3INT</td>
</tr>
<tr>
<td>57</td>
<td>EQEP4INT</td>
</tr>
<tr>
<td>58</td>
<td>EQEP5INT</td>
</tr>
<tr>
<td>59</td>
<td>EQEP6INT</td>
</tr>
<tr>
<td>60</td>
<td>EQEP7INT</td>
</tr>
<tr>
<td>61</td>
<td>EQEP8INT</td>
</tr>
<tr>
<td>62</td>
<td>EQEP9INT</td>
</tr>
<tr>
<td>63</td>
<td>EQEP10INT</td>
</tr>
<tr>
<td>64</td>
<td>EQEP11INT</td>
</tr>
<tr>
<td>65</td>
<td>EQEP12INT</td>
</tr>
<tr>
<td>66</td>
<td>EQEP13INT</td>
</tr>
<tr>
<td>67</td>
<td>EQEP14INT</td>
</tr>
<tr>
<td>68</td>
<td>MXEVTA</td>
</tr>
<tr>
<td>69</td>
<td>MXETB</td>
</tr>
<tr>
<td>70</td>
<td>MXETB</td>
</tr>
<tr>
<td>71</td>
<td>MXETB</td>
</tr>
<tr>
<td>72</td>
<td>MXETB</td>
</tr>
<tr>
<td>73</td>
<td>MXETB</td>
</tr>
<tr>
<td>74</td>
<td>MREVTA</td>
</tr>
<tr>
<td>75</td>
<td>MREVTA</td>
</tr>
<tr>
<td>76</td>
<td>MREVTA</td>
</tr>
<tr>
<td>77</td>
<td>MREVTA</td>
</tr>
<tr>
<td>78</td>
<td>MREVTA</td>
</tr>
<tr>
<td>79</td>
<td>MREVTA</td>
</tr>
<tr>
<td>80</td>
<td>MREVTA</td>
</tr>
<tr>
<td>81</td>
<td>MREVTA</td>
</tr>
<tr>
<td>82</td>
<td>MREVTA</td>
</tr>
<tr>
<td>83</td>
<td>MREVTA</td>
</tr>
<tr>
<td>84</td>
<td>MREVTA</td>
</tr>
<tr>
<td>85</td>
<td>MREVTA</td>
</tr>
<tr>
<td>86</td>
<td>MREVTA</td>
</tr>
<tr>
<td>87</td>
<td>MREVTA</td>
</tr>
<tr>
<td>88</td>
<td>MREVTA</td>
</tr>
<tr>
<td>89</td>
<td>MREVTA</td>
</tr>
<tr>
<td>90</td>
<td>MREVTA</td>
</tr>
<tr>
<td>91</td>
<td>MREVTA</td>
</tr>
<tr>
<td>92</td>
<td>MREVTA</td>
</tr>
<tr>
<td>93</td>
<td>MREVTA</td>
</tr>
<tr>
<td>94</td>
<td>MREVTA</td>
</tr>
<tr>
<td>95</td>
<td>MREVTA</td>
</tr>
<tr>
<td>96</td>
<td>MREVTA</td>
</tr>
<tr>
<td>97</td>
<td>MREVTA</td>
</tr>
<tr>
<td>98</td>
<td>MREVTA</td>
</tr>
<tr>
<td>99</td>
<td>MREVTA</td>
</tr>
<tr>
<td>100</td>
<td>MREVTA</td>
</tr>
<tr>
<td>101</td>
<td>MREVTA</td>
</tr>
<tr>
<td>102</td>
<td>MREVTA</td>
</tr>
<tr>
<td>103</td>
<td>MREVTA</td>
</tr>
<tr>
<td>104</td>
<td>MREVTA</td>
</tr>
<tr>
<td>105</td>
<td>MREVTA</td>
</tr>
<tr>
<td>106</td>
<td>MREVTA</td>
</tr>
<tr>
<td>107</td>
<td>MREVTA</td>
</tr>
<tr>
<td>108</td>
<td>MREVTA</td>
</tr>
<tr>
<td>109</td>
<td>MREVTA</td>
</tr>
<tr>
<td>110</td>
<td>MREVTA</td>
</tr>
<tr>
<td>111</td>
<td>MREVTA</td>
</tr>
<tr>
<td>112</td>
<td>MREVTA</td>
</tr>
<tr>
<td>113</td>
<td>MREVTA</td>
</tr>
<tr>
<td>114</td>
<td>MREVTA</td>
</tr>
<tr>
<td>115</td>
<td>MREVTA</td>
</tr>
<tr>
<td>116</td>
<td>MREVTA</td>
</tr>
<tr>
<td>117</td>
<td>MREVTA</td>
</tr>
<tr>
<td>118</td>
<td>MREVTA</td>
</tr>
<tr>
<td>119</td>
<td>MREVTA</td>
</tr>
<tr>
<td>120</td>
<td>MREVTA</td>
</tr>
<tr>
<td>121</td>
<td>MREVTA</td>
</tr>
<tr>
<td>122</td>
<td>MREVTA</td>
</tr>
<tr>
<td>123</td>
<td>MREVTA</td>
</tr>
<tr>
<td>124</td>
<td>MREVTA</td>
</tr>
<tr>
<td>125</td>
<td>MREVTA</td>
</tr>
<tr>
<td>126</td>
<td>MREVTA</td>
</tr>
<tr>
<td>127</td>
<td>MREVTA</td>
</tr>
</tbody>
</table>

Note: values not shown in table are reserved

// Set EPWM1INT to trigger CLA Task5
DmaClaSrcSelRegs.CLA1TASKSRCSEL2.bit.TASK5 = 36;

### CLA Interrupt Enable Register

**Cla1Regs.MIER**

```
15 - 8  7  6  5  4  3  2  1  0
  reserved  INT8  INT7  INT6  INT5  INT4  INT3  INT2  INT1
```

0 = task interrupt disable (default)
1 = task interrupt enable

Cla1Regs.MIER.bit.INT2 = 1;  //enable Task 2 interrupt
Cla1Regs.MIER.all = 0x0028;  //enable Task 6 and 4 interrupts
CLA Initialization

CLA Initialization

Performed by the CPU during software initialization

1. Copy CLA task code from flash to CLA program RAM
2. Initialize CLA data RAMs, as needed
   - Populate with data coefficients, constants, etc.
3. Configure the CLA registers
   - Enable the CLA clock (PCLKCR3 register)
   - Populate the CLA task interrupt vectors (MVECT1-8 registers)
   - Select the desired task interrupt sources (CLA1TASKSRCSELx register)
   - If desired, set Cla1Regs.MCTL.bit.IACKE = 1 to enable IACK instruction to start tasks using software (avoids EALLOW)
   - Map CLA program RAM and data RAMs to CLA space
4. Configure desired CLA task completion interrupts in the PIE
5. Enable CLA task triggers in the MIER register
6. Initialize the desired peripherals to trigger the CLA tasks

Data can passed between the CLA and CPU via message RAMs or allocated CLA Data RAM

Enabling CLA Support in CCS

- Set the “Specify CLA support” project option to ‘cla1’
- When creating a new CCS project, choosing a device variant that has the CLA will automatically select this option, so normally no user action is required
CLA Task Programming

CLA Task Programming

- Can be written in C or assembly code
- Assembly code will give best performance for time-critical tasks
- Writing in assembly may not be so bad!
  - CLA programs in floating point
  - Often not that much code in a task
- Commonly, the user will use assembly for critical tasks, and C for non-critical tasks

CLA C Language Implementation and Restrictions

CLA C Language Implementation

- Supports C only (no C++ or GCC extension support)
- Different data type sizes than C28x CPU and FPU

<table>
<thead>
<tr>
<th>TYPE</th>
<th>CPU and FPU</th>
<th>CLA</th>
</tr>
</thead>
<tbody>
<tr>
<td>char</td>
<td>16 bit</td>
<td>16 bit</td>
</tr>
<tr>
<td>short</td>
<td>16 bit</td>
<td>16 bit</td>
</tr>
<tr>
<td>int</td>
<td>16 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>long</td>
<td>32 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>long long</td>
<td>64 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>float</td>
<td>32 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>double</td>
<td>32 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>long double</td>
<td>64 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>pointers</td>
<td>32 bit</td>
<td>16 bit</td>
</tr>
</tbody>
</table>

- CLA architecture is designed for 32-bit data types
  - 16-bit computations incur overhead for sign-extension
  - 16-bit values mostly used to read/write 16-bit peripheral registers
  - There is no SW or HW support for 64-bit integer or floating point
CLA C Language Restrictions (1 of 2)

- No initialization support for global and static local variables
  
  ```c
  int16_t x;      // valid
  int16_t x=5;    // not valid
  ```

- Initialized global variables should be declared in a .c file instead of the .cla file

  ```c
  .c file: int16_t x=5;
  .cla file: extern int16_t x;
  ```

- For initialized static variables, easiest solution is to use an initialized global variable instead

- No recursive function calls

- No function pointers

CLA C Language Restrictions (2 of 2)

- No support for certain fundamental math operations
  
  - integer division: `z = x/y;`
  
  - modulus (remainder): `z = x%y;`
  
  - unsigned 32-bit integer compares

  ```c
  Uint32 i; if(i < 10) {...} // not valid
  int32 i; if(i < 10) {...} // valid
  Uint16 i; if(i < 10) {...} // valid
  int16 i; if(i < 10) {...} // valid
  float32 x; if(x < 10) {...} // valid
  ```

- No standard C math library functions, but TI provides some function examples (next slide)
C2000Ware™ - CLA Software Support

- TI provides some examples of floating-point math CLA functions

CLA Compiler Scratchpad Memory Area

- For local and compiler generated temporary variables
- Static allocation, used instead of a stack
- Defined in the linker command file

Lab.cmd

MEMORY
{
  ...
}

SECTIONS
{
  ...

  /*** CLA Compiler Required Sections ***/
  .scratchpad  : > RAMLS0, PAGE = 1
  ...
}

CLA Task C Code Example

```c
#include "Lab.h"

interrupt void Cla1Task1 (void)
{
    __mdebugstop();
    xDelay[0] = (float32)AdcaResultRegs.ADCRESULT0;
    Y = coeffs[4] * xDelay[4];
    xDelay[4] = xDelay[3];
    xDelay[1] = xDelay[0];
    Y = Y + coeffs[0] * xDelay[0];
    ClaFilteredOutput = (Uint16)Y;
}

interrupt void Cla1Task2 (void)
{
}
```

CLA Assembly Language Implementation

- **Same instruction format as the CPU and FPU**
  - Destination operand on the left
  - Source operand(s) on the right
- **Same mnemonics as FPU, with a leading “M”**

<table>
<thead>
<tr>
<th>CPU</th>
<th>FPU</th>
<th>CLA</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPY ACC, T, loc16</td>
<td>MPYF32 R0H, R1H, R2H</td>
<td>MMPYF32 MR0, MR1, MR2</td>
</tr>
</tbody>
</table>

- .cla extension causes the c2000 compiler to invoke the CLA compiler
- All code within this file is placed in the section “Cla1Prog”
- C Peripheral Register Header File references can be used in CLA C and assembly code
- Closing braces are replaced with MSTOP instructions when compiled
### CLA Assembly Instruction Overview

<table>
<thead>
<tr>
<th>Type</th>
<th>Example</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load (Conditional)</td>
<td>MMOV32 MRa, mem32{, CONDF}</td>
<td>1</td>
</tr>
<tr>
<td>Store</td>
<td>MMOV32 mem32, MRa</td>
<td>1</td>
</tr>
<tr>
<td>Load with Data Move</td>
<td>MMOV32 MRa, mem32</td>
<td>1</td>
</tr>
<tr>
<td>Store/Load MSTF</td>
<td>MMOV32 MSTF, mem32</td>
<td>1</td>
</tr>
<tr>
<td>Compare, Min, Max</td>
<td>MCMFF32 MRa, MRe</td>
<td>1</td>
</tr>
<tr>
<td>Absolute, Negative Value</td>
<td>MABSF32 MRa, MRe</td>
<td>1</td>
</tr>
<tr>
<td>Integer to Float</td>
<td>M1216TOF32 MRa, mem32</td>
<td>1</td>
</tr>
<tr>
<td>Float to Integer &amp; Round</td>
<td>MFP32TOI16B MRa, MRe</td>
<td>1</td>
</tr>
<tr>
<td>Integer Load/Store</td>
<td>MMOV16 MRa, mem16</td>
<td>1</td>
</tr>
<tr>
<td>Branch/Call/Return (conditional delayed)</td>
<td>MBCNDD 16bitdest {, CNDF}</td>
<td>1-7</td>
</tr>
<tr>
<td>Integer Bitwise AND, OR, XOR</td>
<td>MAND32 MRa, MRe, M Rc</td>
<td>1</td>
</tr>
<tr>
<td>Integer Add and Subtract</td>
<td>MSUB32 MRa, MRe, M Rc</td>
<td>1</td>
</tr>
<tr>
<td>Integer Shifts</td>
<td>MLSR32 MRa, #SHIFT</td>
<td>1</td>
</tr>
<tr>
<td>Write Protection Enable/Disable</td>
<td>MEALLOW</td>
<td>1</td>
</tr>
<tr>
<td>Halt Code or End Task</td>
<td>MSTOP</td>
<td>1</td>
</tr>
<tr>
<td>No Operation</td>
<td>MNOP</td>
<td>1</td>
</tr>
</tbody>
</table>

See the Technical Reference Manual for a complete listing of instructions

### CLA Assembly Parallel Instructions

- Parallel instructions are ‘built-in’ and not free form
- You cannot just combine two regular instructions
- Operates as a single instruction with a single opcode
- Performs two operations in a single cycle
- A parallel instruction is recognized by the parallel bars
- Example: Add + Parallel Store

```
MADDF32 MR3, MR3, MR1
|| MMOV32 @_Var, MR3
```

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Example</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiply &amp; Parallel Add/Subtract</td>
<td>MMOV32 MRa, MRe, M Rc</td>
<td>1</td>
</tr>
<tr>
<td>Multiply, Add, Subtract &amp; Parallel Store</td>
<td>MADDF32 MRa, MRe, M Rc</td>
<td>1</td>
</tr>
<tr>
<td>Multiply, Add, Subtract, MAC &amp; Parallel Load</td>
<td>MADDF32 MRa, MRe, mem32</td>
<td>1</td>
</tr>
</tbody>
</table>
CLA Assembly Addressing Modes

- Two addressing modes: **Direct** and **Indirect**
- Both modes can access the lower 64Kx16 of memory only:
  - All of the CLA data space
  - Both message RAMs
  - Shared peripheral registers

**Direct** – Populates opcode field with 16-bit address of the variable

example 1: `MMOV32 MR1, @_VarA`
example 2: `MMOV32 MR1, @_EPwm1Regs.CMPA.all`

**Indirect** – Uses the address in MAR0 or MAR1 to access memory; after the read or write MAR0/MAR1 is incremented by a 16-bit signed value

example 1: `MMOV32 MR0, *MAR0[2]++`
example 2: `MMOV32 MR1, *MAR1[-2]++`

CLA Task Assembly Code Example

```
 ClaTasks.asm
 .cdecls "Lab.h"
 .sect "Cla1Prog"
 _Cla1Task1: ; FIR filter
   ...
   MUI16TOF32 MR2, @_AdcaResultRegs.ADCRESULT0
   MMPPF32 MR2, MR1, MR0
   ...
   MADDF32 MR3, MR3, MR2
   MF32TOUI16 MR2, MR3
   MMOV16 @_ClaFilteredOutput, MR2
   ...
   MSTOP ; End of task
 ;-----------------------------
 _Cla1Task2:
   ...
   MSTOP
 ;-----------------------------
 _Cla1Task3:
   ...
   MSTOP
```

- .cdecls directive used to include the C header file in the CLA assembly file
- .sect directive used to place CLA assembly code in its own section
- C Peripheral Register Header File references can be used in CLA assembly code
- MSTOP instruction used at the end of the task
CLA Initialization Code Example

Lab.h
#include "F2837xD_Cla_typedefs.h"
#include "F2837xD_Device.h"

extern interrupt void Cla1Task1();
extern interrupt void Cla1Task2();
extern interrupt void Cla1Task8();

Cla.c
#include "Lab.h"

// Initialize CLA task interrupt vectors
Cla1Regs.MVECT1 = (uint16_t)(Cla1Task1);
Cla1Regs.MVECT2 = (uint16_t)(Cla1Task2);
Cla1Regs.MVECT7 = (uint16_t)(Cla1Task7);
Cla1Regs.MVECT8 = (uint16_t)(Cla1Task8);

CLA Code Debugging

CLA Code Debugging

- The CLA and CPU are debugged from the same JTAG port
- You can halt, single-step, and run the CLA independent of the CPU
- A CLA single step execute one pipeline cycle, whereas a CPU single step executes one instruction (and flushes the pipeline)

1. Insert a breakpoint in the CLA code
   - Insert a MDEBUGSTOP instruction(s) in the code where desired then rebuild/reload
   - In C code, can use __mdebugstop() intrinsic, or asm(" MDEBUGSTOP")
   - When the debugger is not connected, the MDEBUGSTOP acts like an MNOP
2. Connect to the CLA target in CCS
   - This enables CLA breakpoints
3. Run the CPU target
   - CLA task will trigger (via peripheral interrupt or software)
   - CLA executes instructions until MDEBUGSTOP is hit
4. Load the code symbols into the CLA context in CCS
   - This allows source-level debug
   - Needs to be done only once per debug session unless the .out file changes
5. Debug the CLA code
   - Can single-step the code, or run to the next MDEBUGSTOP or to the end of the task
   - If another task is pending, it will start at the end of the previous task
6. Disconnect the CLA target to disable CLA breakpoints, if desired
Lab 9: CLA Floating-Point FIR Filter

- **Objective**

  The objective of this lab exercise is to become familiar with operation and programming of the CLA. In this lab exercise, the ePWM1A generated 2 kHz, 25% duty cycle symmetric PWM waveform will be filtered using the CLA. The CLA will directly read the ADC result register and a task will run a low-pass FIR filter on the sampled waveform. The filtered result will be stored in a circular memory buffer. Note that the CLA is operating concurrently with the CPU. As an operational test, the filtered and unfiltered waveforms will be displayed using the graphing feature of Code Composer Studio.

Recall that a task is similar to an interrupt service routine. Once a task is triggered it runs to completion. In this lab exercise two tasks will be used. Task 1 contains the low-pass filter. Task 8 contains a one-time initialization routine that is used to clear (set to zero) the filter delay chain.

Since there are tradeoffs between the conveniences of C programming and the performance advantages of assembly language programming, three different task scenarios will be explored:

1. Filter and initialization tasks both in C
2. Filter task in assembly, initialization task in C
3. Filter and initialization tasks both in assembly

These three scenarios will highlight the flexibility of programming the CLA tasks, as well as show the required configuration steps for each. Note that scenarios 1 and 2 are the most likely to be used in a real application. There is little to be gained by putting the initialization task in assembly with scenario 3, but it is shown here for completeness as an all-assembly CLA setup.
Procedure

Open the Project

1. A project named Lab9 has been created for this lab exercise. Open the project by clicking on Project → Import CCS Projects. The “Import CCS Eclipse Projects” window will open then click Browse... next to the “Select search-directory” box. Navigate to: C:\C28x\Labs\Lab9\cpu01 and click OK. Then click Finish to import the project. All build options have been configured the same as the previous lab exercise. The files used in this lab exercise are:

   - Adc.c
   - Cla_9.c
   - ClaTasks.asm
   - ClaTasks_C.cla
   - CodeStartBranch.asm
   - Dac.c
   - DefaultIsr_9_10.c
   - DelayUs.asm
   - Dma.c
   - ECap.c
   - EPwm.c
   - F2837xD_Ad .c
   - F2837xD_GlobalVariableDefs.c
   - F2837xD_Headers_nonBIOS_cpu1.cmd
   - Gpio.c
   - Lab_9.cmd
   - Main_9.c
   - PieCtrl.c
   - PieVect.c
   - SineTable.c
   - SysCtrl.c
   - Watchdog.c
   - Xbar.c

Note: The ClaTasks.asm file will be added during the lab exercise.

Enabling CLA Support in CCS

2. Open the build options by right-clicking on Lab9 in the Project Explorer window and select Properties. Then under “C2000 Compiler” select “Processor Options”. Notice the “Specify CLA support” is set to cla1. This is needed to compile and assemble CLA code. Click OK to close the Properties window.

Inspect Lab_9.cmd

3. Open and inspect Lab_9.cmd. Notice that a section called “ClalProg” is being linked to RAMLS4. This section links the CLA program tasks to the CPU memory space. Two other sections called “Cla1Data1” and “Cla1Data2” are being linked to RAMLS1 and RAMLS2, respectively, for the CLA data. These memory spaces will be mapped to the CLA memory space during initialization. Also, notice the two message RAM sections used to pass data between the CPU and CLA.

We are linking CLA code directly to the CLA program RAM because we are not yet using the flash memory. CCS will load the code for us into RAM, and therefore the CPU will not need to copy the CLA code into the CLA program RAM. In the flash programming lab exercise later in this workshop, we will modify the linking so that the CLA code is loaded into flash, and the CPU will do the copy.

4. The CLA C compiler uses a section called .scratchpad for storing local and compiler generated temporary variables. This scratchpad memory area is allocated using the linker command file. Notice .scratchpad is being linked to RAMLS0. Close the Lab_9.cmd linker command file.
Setup CLA Initialization

During the CLA initialization, the CPU memory block \texttt{RAMLS4} needs to be configured as CLA program memory. This memory space contains the CLA Task routines. A one-time force of the CLA Task 8 will be executed to clear the delay buffer. The CLA Task 1 has been configured to run an FIR filter. The CLA needs to be configured to start Task 1 on the ADCAINT1 interrupt trigger. The next section will setup the PIE interrupt for the CLA.

5. Open \texttt{ClaTasks.C.cla} and notice Task 1 has been configured to run an FIR filter. Within this code the ADC result integer (i.e. the filter input) is being first converted to floating-point, and then at the end the floating-point filter output is being converted back to integer. Also, notice Task 8 is being used to initialize the filter delay line. The .cla extension is recognized by the compiler as a CLA C file, and the compiler will generate CLA specific code.

6. Edit \texttt{Cla_9.c} to implement the CLA operation as described in the objective for this lab exercise. Set \texttt{RAMLS0}, \texttt{RAMLS1}, \texttt{RAMLS2}, and \texttt{RAMLS4} memory blocks as shared between the CPU and CLA. Configure the \texttt{RAMLS4} memory block to be mapped to CLA program memory space. Configure the \texttt{RAMLS0}, \texttt{RAMLS1} and \texttt{RAMLS2} memory blocks to be mapped to CLA data memory space. Note that the \texttt{RAMLS0} memory block will be used for the CLA C compiler scratchpad. Set Task 1 peripheral interrupt source to ADCAINT1 and set the other Task peripheral interrupt source inputs to "software" (i.e. none). Enable CLA Task 1 interrupt. Enable the use of the IACK instruction to trigger a task, and then enable Task 8 interrupt.

7. Open \texttt{Main_9.c} and add a line of code in \texttt{main()} to call the \texttt{InitCla()} function. There are no passed parameters or return values. You just type

\begin{verbatim}
    InitCla();
\end{verbatim}

at the desired spot in \texttt{main()}.

8. In \texttt{Main_9.c} comment out the line of code in \texttt{main()} that calls the \texttt{InitDma()} function. The DMA is no longer being used. The CLA will directly access the ADC RESULT0 register.

Setup PIE Interrupt for CLA

Recall that ePWM2 is triggering the ADC at a 50 kHz rate. In the Control Peripherals lab exercise (i.e. ePWM lab), the ADC generated an interrupt to the CPU, and the CPU read the ADC result register in the ADC ISR. Then in the DMA lab exercise, the ADC instead triggered the DMA, and the DMA generated an interrupt to the CPU, where the CPU read the ADC result register in the DMA ISR. For this lab exercise, the ADC is instead triggering the CLA, and the CLA will directly read the ADC result register and run a task implementing an FIR filter. The CLA will generate an interrupt to the CPU, which will store the filtered results to a circular buffer implemented in the CLA ISR.

9. Remember that in \texttt{Adc.c} we commented out the code used to enable the ADCA1 interrupt in PIE group 1. This is no longer being used. The CLA interrupt will be used instead.

10. Using the “PIE Interrupt Assignment Table” find the location for the CLA Task 1 interrupt “CLA1_1” and fill in the following information:

\begin{verbatim}
PIE group #:___________  # within group:__________
\end{verbatim}

This information will be used in the next step.
11. Modify the end of Cla_9.c to do the following:
   - Enable the "CLA1_1" interrupt in the PIE (Hint: use the PieCtrlRegs structure)
   - Enable the appropriate core interrupt in the IER register

12. Open and inspect DefaultIsr_9_10.c. Notice that this file contains the CLA interrupt service routine. Save all modified files.

**Build and Load**

13. Click the "Build" button and watch the tools run in the Console window. Check for errors in the Problems window.

14. Click the "debug" button (green bug). A Launching Debug Session window will open. Select only CPU1 to load the program on (i.e. uncheck CPU2), and then click OK. Then the CCS Debug perspective view should open, the program will load automatically, and you should now be at the start of main(). If the device has been power cycled since the last lab exercise, be sure to configure the boot mode to EMU_BOOT_SARAM using the Scripts menu.

**Run the Code – Test the CLA Operation (Tasks in C)**

| Note: | For the next step, check to be sure that the jumper wire connecting PWM1A (header J4, pin #40) to ADCINA0 (header J3, pin #30) is in place on the LaunchPad. |

15. Run the code in real-time mode using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset. Open and watch the memory browser window update. Verify that the ADC result buffer contains updated values.

16. Setup a dual-time graph of the filtered and unfiltered ADC results buffer. Click: Tools → Graph → Dual Time and set the following values:

<table>
<thead>
<tr>
<th>Acquisition Buffer Size</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>50000</td>
</tr>
<tr>
<td>Start Address A</td>
<td>AdcBufFiltered</td>
</tr>
<tr>
<td>Start Address B</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Display Data Size</td>
<td>50</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>µs</td>
</tr>
</tbody>
</table>

17. The graphical display should show the filtered PWM waveform in the Dual Time A display and the unfiltered waveform in the Dual Time B display. You should see that the results match the previous lab exercise.

18. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.
Change Task 1 to FIR Filter in Assembly

Previously, the initialization and filter tasks were implemented in C. In this part, we will not be using the C implementation of the FIR filter located at Task 1 in ClaTasks_C.cla. Instead, we will add ClaTasks.asm to the project and use the assembly implementation of the FIR filter located at Task 1 in this file. The CLA setup code in Clal_9.c and the filter initialization C-code located at Task 8 in ClaTasks_C.cla will not need to change.

19. Open ClaTasks_C.cla and at the beginning of Task 1 change the #if preprocessor directive from 1 to 0. The sections of code between the #if and #endif will not be compiled. This has the same effect as commenting out this code. We need to do this to avoid a conflict with the Task 1 in ClaTask.asm file.

20. Add (copy) ClaTasks.asm to project from C:\C28x\Labs\Lab9\source.

21. Open ClaTasks.asm and notice that the .cdecls directive is being used to include the C header file in the CLA assembly file. Therefore, we can use the Peripheral Register Header File references in the CLA assembly code. Next, notice Task 1 has been configured to run an FIR filter. Within this code special instructions have been used to convert the ADC result integer (i.e. the filter input) to floating-point and the floating-point filter output back to integer. Notice at Task 2 the assembly preprocessor .if directive is set to 0. The assembly preprocessor .endif directive is located at the end of Task 8. With this setting, Tasks 2 through 8 will not be assembled, again avoiding a conflict with Task 2 through 8 in the ClaTasks_C.cla file. Save all modified files.

Build and Load

22. Build the project by clicking Project → Build Project, or by clicking on the "Build" button (if it has been added to the tool bar). Select Yes to “Reload the program automatically”.

Run the Code – Test the CLA Operation (Tasks in C and ASM)

23. Run the code in real-time mode using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset, and watch the graph window update. To confirm these are updated values, carefully remove and replace the jumper wire to ADCINA0. (Remember the graph must be enabled for continuous refresh). The results should be the same as before.

24. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

Change All Tasks to Assembly

In this part, we will be using the assembly implementation of the FIR filter and filter delay line initialization routine located at Task 1 and Task 8, respectively, in the ClaTasks.asm file. The setup in Clal_9.c will remain the same. The ClaTasks_C.cla is no longer needed and will be excluded from the build. As a result, the CLA C compiler is not used and the CLA C compiler scratchpad area allocated by the linker command file will not be needed.

25. Open ClaTasks.asm and at the beginning of Task 2 change the assembly preprocessor .if directive to 1. Recall that the assembly preprocessor .endif directive is located at the end of Task 8. Now Task 2 through Task 8 will be assembled, along with Task 1.

26. Exclude ClaTasks_C.cla from the project to avoid conflicts with ClaTasks.asm. In the Project Explorer window right-click on ClaTasks_C.cla and select “Exclude from Build”. This file is no longer needed since all of the tasks are now in ClaTasks.asm.
Build and Load

27. Build the project by clicking Project → Build Project, or by clicking on the "Build" button (if it has been added to the tool bar). Select Yes to “Reload the program automatically”.

Run the Code – Test the CLA Operation (Tasks in ASM)

28. Run the code in real-time mode using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset, and watch the graph window update. To confirm these are updated values, carefully remove and replace the jumper wire to ADCINA0. The results should be the same as before.

29. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

Terminate Debug Session and Close Project

30. Terminate the active debug session using the Terminate button. This will close the debugger and return Code Composer Studio to the CCS Edit perspective view.

31. Next, close the project by right-clicking on Lab9 in the Project Explorer window and select Close Project.

End of Exercise
Lab 9 Reference: Low-Pass FIR Filter

Bode Plot of Digital Low Pass Filter
Coefficients: [1/16, 4/16, 6/16, 4/16, 1/16]
Sample Rate: 50 kHz
System Design

Introduction

This module discusses various aspects of system design. Details of the emulation and analysis block along with JTAG will be explored. Flash memory programming and the Code Security Module will be described.

Module Objectives

- Emulation and Analysis Block
- External Memory Interface (EMIF)
- Flash Configuration and Memory Performance
- Flash Programming
- Dual Code Security Module (DCSM)
Chapter Topics

System Design .......................................................................................................................... 10-1

Emulation and Analysis Block ............................................................................................. 10-3
External Memory Interface (EMIF) ....................................................................................... 10-5
Flash Configuration and Memory Performance ................................................................. 10-7
Flash Programming .............................................................................................................. 10-10
Dual Code Security Module (DCSM) .................................................................................. 10-12
Lab 10: Programming the Flash .......................................................................................... 10-16
Emulation and Analysis Block

JTAG Emulation System
(based on IEEE 1149.1 Boundary Scan Standard)

Some Available Debug Probes

**XDS100 CLASS**
- BlackHawk: USB100
- Spectrum Digital: XDS100

These debug probes are ultra-low cost, and have an unlimited free license for use with Code Composer Studio.

**XDS200 CLASS**
- BlackHawk: USB200
- Spectrum Digital: XDS200

These debug probes offer a balance of low cost with good performance compared to the XDS100 class debug probes.

Note: XDS510 CLASS debug probes are not recommended (obsolete); and for C2000, XDS560 CLASS debug probes are not recommended since they are expensive and do not offer any advantage over the XDS200 CLASS debug probes.

Emulation Connections to the Device

- GND
- Vcc (3.3 V)

**TMS320F28x7x**
- TRST
- TMS
- TDI
- TDO
- TCK

**Debug Header**
- EMU0
- EMU1
- TRST
- TMS
- TDI
- TDO
- TCK
- TCK_RET

= If distance between device and header is greater than 6 inches
**On-Chip Emulation Analysis Block: Capabilities**

Two hardware analysis units can be configured to provide any one of the following advanced debug features:

<table>
<thead>
<tr>
<th>Analysis Configuration</th>
<th>Debug Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Hardware Breakpoints</td>
<td>Halt on a specified instruction (for debugging in Flash)</td>
</tr>
<tr>
<td>2 Address Watchpoints</td>
<td>A memory location is getting corrupted; halt the processor when any value is written to this location</td>
</tr>
<tr>
<td>1 Address Watchpoint with Data</td>
<td>Halt program execution after a specific value is written to a variable</td>
</tr>
<tr>
<td>1 Pair Chained Breakpoints</td>
<td>Halt on a specified instruction only after some other specific routine has executed</td>
</tr>
</tbody>
</table>

---

**On-Chip Emulation Analysis Block: Hardware Breakpoints and Watchpoints**

View ➔ Breakpoints

Hardware Breakpoint Properties

Hardware Watchpoint Properties
External Memory Interface (EMIF)

- Provides a means for the CPU, DMA, and CLA to connect to various memory devices
- Support for synchronous (SDRAM) and asynchronous (SRAM, NOR Flash) memories
- TMS320F2837xD includes two EMIFs
  - EMIF1 – 16/32-bit interface shared between CPU1 and CPU2
  - EMIF2 – 16-bit interface dedicated to CPU1

External Memory Interface Signals

- Chip select
- Column address strobe
- Row address strobe
- SDRAM clock
- Clock enable
- Chip select pins
- Output enable
- Wait input with programmable polarity
- Asynchronous read/write control
- Write enable
- Bank address pins
- Byte enable pins
- Data bus
- Address bus

EMIF signals:

- EMIF_nCS[0]
- EMIF_nCAS
- EMIF_nRAS
- EMIF_CLK
- EMIF_CKE
- EMIF_nCS[4:2]
- EMIF_nOE
- EMIF_WAIT
- EMIF_RnW
- EMIF_nWE
- EMIF_BA[1:0]
- EMIF_nDQM[x:0]
- EMIF_D[x:0]
- EMIF_A[x:0]
Configurations for EMIF1 and EMIF2

<table>
<thead>
<tr>
<th></th>
<th>EMIF1</th>
<th>EMIF2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Data Width</td>
<td>32-Bit</td>
<td>16-Bit</td>
</tr>
<tr>
<td>Maximum Address Width</td>
<td>22-Bit (some pins muxed)</td>
<td>12-Bit</td>
</tr>
<tr>
<td>SDRAM CSx Support</td>
<td>1 (CS0)</td>
<td>1 (CS0)</td>
</tr>
<tr>
<td>ASRAM CSx Support</td>
<td>3 (CS2, CS3, CS4)</td>
<td>1 (CS2)</td>
</tr>
</tbody>
</table>

- **Synchronous (SDRAM) Memory Support:**
  - One, two, and four banks of SDRAMs
  - Devices with eight, nine, ten, and eleven column address
  - CAS latency of two or three clock cycles
  - Self-refresh and power-down modes

- **Asynchronous (SRAM and NOR Flash) Memory Support:**
  - External “Wait” input for slower memories
  - Programmable read and write cycle timings: setup, hold, strobe
  - Programmable data bus width, and select strobe option
  - Extended Wait option with programmable timeout

---

**EMIF Performance**

**TMS320F2837x at 200 MHz SYSCLK**

<table>
<thead>
<tr>
<th>Memory Type</th>
<th>Access Type</th>
<th>CPU Cycles</th>
<th>Throughput (Mword/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASRAM</td>
<td>read</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>DRAM</td>
<td>read</td>
<td>14</td>
<td>14.3</td>
</tr>
<tr>
<td>ASRAM</td>
<td>write</td>
<td>5</td>
<td>40</td>
</tr>
<tr>
<td>DRAM</td>
<td>write</td>
<td>9</td>
<td>22.2</td>
</tr>
</tbody>
</table>

Notes:
1. A ‘word’ can be a 16- or 32-bit access
2. ASRAM assumed to have ta(A) of 10 or 12 ns (access time)
3. TMS320F2837x
   a. ASRAM read setup/strobe/hold timings are 1/4/1, add 2 cycles bus start, 1 cycle data latency to CPU → 9 cycles (successive reads that are back-to-back do not incur the 1 cycle data latency, so 8*N+1 cycles for N “RPT” transfers)
   b. ASRAM write setup/strobe/hold timings are 1/1/1, add 2 cycles bus start → 5 cycles
   c. ASRAM read assumes ta(OE) < 5 ns (This is typical for 10 or 12 ns ASRAM)
   d. DRAM read, 100 MHz DRAM → 14 cycles
   e. DRAM write, 100 MHz DRAM → 9 cycles
Flash Configuration and Memory Performance

**Basic Flash Operation**

- **RWAIT** bit-field in the FRDCNTL register specifies the number of random accesses wait states.
- **OTP** reads are hardwired for 10 wait states (**RWAIT** has no effect).
- Must specify the number of SYSCLK cycle wait-states; **Reset defaults are maximum value (15)**.
- Flash/OTP reads returned after (**RWAIT** + 1 SYSCLK cycles).
- Flash configuration code should not be run from the Flash memory.

```
FlashCtrlRegs.FRDCNTL.bit.RWAIT = 0x3;  // Setting for 200 MHz
```

### FlashCtrlRegs.FRDCNTL.bit.RWAIT = 0x3; // Setting for 200 MHz

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>12</td>
<td>11</td>
<td>8</td>
<td>7</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>reserved</td>
<td></td>
<td>RWAIT</td>
<td>reserved</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*** Refer to the F28x7x datasheet for detailed numbers ***

For 200 MHz, **RANDWAIT = 3**

---

**Speeding Up Execution in Flash / OTP**

- C28x core decoder unit
- 2-level deep fetch buffer
- 128-bit data cache
- Instruction fetch
- 16 or 32 dispatched
- Data read either from program or data memory
- Enable prefetch mechanism:
  ```
  FlashCtrlRegs.FRǇD_INTF_CTRL.bit.PREFETCH_EN = 1;
  ```
- Enable data cache:
  ```
  FlashCtrlRegs.FRǇD_INTF_CTRL.bit.DATA_CACHE_EN = 1;
  ```
Flash Configuration and Memory Performance

**Code Execution Performance**

- **Assume 200 MHz SYSCLKOUT and single-cycle execution for each instruction**

**Internal RAM: 200 MIPS**
Fetch up to 32 bits every cycle → 1 instruction/cycle

**Flash: 200 MIPS**
Assume RWAIT=3, prefetch buffer enabled
Fetch 128 bits every 4 cycles:
(128 bits) / (32-bits per instruction worst-case) → 4 instructions/4 cycles
PC discontinuity will degrade this, while 16-bit instructions can help
Benchmarking in control applications has shown actual performance of about 90% efficiency, yielding approximately 180 MIPS

**Data Access Performance**

- **Assume 200 MHz SYSCLKOUT**

<table>
<thead>
<tr>
<th>Memory</th>
<th>16-bit access (words/cycle)</th>
<th>32-bit access (words/cycle)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal RAM</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Flash 'sequential' access</td>
<td>0.73 (8 words/11 cycles)</td>
<td>0.57 (4 words/7 cycles)</td>
<td>Assumes RWAIT = 3, flash data cache enabled, all 128 bits in cache are used</td>
</tr>
<tr>
<td>Flash random access</td>
<td>0.25 (1 word/4 cycles)</td>
<td>0.25 (1 word/4 cycles)</td>
<td>Assumes RWAIT = 3</td>
</tr>
</tbody>
</table>

- Internal RAM has best data performance – put time critical data here
- Flash performance often sufficient for constants and tables
- Note that the flash instruction fetch pipeline will also stall during a flash data access
- For best flash performance, arrange data so that all 128 bits in a cache line are utilized (e.g. sequential access)
Flash Configuration and Memory Performance

Flash / OTP Power Modes

- Power configuration settings save power by putting Flash/OTP to ‘Sleep’ or ‘Standby’ mode; Flash will automatically enter ‘Active’ mode if a Flash/OTP access is made
- At reset Flash/OTP is in sleep mode
- Operates in three power modes:
  - Sleep (lowest power)
  - Standby (shorter transition time to active)
  - Active (highest power)
- After an access is made, Flash/OTP can automatically power down to ‘Standby’ or ‘Sleep’ (active grace period set in user programmable counters)

Setting Flash charge pump fallback power mode to active:
FlashCtrlRegs.FPAC1.bit.PMPPWR = 0x1;  // 0: sleep, 1: active

Setting fallback power mode to active:
FlashCtrlRegs.FBFALLBACK.bit.BNKPWR0 = 0x3;  // 0: sleep, 1: standby, 2: reserved, 3: active

Error Correction Code (ECC) Protection

- Provides capability to screen out Flash/OTP memory faults (enabled at reset)
- Single error correction and double error detection (SECDED)
- For every 64-bits of Flash/OTP, 8 ECC check bits are calculated and programmed into ECC memory
- ECC check bits are programmed along with Flash/OTP data
- During an instruction fetch or data read operation the 64-bit data/8-bit ECC are processed by the SECDED to determine one of three conditions:
  - No error occurred
  - A correctable error (single bit data error) occurred
  - A non-correctable error (double bit data error or address error) occurred

FlashEccRegs.ECC_ENABLE.bit.ENABLE = 0xA;  // 0xA enable; other values disable
Flash Programming Basics

- The device CPU performs the flash programming
- The CPU executes Flash utility code from RAM that reads the Flash data and writes it into the Flash
- We need to get the Flash utility code and the Flash data into RAM

Sequence of steps for Flash programming:

- Minimum Erase size is a sector
- Minimum Program size is a bit!
- Important not to lose power during erase step: If CSM passwords happen to be all zeros, the CSM will be permanently secured!
- Chance of this happening is quite small! (Erase step is performed sector by sector)
Flash Programming Utilities

- **JTAG Emulator Based**
  - CCS on-chip Flash programmer (Tools → On-Chip Flash)
  - CCS UniFlash (TI universal Flash utility)
  - BlackHawk Flash utilities (requires Blackhawk emulator)
  - Elprotronic FlashPro2000
  - Spectrum Digital SDFlash JTAG (requires SD emulator)

- **SCI Serial Port Bootloader Based**
  - CodeSkin C2Prog
  - Elprotronic FlashPro2000

- **Production Test/Programming Equipment Based**
  - BP Microsystems programmer
  - Data I/O programmer

- **Build your own custom utility**
  - Can use any of the ROM bootloader methods
  - Can embed flash programming into your application
  - Flash API algorithms provided by TI

*TI web has links to all utilities (http://www.ti.com/c2000)
Dual Code Security Module (DCSM)

- DCSM offers protection for two zones – zone 1 & zone 2
  (Note: For dual-core devices each CPU has a DCSM)
- Each zone has its own dedicated secure OTP
  - Contains security configurations for each zone
- The following on-chip memory can be secured:
  - Flash – each sector individually
  - LS0-5 RAM – each block individually
  - D0-1 RAM – each block individually
  - CLA – Includes CLA message RAMs
- Data reads and writes from secured memory are only allowed for code running from secured memory
- All other data read/write accesses are blocked:
  - JTAG emulator/debugger, ROM bootloader, code running in external memory or unsecured internal memory

Zone Selection

- Each securable on-chip memory resource can be allocated to either zone 1 (Z1), zone 2 (Z2), or as non-secure
  - DcsmZ1Regs.Z1_GRABSECTR register:
    - Allocates individual Flash sectors to zone 1 or non-secure
  - DcsmZ2Regs.Z2_GRABSECTR register:
    - Allocates individual Flash sectors to zone 2 or non-secure
  - DcsmZ1Regs.Z1_GRABRAMR register:
    - Allocates LS0-5, D0-1, and CLA1 to zone 1 or non-secure
  - DcsmZ2Regs.Z2_GRABRAMR register:
    - Allocates LS0-5, D0-1, and CLA1 to zone 2 or non-secure

Technical Reference Manual contains a table to resolve mapping conflicts
Each zone is secured by its own 128-bit (four 32-bit words) user defined CSM password.

Passwords for each zone is stored in its dedicated OTP location

Location based on a zone-specific link pointer

128-bit CSMKEY registers are used to secure and unsecure the device.

Password locations for each zone can be locked and secured by programming PSWDLOCK fields in the OTP with any value other than “1111” (0xF).

---

Final link pointer value is resolved by comparing all three individual link pointer values (bit-wise voting logic).

OTP value “1” programmed as “0” (no erase operation).
Zone Select Block - Linker Pointer

Three link pointers need to be programmed with the same value (not ECC protected)

Secure and Unsecure the CSM

◆ The CSM is always secured after reset
◆ To unsecure the CSM:
  ◆ Perform a dummy read of each CSMPSWD(0,1,2,3) register (passwords in the OTP)
  ◆ Write the correct password to each CSMKEY(0,1,2,3) register
◆ Passwords are all 0xFFFF on new devices
  ◆ When passwords are all 0xFFFF, only a read of each password location (PWL) is required to unsecure the device
  ◆ The bootloader does these dummy reads and hence unsecures devices that do not have passwords programmed
CSM Caveats

- Never program all the PWL’s as 0x0000
  - Doing so will permanently lock the zone
- Programming the PSWDLOCK field with any other value than “1111” (0xF) will lock and secure the password locations
- Remember that code running in unsecured RAM cannot access data in secured memory
  - Don’t link the stack to secured RAM if you have any code that runs from unsecured RAM
- Do not embed the passwords in your code!
  - Generally, the CSM is unsecured only for debug
  - Code Composer Studio can unsecure the zone

CSM Password Match Flow

Start

Zone secure after reset or runtime

Dummy reads of CSM PWL of secure zone (that needs to be unsecure)

Is PWL = all 0s?
  - Yes → Zone permanently locked
  - No

Is PWL = all Fs?
  - Yes
  - Write CSM password of that zone into CSMKEYx registers
  - Correct password?
    - Yes → Zone Unsecure
    - No
  - No → Is PWL = all Fs?

Yes

No
Lab 10: Programming the Flash

Objective

The objective of this lab exercise is to program and execute code from the on-chip flash memory. The TMS320F28379D device has been designed for standalone operation in an embedded system. Using the on-chip flash eliminates the need for external non-volatile memory or a host processor from which to bootload. In this lab exercise, the steps required to properly configure the software for execution from internal flash memory will be covered.

Procedure

Open the Project

1. A project named Lab10 has been created for this lab exercise. Open the project by clicking on Project → Import CCS Projects. The “Import CCS Eclipse Projects” window will open then click Browse... next to the “Select search-directory” box. Navigate to: C:\C28x\Labs\Lab10\cpu01 and click OK. Then click Finish to import the project. All build options have been configured the same as the previous lab exercise. The files used in this lab exercise are:

...
Adc.c       F2837xD_GlobalVariableDefs.c
Cla_10.c    F2837xD_Headers_nonBIOS_cpul.cmd
ClaTasks.asm Flash.c
ClaTasks_C.cla Gpio.c
CodeStartBranch.asm Lab_10.cmd
Dac.c       Main_10.c
DefaultIsr_9_10.c PieCtrl1.c
DelayUs.asm  PieVect.c
Dma.c       SineTable.c
ECap.c       SysCtrl1.c
EPwm.c       Watchdog.c
F2837xD_Adc.c Xbar.c

\textbf{Note:} The Flash.c file will be added during the lab exercise.

**Link Initialized Sections to Flash**

Initialized sections, such as code and constants, must contain valid values at device power-up. Stand-alone operation of an embedded system means that no debug probe (emulator) is available to initialize the device RAM. Therefore, all initialized sections must be linked to the on-chip flash memory.

Each initialized section actually has two addresses associated with it. First, it has a LOAD address which is the address to which it gets loaded at load time (or at flash programming time). Second, it has a RUN address which is the address from which the section is accessed at runtime. The linker assigns both addresses to the section. Most initialized sections can have the same LOAD and RUN address in the flash. However, some initialized sections need to be loaded to flash, but then run from RAM. This is required, for example, if the contents of the section needs to be modified at runtime by the code.

2. Open and inspect the linker command file Lab_10.cmd. Notice that the first flash sector has been divided into two blocks named BEGIN_FLASH and FLASH_A. The FLASH_A flash sector origin and length has been modified to avoid conflicts with the other flash sector spaces. The remaining flash sectors have been combined into a single block named FLASH_BCDEFGHIJKLMN. See the reference slide at the end of this lab exercise for further details showing the address origins and lengths of the various flash sectors used.

3. Edit Lab_10.cmd to link the following compiler sections to on-chip flash memory block FLASH_BCDEFGHIJKLMN:

\textbf{Compiler Sections:}

| .text | .cinit | .const | .econst | .pinit | .switch |

**Copying Interrupt Vectors from Flash to RAM**

The interrupt vectors must be located in on-chip flash memory and at power-up needs to be copied to the PIE RAM as part of the device initialization procedure. The code that performs this copy is located in InitPieCtrl(). The C-compiler runtime support library contains a memory copy function called \texttt{memcpy()} which will be used to perform the copy.

4. Open and inspect InitPieCtrl() in PieCtrl.c. Notice the memcpy() function used to initialize (copy) the PIE vectors. At the end of the file a structure is used to enable the PIE.
Initializing the Flash Control Registers

The initialization code for the flash control registers cannot execute from the flash memory (since it is changing the flash configuration!). Therefore, the initialization function for the flash control registers must be copied from flash (load address) to RAM (run address) at runtime. The memory copy function `memcpy()` will again be used to perform the copy. The initialization code for the flash control registers `InitFlash()` is located in the Flash.c file.

5. Add (copy) Flash.c to the project from `C:\C28x\Labs\Lab10\source`.

6. Open and inspect Flash.c. The C compiler `CODE_SECTION` pragma is used to place the `InitFlash()` function into a linkable section named "secureRamFuncs".

7. The "secureRamFuncs" section will be linked using the user linker command file `Lab_10.cmd`. In `Lab_10.cmd` the "secureRamFuncs" will load to flash (load address) but will run from RAMLS5 (run address). Also notice that the linker has been asked to generate symbols for the load start, load size, and run start addresses.

While not a requirement from a MCU hardware or development tools perspective (since the C28x MCU has a unified memory architecture), historical convention is to link code to program memory space and data to data memory space. Therefore, notice that for the RAMLS5 memory we are linking "secureRamFuncs" to, we are specifying "PAGE = 0" (which is program memory).

8. Open and inspect Main_10.c. Notice that the memory copy function `memcpy()` is being used to copy the section "secureRamFuncs", which contains the initialization function for the flash control registers.

9. Add a line of code in main() to call the `InitFlash()` function. There are no passed parameters or return values. You just type

   ```c
   InitFlash();
   ```

   at the desired spot in main().

Dual Code Security Module and Passwords

The DCSM module provides protection against unwanted copying (i.e. pirating!) of your code from flash, OTP, LS0-5 RAM blocks, D0-1 RAM blocks, and CLA memory blocks. The DCSM uses a 128-bit password made up of 4 individual 32-bit words. They are located in the OTP. During this lab exercise, dummy passwords of 0xFFFFFFFF will be used – therefore only dummy reads of the password locations are needed to unsecure the DCSM. **DO NOT PROGRAM ANY REAL PASSWORDS INTO THE DEVICE.** After development, real passwords are typically placed in the password locations to protect your code. We will not be using real passwords in the workshop. Again, **DO NOT CHANGE THE VALUES FROM 0xFFFFFFFF**.

Executing from Flash after Reset

The F28379D device contains a ROM bootloader that will transfer code execution to the flash after reset. When the boot mode selection is set for “Jump to Flash” mode, the bootloader will branch to the instruction located at address 0x080000 in the flash. An instruction that branches to the beginning of your program needs to be placed at this address. Note that `BEGIN_FLASH` begins at address 0x080000. There are exactly two words available to hold this branch instruction, and not coincidentally, a long branch instruction "LB" in assembly code occupies exactly two words. Generally, the branch instruction will branch to the start of the C-environment initialization routine located in the C-compiler runtime support library. The entry symbol for this routine is `_c_int00`. Recall that C code cannot be executed until this setup routine is run.
Therefore, assembly code must be used for the branch. We are using the assembly code file named CodeStartBranch.asm.

10. Open and inspect CodeStartBranch.asm. This file creates an initialized section named "codestart" that contains a long branch to the C-environment setup routine. This section needs to be linked to a block of memory named BEGIN_FLASH.

11. In the earlier lab exercises, the section "codestart" was directed to the memory named BEGIN_M0. Edit Lab_10.cmd so that the section "codestart" will be directed to BEGIN_FLASH. Save your work.

On power up, the reset vector will be fetched and the ROM bootloader will begin execution. If the emulator is connected, the device will be in emulation boot mode and will use the EMU_KEY and EMU_BMODE values in the PIE RAM to determine the boot mode. This mode was utilized in the previous lab exercises. In this lab exercise, we will be disconnecting the emulator and running in stand-alone boot mode (but do not disconnect the emulator yet!). The bootloader will read the OTP_KEY and OTP_BMODE values from their locations in the OTP. The behavior when these values have not been programmed (i.e., both 0xFF) or have been set to invalid values is boot to flash boot mode.

**Initializing the CLA**

Previously, the named section “Cla1Prog” containing the CLA program tasks was linked directly to the CPU memory block RAMLS4 for both load and run purposes. At runtime, all the code did was map the RAMLS4 block to the CLA program memory space during CLA initialization. For an embedded application, the CLA program tasks are linked to load to flash and run from RAM. At runtime, the CLA program tasks must be copied from flash to RAMLS4. The memory copy function memcpy() will once again be used to perform the copy. After the copy is performed, the RAMLS4 block will then be mapped to CLA program memory space as was done in the earlier lab.

12. In Lab_10.cmd notice that the named section “Cla1Prog” will now load to flash (load address) but will run from RAMLS4 (run address). The linker will also be used to generate symbols for the load start, load size, and run start addresses.

13. Open Cla_10.c and notice that the memory copy function memcpy() is being used to copy the CLA program code from flash to RAMLS4 using the symbols generated by the linker. Just after the copy the MemCfgRegs structure is used to configure the RAMLS4 block as CLA program memory space. Close the opened files.

**Build – Lab.out**

14. Click the “Build” button to generate the Lab.out file to be used with the CCS Flash Programmer. Check for errors in the Problems window.

**Programming the On-Chip Flash Memory**

In CCS the on-chip flash programmer is integrated into the debugger. When the program is loaded CCS will automatically determine which sections reside in flash memory based on the linker command file. CCS will then program these sections into the on-chip flash memory. Additionally, in order to effectively debug with CCS, the symbolic debug information (e.g., symbol and label addresses, source file links, etc.) will automatically load so that CCS knows where everything is in your code. Clicking the “Debug” button in the CCS Edit perspective will automatically launch the debugger, connect to the target, and program the flash memory in a single step.
15. Program the flash memory by clicking the “Debug” button (green bug). A Launching Debug Session window will open. Select only CPU1 to load the program on (i.e. uncheck CPU2), and then click OK. The CCS Debug perspective view will open and the flash memory will be programmed. *(If needed, when the “Progress Information” box opens select “Details >>” in order to watch the programming operation and status). After successfully programming the flash memory the “Progress Information” box will close. Then the program will load automatically, and you should now be at the start of main().

**Running the Code – Using CCS**

16. Reset the CPU using the “CPU Reset” button or click:

```
Run ➔ Reset ➔ CPU Reset
```

The program counter should now be at address 0x3FF16A in the “Disassembly” window, which is the start of the bootloader in the Boot ROM. If needed, click on the “View Disassembly…” button in the window that opens, or click View ➔ Disassembly.

17. Under Scripts on the menu bar click:

```
EMU Boot Mode Select ➔ EMU_BOOT_FLASH
```

This has the debugger load values into EMU_KEY and EMU_BMODE so that the bootloader will jump to "Flash" at address 0x080000.

18. Next click:

```
Run ➔ Go Main
```

The code should stop at the beginning of your main()routine. If you got to that point successfully, it confirms that the flash has been programmed properly, that the bootloader is properly configured for jump to flash mode, and that the codestart section has been linked to the proper address.

19. You can now run the CPU, and you should observe the LED D9 on the LaunchPad blinking. Try resetting the CPU, select the EMU_BOOT_FLASH boot mode, and then hitting run (without doing the Go Main procedure). The LED should be blinking again.

20. Halt the CPU.

**Terminate Debug Session and Close Project**

21. Terminate the active debug session using the Terminate button. This will close the debugger and return Code Composer Studio to the CCS Edit perspective view.

22. Next, close the project by right-clicking on Lab10 in the Project Explorer window and select Close Project.

**Running the Code – Stand-alone Operation (No Emulator)**

Recall that if the device is in stand-alone boot mode, the state of GPIO72 and GPIO84 pins are used to determine the boot mode. On the LaunchPad switch SW1 controls the boot options for the F28379D device. Check that switch SW1 positions 1 and 2 are set to the default “1 – on” position (both switches up). This will configure the device (in stand-alone boot mode) to GetMode. Since the OTP_KEY has not been programmed, the default GetMode will be boot from flash. Details of the switch positions can be found in the LaunchPad User’s Guide.

24. Disconnect the USB cable from the LaunchPad (i.e. remove power from the LaunchPad).

25. Re-connect the USB cable to the LaunchPad (i.e. power the LaunchPad). The LED should be blinking, showing that the code is now running from flash memory.

End of Exercise
Lab 12 Reference: Programming the Flash

Flash Memory Section Blocks

<table>
<thead>
<tr>
<th>Address</th>
<th>Block</th>
<th>Length</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x080000</td>
<td>BEGIN_FLASH</td>
<td>0x2</td>
<td>0</td>
</tr>
<tr>
<td>0x080002</td>
<td>FLASH_A</td>
<td>0x001FFE</td>
<td>0</td>
</tr>
<tr>
<td>0x082000</td>
<td>FLASH_BCDEFGHIJKLMNOP</td>
<td>0x03E000</td>
<td>0</td>
</tr>
</tbody>
</table>

Lab_10.cmd

```
SECTIONS
{
    codestart  > BEGIN_FLASH, PAGE = 0
    ...
}
```

Startup Sequence from Flash Memory

1. **RESET**
2. **Boot Code**
3. **Flash ROM (256Kw)**
4. **c_int00**
5. **c_int00**

* reset vector = 0x3FF16A for CPU1; 0x3FEC52 for CPU2
Introduction

This module explains the use and operation of the Inter-Processor Communications (IPC). The IPC allows communication between the two CPU subsystems (i.e. CPU1 and CPU2).

Module Objectives

- Understand the fundamental operation of Inter-Processor Communications (IPC)
- Use the IPC to transfer data between CPU1 and CPU2
Chapter Topics

Dual-Core Inter-Processor Communications

Inter-Processor Communications
IPC Global Shared RAM and Message RAM
Interrupts and Flags
IPC Data Transfer

Lab 11: Inter-Processor Communications
Inter-Processor Communications

IPC Features

Allows Communications Between the Two CPU Subsystems

- Message RAMs
- IPC flags and interrupts
- IPC command registers
- Flash pump semaphore
- Clock configuration semaphore
- Free-running counter

All IPC features are independent of each other

IPC Global Shared RAM and Message RAM

Global Shared RAM

- Device contains up to 16 blocks of global shared RAM
  - Blocks named GS0 – GS15
- Each block size is 4K words
- Each block can configured to be used by CPU1 or CPU2
  - Selected by MemCfgRegs.GSxMSEL register
- Individual memory blocks can be shared between the CPU and DMA

<table>
<thead>
<tr>
<th>Ownership</th>
<th>CPU1 Subsystem</th>
<th>CPU2 Subsystem</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CPU1</td>
<td>CPU2</td>
</tr>
<tr>
<td></td>
<td>CPU1.DMA</td>
<td>CPU2.DMA</td>
</tr>
<tr>
<td>CPU1 Subsystem*</td>
<td>R/W/Exe</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>CPU2 Subsystem</td>
<td>R</td>
<td>R/W/Exe</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>R/W</td>
</tr>
</tbody>
</table>

* default

Note: register lock protected
There are up to 16 blocks of shared RAM on F2837xD devices. These shared RAM blocks are typically used by the application, but can also be used for transferring messages and data.

Each block can individually be owned by either CPU1 or CPU2.

CPU1 core ownership:
At reset, CPU1 owns all of the shared RAM blocks. In this configuration CPU1 core can freely use the memory blocks. CPU1 can read, write or execute from the block and CPU1.DMA can read or write.

On the CPU2 core, CPU2 and CPU2.DMA can only read from these blocks. Blocks owned by the CPU1 core can be used by the CPU1 to send CPU2 messages. This is referred to as “C1toC2”.

CPU2 core ownership:
After reset, the CPU1 application can assign ownership of blocks to the CPU2 subsystem. In this configuration, CPU2 core can freely use the blocks. CPU2 can read, write or execute from the block and the CPU2.DMA can read or write. CPU1 core, however can only read from the block. Blocks owned by CPU2 core can be used can be used to send messages from the CPU2 to CPU1. This is referred to as “C2toC1”.

### IPC Message RAM

- Device contains 2 blocks of Message RAM
- Each block size is 1K words
- Each block is always enabled and the configuration is fixed
- Used to transfer messages or data between CPU1 and CPU2

<table>
<thead>
<tr>
<th>Message RAM</th>
<th>CPU1 Subsystem</th>
<th>CPU2 Subsystem</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CPU1</td>
<td>CPU1.DMA</td>
</tr>
<tr>
<td>CPU1 to CPU2 (“C1toC2”)</td>
<td>R/W</td>
<td>R/W</td>
</tr>
<tr>
<td>CPU2 to CPU1 (“C2toC1”)</td>
<td>R</td>
<td>R</td>
</tr>
</tbody>
</table>

The F2837xD has two dedicated message RAM blocks. Each block is 1K words in length. Unlike the shared RAM blocks, these blocks provide communication in one direction only and cannot be reconfigured.

CPU1 to CPU2 “C1toC2” message RAM:
The first message RAM is the CPU1 to CPU2 or C1toC2. This block can be read or written to by the CPU1 and read by the CPU2. CPU1 can write a message to this block and then the CPU2 can read it.

CPU2 to CPU1 “C2toC1” message RAM:
The second message RAM is the CPU2 to CPU1 or C2toC1. This block can be read or written to by CPU2 and read by CPU1. This means CPU2 can write a message to this block and then...
CPU1 can read it. After the sending CPU writes a message it can inform the receiver CPU that it is available through an interrupt or flag.

**IPC Message Registers**

- Provides very simple and flexible messaging
- Dedicated registers mapped to both CPU’s

<table>
<thead>
<tr>
<th>Local Register Name</th>
<th>Local CPU</th>
<th>Remote CPU</th>
<th>Remote Register Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPCSENDCOM</td>
<td>R/W</td>
<td>R</td>
<td>IPCRECVCOM</td>
</tr>
<tr>
<td>IPCSENDADDR</td>
<td>R/W</td>
<td>R</td>
<td>IPCRECVADDR</td>
</tr>
<tr>
<td>IPCSENDDATA</td>
<td>R/W</td>
<td>R</td>
<td>IPCRECVDATA</td>
</tr>
<tr>
<td>IPCREMOTEREPLY</td>
<td>R</td>
<td>R/W</td>
<td>IPCLOCALREPLY</td>
</tr>
</tbody>
</table>

- The definition (what the register content means) is up to the application software
- TI’s IPC-Lite drivers use the IPC message registers

**Interrupts and Flags**

**IPC Flags and Interrupts**

- CPU1 to CPU2: 32 flags with 4 interrupts (IPC0-3)
- CPU2 to CPU1: 32 flags with 4 interrupts (IPC0-3)

**Requesting CPU ➔ Set, Flag and Clear registers**

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPCSET</td>
<td>Message waiting (send interrupt and/or set flag)</td>
</tr>
<tr>
<td>IPCFLG</td>
<td>Bit is set by the &quot;SET&quot; register</td>
</tr>
<tr>
<td>IPCCLR</td>
<td>Clear the flag</td>
</tr>
</tbody>
</table>

**Receiving CPU ➔ Status and Acknowledge registers**

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPCSTS</td>
<td>Status (reflects the FLG bit)</td>
</tr>
<tr>
<td>IPCACK</td>
<td>Clear STS and FLG</td>
</tr>
</tbody>
</table>
When the sending CPU wants to inform the receiver that a message is ready, it can make use of an interrupt or flag. There are identical IPC interrupt and flag resources on both CPU1 core and CPU2 core.

4 Interrupts:
There are 4 interrupts that CPU1 can send to CPU2 (and vice-versa) through the Peripheral Interrupt Expansion (PIE) module. Each of the interrupts has a dedicated vector within the PIE, IPC0 – IPC3.

28 Flags:
In addition, there are 28 flags available to each of the CPU cores. These flags can be used for messages that are not time critical or they can be used to send status back to originating processor. The flags and interrupts can be used however the application sees fit and are not tied to particular operation in hardware.

Registers: Set, Flag, Clear, Status and Acknowledge
The registers to control the IPC interrupts and flags are 32-bits:
- Bits [3:0] = interrupt & flag
- Bits [31:4] = flag only
IPC Data Transfer

Basic IPC Data Transfer

- Basic option – no software drivers needed and easy to use!
- Use the Message RAMs or global shared RAMs to transfer data between processors at a known address
- Use the IPC flag registers to tell the other processor that the data is ready

The F2837xD IPC is very easy to use. At the most basic level, the application does not need any separate software drivers to communicate between processors. It can utilize the message RAM's and shared RAM blocks to pass data between processors at a fixed address known to both processors. Then the sending processor can use the IPC flag registers merely to flag to the receiving processor that the data is ready. Once the receiving processor has grabbed the data, it will then acknowledge the corresponding IPC flag to indicate that it is ready for more messages.

As an example:

1. First, CPU1 would write a message to the CPU2 in C1toC2 MSG RAM.
2. Then the CPU1 would write a 1 to the appropriate flag bit in the C1TOC2IPCSET register. This sets the C1TOC2IPCFLG, which also sets the C1TOC2IPCSTS register on CPU2, letting CPU2 know that a message is available.
3. Then CPU2 sees that a bit in the C1TOC2IPCSTS register is set.
4. Next CPU2 reads the message from the C1toC2 MSG RAM and then
5. It writes a 1 to the same bit in the C1TOC2IPCACK register to acknowledge that it has received the message. This subsequently clears the flag bit in C1TOC2IPCFLG and C1TOC2IPCSTS.
6. CPU1 can then send more messages using that particular flag bit.
IPC Software Solutions Summary

- **Basic Option**
  - No software drivers needed
  - Uses IPC registers only (simple message passing)

- **IPC-Lite Software API Driver**
  - Uses IPC registers only (no memory used)
  - Limited to 1 IPC interrupt at a time
  - Limited to 1 command/message at a time
  - CPU1 can use IPC-Lite to communicate with CPU2 boot ROM

- **Main IPC Software API Driver**
  - Uses circular buffers message RAMs
  - Can queue up to 4 messages prior to processing (configurable)
  - Can use multiple IPC ISRs at a time
  - Requires additional setup in application code prior to use

There are three options to use the IPC on the device.

Basic option: A very simple option that does not require any drivers. This option only requires IPC registers to implement very simple flagging of messages passed between processors.

Driver options: If the application code needs a set of basic IPC driver functions for reading or writing data, setting/clearing bits, and function calls, then there are 2 IPC software driver solutions provided by TI.

IPC-Lite:
- Only uses the IPC registers. No additional memory such as message RAM or shared RAM is needed.
- Only one IPC ISR can be used at a time.
- Can only process one message at a time.
- CPU1 can use IPC lite to communicate with the CPU2 boot ROM. The CPU2 boot ROM processes basic IPC read, write, bit manipulation, function call, and branch commands.

Main IPC Software API Driver: (This is a more feature filled IPC solution)
- Utilizes circular buffers in C2toC1 and C1toC2 message RAM’s.
- Allows application to queue up to 4 messages prior to processing (configurable).
- Allows application to use multiple IPC ISR’s at a time.
- Requires additional setup in application code prior to use.

In addition to the above, SYS/BIOS 6 will provide a new transport module to work with the shared memory and IPC resources on the F2837x.
Lab 11: Inter-Processor Communications

Objective

The objective of this lab exercise is to demonstrate and become familiar with the operation of the IPC module. We will be using the basic IPC features to send data in both directions between CPU1 and CPU2. A typical dual-core F2837xD application consists of two separate and completely independent CCS projects. One project is for CPU1, and the other project is for CPU2. As in the previous lab exercises, PWM2 will be configured to provide a 50 kHz SOC signal to ADC-A. An End-of-Conversion ISR on CPU1 will read each result and write it into a data register in the IPC. An IPC interrupt will then be triggered on CPU2 which fetches this data and stores it in a circular buffer. The same ISR grabs a data point from a sine table and loads it into a different IPC register for transmission to CPU1. This triggers an interrupt on CPU1 to fetch the sine data and write it into DAC-B. The DAC-B output is connected by a jumper wire to the ADCINA0 pin. If the program runs as expected, the sine table and ADC results buffer on CPU2 should contain very similar data.

Procedure

Open the Projects – CPU1 & CPU2

1. Two projects named Lab11_cpu01 and Lab11_cpu02 have been created for this lab exercise. Open both projects by clicking on Project → Import CCS Projects. The “Import CCS Eclipse Projects” window will open then click Browse... next to the “Select search-directory” box. Navigate to: C:\C28x\Labs\Lab11 and click OK.

Both projects will appear in the “Discovered projects” window. Click Select All and click Finish to import the project. All build options for each project have been configured the same as the previous lab exercise.

The files used in the CPU1 project are:
Inspect the Project – CPU1

2. Click on the project name Lab11_cpu01 in the Project Explorer window to set the project active. Then click on the plus sign (+) to the left of Lab11_cpu01 to expand the file list.

3. Open and inspect Main_11_cpu1.c. Notice the synchronization handshake code using IPC17 during initialization:

```c
//--- Wait here until CPU02 is ready
while (IpcRegs.IPCSTS.bit.IPC17 == 0) ; // Wait for CPU02 to set IPC17
IpcRegs.IPCACK.bit.IPC17 = 1; // Acknowledge and clear IPC17
```

CPU1 will start first and then wait until CPU2 releases it from the while() loop. This only needs to be done once. In effect, CPU1 is waiting until CPU2 is ready to accept IPC interrupts, thereby making sure that the CPUs are ready for messaging through the IPC.

4. Open and inspect DefaultIsr_11_cpu1.c. This file contains two interrupt service routines – one (ADCA1_ISR) at PIE1.1 reads the ADC results which is sent over IPC1 to CPU2, and the other (IPC0_ISR) at PIE1.13 reads the incoming sine table point for the DAC which is sent over IPC0 from CPU2. Additionally, ADCA1_ISR toggles the LaunchPad LED D9 at 1 Hz as a visual indication that it is running.

In ADCA1_ISR() the ADC result value being sent to CPU2 is written via the IPCSENDDATA register. In IPC0_ISR() the incoming data from CPU2 for the DAC is read via the IPCRECVAADDR register. These registers are part of the IPC module and provide an easy way to transmit single data words between CPUs without using memory.

Inspect the Project – CPU2

5. Click on the project name Lab11_cpu02 in the Project Explorer window to set the project active. Then click on the plus sign (+) to the left of Lab11_cpu02 to expand the file list.

6. Open and inspect Main_11_cpu2.c. Notice the synchronization handshake code used to release CPU1 from its while() loop:

```c
//--- Let CPU1 know that CPU2 is ready
IpcRegs.IPCSET.bit.IPC17 = 1; // Set IPC17 to release CPU1
```

7. Open and inspect DefaultIsr_11_cpu2.c. This file contains a single interrupt service routine – (IPC1_ISR) at PIE1.14 reads the incoming ADC results which is sent over IPC1 from CPU1, and writes the next sine table point for the DAC which is sent over IPC0 to CPU1. Additionally, IPC1_ISR toggles the LaunchPad LED D10 at 5 Hz as a visual indication that it is running.
In `IPC1_ISR()` the incoming ADC result value from CPU1 is read via the `IPCRECVDATA` register, and the sine data to CPU1 is written via the `IPCSENDADDR` register. The `IPCSENDDATA` and `IPCRECVDATA` registers are mapped to the same address on each CPU, as are the `IPCSENDADDR` and `IPCRECVADDR` registers.

**Jumper Wire Connection**

8. Using a jumper wire, connect the ADCINA0 (header J3, pin #30) to DACB (header J7, pin #70) on the LaunchPad. Refer to the following diagram for the pins that need to be connected.

![](image)

**Build and Load the Project**

9. In the Project Explorer window click on the `Lab11_cpu01` project to set it active. Then click the Build button and watch the tools run in the Console window. Check for any errors in the Problems window. Repeat this step for the `Lab11_cpu02` project.

10. Again, in the Project Explorer window click on the `Lab11_cpu01` project to set it active. Click on the Debug button (green bug). A Launching Debug Session window will open. Select only CPU1 to load the program on (i.e. uncheck CPU2), and then click OK. The CCS Debug perspective view should open, then CPU1 will connect to the target and the program will load automatically.

11. The Debug window reflects the current status of CPU1 and CPU2.

![](image)

Notice that CPU1 is currently connected and CPU2 is “Disconnected”. This means that CCS has no control over CPU2 thus far; it is freely running from the view of CCS. Of course CPU2 is under control of CPU1 and since we have not executed an IPC command yet, CPU2 is stopped by an “Idle” mode instruction in the Boot ROM.

12. Next, we need to connect to and load the program on CPU2. Right-click at the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU2” and select Connect Target.

13. With the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU2” still highlighted, load the program:
Run → Load → Load Program…

**Browse to the file:** C:\C28x\Labs\Lab11\cpu02\Debug\Lab11_cpu02.out **and select OK** to load the program.

14. Again, with the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU1” highlighted, set the bootloader mode using the menu bar by clicking:
   Scripts → EMU Boot Mode Select → EMU_BOOT_SARAM

   Use the same procedure above to set the bootloader mode for CPU2. If the device has been power cycled between lab exercises, or within this lab exercise, be sure to configure the boot mode to EMU_BOOT_SARAM using the Scripts menu for both CPU1 and CPU2.

**Run the Code**

15. In the Debug window, click on the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU1”. Run the code on CPU1 by clicking the green **Resume** button. At this point CPU1 is waiting for CPU2 to be ready.

16. In the Debug window, click on the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU2”. As before, run the code on CPU2 by clicking the **Resume** button. Using the IPC17, CPU2 communicates to CPU1 that it is now ready. On the LaunchPad, LED D9 connected to CPU1 should be blinking at approximately 1 Hz and LED D10 connected to CPU2 should be blinking at approximately 5 Hz.

17. In the Debug window select CPU1. Halt the CPU1 code after a few seconds by clicking on the **Suspend** button.

18. Then in the Debug window select CPU2. Halt the CPU2 code by using the same procedure.

**View the ADC Results**

19. Open and setup a graph to plot a 50-point window of the ADC results buffer. **Click:** Tools → Graph → Single Time and set the following values:

<table>
<thead>
<tr>
<th>Acquisition Buffer Size</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>50000</td>
</tr>
<tr>
<td>Start Address</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Display Data Size</td>
<td>50</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>sample</td>
</tr>
</tbody>
</table>

   Select **OK** to save the graph options.

20. If the IPC communications is working, the ADC results buffer on CPU2 should contain the sine data transmitted from the look-up table. The graph view should look like:
Run the Code - Real-Time Emulation Mode

21. We will now run the code in real-time emulation mode. Enable the graph window for continuous refresh. On the graph window toolbar, left-click on "Enable Continuous Refresh" (the yellow icon with the arrows rotating in a circle over a pause sign). This will allow the graph to continuously refresh in real-time while the program is running.

22. In the Debug window highlight the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU1”. Run the code on CPU1 in real-time mode by clicking:

Scripts → Realtime Emulation Control → Run_Realtime_with_Reset

23. Next, in the Debug window highlight the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU2”. Run the code on CPU2 in real-time mode by using the same procedure above.

The graph should now be updating in real-time.

24. Carefully remove and replace the jumper wire from the DACB output (header J7, pin #70) to the ADCINA0 input (header J3, pin #30). The ADC results graph should disappear and be replaced by a flat line when the jumper wire is removed. This shows that the sine data is being transmitted over IPC0 to CPU1, and (after being sent from DAC to ADC) received from CPU1 over IPC1.

25. Now we will view the IPC registers while the code is running in real-time emulation mode on CPU1 and CPU2. Open Main_11_cpu1.c (or Main_11_cpu2.c), highlight the “IpcRegs” structure and right click, then select Add Watch Expression… and click OK. Enable the Expressions window for continuous refresh.

26. In the Debug window highlight the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU1”. Then in the Expressions window open “IpcRegs”, scroll down and notice the IPCSENDATA and IPCRECVADDR registers is updating, as expected for CPU1. Also, notice that IPCSENDADDR and IPCRECVDATA registers, as well as the graph (ADC buffer) are not updated on CPU1.

27. In the Debug window highlight the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU2”. Then in the Expressions window open “IpcRegs”, scroll down and notice the IPCRECVDATA and IPCSENDADDR registers, and the graph is updating, as expected for CPU2. Likewise, notice that IPCRECVADDR and IPCSENDDATA registers are not updated on CPU2.

28. Again, in the Debug window highlight the line “Texas Instruments XDS100v2 USB Emulator_0/C28xx_CPU1”. Fully halt the code on CPU1 in real-time mode by clicking:

Scripts → Realtime Emulation Control → Full_Halt

29. Next, fully halt the code on CPU2 in real-time mode by using the same procedure.

Terminate Debug Session and Close Project

30. Terminate the active debug session using the Terminate button. This will close the debugger and return Code Composer Studio to the CCS Edit perspective view.

31. Next, close the Lab11_cpu01 and Lab11_cpu02 projects by right-clicking on each project in the Project Explorer window and select Close Project.
End of Exercise
Communications

Introduction

The TMS320C28x contains features that allow several methods of communication and data exchange between the C28x and other devices. Many of the most commonly used communications techniques are presented in this module.

The intent of this module is not to give exhaustive design details of the communication peripherals, but rather to provide an overview of the features and capabilities. Once these features and capabilities are understood, additional information can be obtained from various resources such as documentation, as needed. This module will cover the basic operation of the communication peripherals, as well as some basic terms and how they work.

Module Objectives

- Serial Peripheral Interface (SPI)
- Serial Communication Interface (SCI)
- Multichannel Buffered Serial Port (McBSP)
- Inter-Integrated Circuit (I2C)
- Universal Serial Bus (USB)
- Controller Area Network (CAN)

Note: Up to 3 SPI modules, 4 SCI modules, 2 McBSP modules, 2 I2C modules, 1 USB module, and 2 CAN modules are available on the F28x7x devices.

The F2837xD dual-core MCU includes numerous communications peripherals that extend the connectivity of the device. There are up to three Serial Peripheral Interface (SPI) modules, four Serial Communication Interface (SCI) modules, two Multi-channel Buffered Serial Port (McBSP) modules, two Inter-Integrated Circuit (I2C) modules, two Controller Area Network (CAN) modules, one Universal Serial Bus (USB) module, and one Universal Parallel Port (uPP) module. These peripherals can be assigned to either the CPU1 subsystem or the CPU2 subsystem, except for the USB and uPP which is dedicated to only the CPU1 subsystem.
## Chapter Topics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications Techniques</td>
<td>12-3</td>
</tr>
<tr>
<td>Serial Peripheral Interface (SPI)</td>
<td>12-4</td>
</tr>
<tr>
<td>SPI Summary</td>
<td>12-7</td>
</tr>
<tr>
<td>Serial Communications Interface (SCI)</td>
<td>12-8</td>
</tr>
<tr>
<td>Multiprocessor Wake-Up Modes</td>
<td>12-10</td>
</tr>
<tr>
<td>SCI Summary</td>
<td>12-12</td>
</tr>
<tr>
<td>Multichannel Buffered Serial Port (McBSP)</td>
<td>12-13</td>
</tr>
<tr>
<td>Definition: Bit, Word, and Frame</td>
<td>12-14</td>
</tr>
<tr>
<td>Multi-Channel Selection</td>
<td>12-15</td>
</tr>
<tr>
<td>McBSP Summary</td>
<td>12-15</td>
</tr>
<tr>
<td>Inter-Integrated Circuit (I2C)</td>
<td>12-16</td>
</tr>
<tr>
<td>I2C Operating Modes and Data Formats</td>
<td>12-17</td>
</tr>
<tr>
<td>I2C Summary</td>
<td>12-18</td>
</tr>
<tr>
<td>Universal Serial Bus (USB)</td>
<td>12-19</td>
</tr>
<tr>
<td>USB Communication</td>
<td>12-20</td>
</tr>
<tr>
<td>Enumeration</td>
<td>12-20</td>
</tr>
<tr>
<td>F28x USB Hardware</td>
<td>12-21</td>
</tr>
<tr>
<td>USB Controller Summary</td>
<td>12-21</td>
</tr>
<tr>
<td>Controller Area Network (CAN)</td>
<td>12-22</td>
</tr>
<tr>
<td>CAN Bus and Node</td>
<td>12-23</td>
</tr>
<tr>
<td>Principles of Operation</td>
<td>12-23</td>
</tr>
<tr>
<td>Message Format and Block Diagram</td>
<td>12-25</td>
</tr>
<tr>
<td>CAN Summary</td>
<td>12-26</td>
</tr>
</tbody>
</table>
Communications Techniques

Several methods of implementing a TMS320C28x communications system are possible. The method selected for a particular design should reflect the method that meets the required data rate at the lowest cost. Various categories of interface are available and are summarized in the learning objective slide. Each will be described in this module.

### Synchronous vs. Asynchronous

<table>
<thead>
<tr>
<th>Synchronous</th>
<th>Asynchronous</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short distances (on-board)</td>
<td>longer distances</td>
</tr>
<tr>
<td>High data rate</td>
<td>Lower data rate ($\approx 1/8$ of SPI)</td>
</tr>
<tr>
<td>Explicit clock</td>
<td>Implied clock (clk/data mixed)</td>
</tr>
<tr>
<td>Economical with reasonable performance</td>
<td></td>
</tr>
</tbody>
</table>

Serial ports provide a simple, hardware-efficient means of high-level communication between devices. Like the GPIO pins, they may be used in stand-alone or multiprocessing systems.

In a multiprocessing system, they are an excellent choice when both devices have an available serial port and the data rate requirement is relatively low. Serial interface is even more desirable when the devices are physically distant from each other because the inherently low number of wires provides a simpler interconnection.

Serial ports require separate lines to implement, and they do not interfere in any way with the data and address lines of the processor. The only overhead they require is to read/write new words from/to the ports as each word is received/transmitted. This process can be performed as a short interrupt service routine under hardware control, requiring only a few cycles to maintain.

The C28x family of devices have both synchronous and asynchronous serial ports. Detailed features and operation will be described next.
Serial Peripheral Interface (SPI)

The SPI is a high-speed synchronous serial port that shifts a programmable length serial bit stream into and out of the device at a programmable bit-transfer rate. It is typically used for communications between processors and external peripherals, and it has a 16-level deep receive and transmit FIFO for reducing servicing overhead. During data transfers, one SPI device must be configured as the transfer MASTER, and all other devices configured as SLAVES. The master drives the transfer clock signal for all SLAVES on the bus. SPI communications can be implemented in any of three different modes:

- MASTER sends data, SLAVES send dummy data
- MASTER sends data, one SLAVE sends data
- MASTER sends dummy data, one SLAVE sends data

In its simplest form, the SPI can be thought of as a programmable shift register. Data is shifted in and out of the SPI through the SPIDAT register. Data to be transmitted is written directly to the SPIDAT register, and received data is latched into the SPIBUF register for reading by the CPU. This allows for double-buffered receive operation, in that the CPU need not read the current received data from SPIBUF before a new receive operation can be started. However, the CPU must read SPIBUF before the new operation is complete of a receiver overrun error will occur. In addition, double-buffered transmit is not supported: the current transmission must be complete before the next data character is written to SPIDAT or the current transmission will be corrupted.

The Master can initiate a data transfer at any time because it controls the SPICLK signal. The software, however, determines how the Master detects when the Slave is ready to broadcast.

---

**SPI Data Flow**

- Simultaneous transmits and receive
- SPI Master provides the clock signal

![SPI Data Flow Diagram](image-url)
**SPI Block Diagram**

C28x - SPI Master Mode Shown

- **SPISIMO**
- **SPISOMI**
- **SPICLK**
- **LSPCLK**
- **RX FIFO_0**
- **RX FIFO_3**
- **SPITXBUF.15-0**
- **TX FIFO_0**
- **TX FIFO_3**
- **SPIRXBUF.15-0**

**SPI Transmit / Receive Sequence**

1. Slave writes data to be sent to its shift register (SPIDAT)
2. Master writes data to be sent to its shift register (SPIDAT or SPITXBUF)
3. Completing Step 2 automatically starts SPICLK signal of the Master
4. MSB of the Master’s shift register (SPIDAT) is shifted out, and LSB of the Slave’s shift register (SPIDAT) is loaded
5. Step 4 is repeated until specified number of bits are transmitted
6. SPIDAT register is copied to SPIRXBUF register
7. SPI INT Flag bit is set to 1
8. An interrupt is asserted if SPI INT ENA bit is set to 1
9. If data is in SPITXBUF (either Slave or Master), it is loaded into SPIDAT and transmission starts again as soon as the Master’s SPIDAT is loaded
Since data is shifted out of the SPIDAT register MSB first, transmission characters of less than 16 bits must be left-justified by the CPU software prior to being written to SPIDAT.

Received data is shifted into SPIDAT from the left, MSB first. However, the entire sixteen bits of SPIDAT is copied into SPIBUF after the character transmission is complete such that received characters of less than 16 bits will be right-justified in SPIBUF. The non-utilized higher significance bits must be masked-off by the CPU software when it interprets the character. For example, a 9 bit character transmission would require masking-off the 7 MSB's.

**SPI Data Character Justification**

- Programmable data length of 1 to 16 bits
- Transmitted data of less than 16 bits must be left justified
  - MSB transmitted first
- Received data of less than 16 bits are right justified
- User software must mask-off unused MSB’s
SPI Summary

- Synchronous serial communications
  - Two wire transmit or receive (half duplex)
  - Three wire transmit and receive (full duplex)
- Software configurable as master or slave
  - C28x provides clock signal in master mode
- Data length programmable from 1-16 bits
- 125 different programmable baud rates
Serial Communications Interface (SCI)

The SCI is a two-wire asynchronous serial port (also known as a UART) that supports communications between the processor and other asynchronous peripherals that use the standard non-return-to-zero (NRZ) format. A receiver and transmitter 16-level deep FIFO is used to reduce servicing overhead. The SCI transmit and receive registers are both double-buffered to prevent data collisions and allow for efficient CPU usage. In addition, the C28x SCI is a full duplex interface which provides for simultaneous data transmit and receive. Parity checking and data formatting is also designed to be done by the port hardware, further reducing software overhead.
Serial Communications Interface (SCI)

SCI Data Format

NRZ (non-return to zero) format

<table>
<thead>
<tr>
<th>Start</th>
<th>LSB</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>MSB</th>
<th>Addr/Data</th>
<th>Parity</th>
<th>Stop 1</th>
<th>Stop 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This bit present only in Address-bit mode

Communications Control Register (SciRegs.SCICCR)

<table>
<thead>
<tr>
<th>Stop Bits</th>
<th>Even/Odd Parity</th>
<th>Parity Enable</th>
<th>Loopback Enable</th>
<th>Addr/Idle Mode</th>
<th>SCI Char2</th>
<th>SCI Char1</th>
<th>SCI Char0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = 1 Stop bit</td>
<td>0 = Disabled</td>
<td>0 = Disabled</td>
<td>0 = Idle-line mode</td>
<td>0 = Disabled</td>
<td>SCI Char2</td>
<td>SCI Char1</td>
<td>SCI Char0</td>
</tr>
<tr>
<td>1 = 2 Stop bits</td>
<td>1 = Enabled</td>
<td>1 = Enabled</td>
<td>1 = Addr-bit mode</td>
<td>1 = Enabled</td>
<td>SCI Char2</td>
<td>SCI Char1</td>
<td>SCI Char0</td>
</tr>
</tbody>
</table>

# of data bits = (binary + 1)
e.g. 110b gives 7 data bits

The basic unit of data is called a **character** and is 1 to 8 bits in length. Each character of data is formatted with a start bit, 1 or 2 stop bits, an optional parity bit, and an optional address/data bit. A character of data along with its formatting bits is called a **frame**. Frames are organized into groups called blocks. If more than two serial ports exist on the SCI bus, a block of data will usually begin with an address frame which specifies the destination port of the data as determined by the user’s protocol.

The start bit is a low bit at the beginning of each frame which marks the beginning of a frame. The SCI uses a NRZ (Non-Return-to-Zero) format which means that in an inactive state the SCIRX and SCITX lines will be held high. Peripherals are expected to pull the SCIRX and SCITX lines to a high level when they are not receiving or transmitting on their respective lines.

**When configuring the SCICCR, the SCI port should first be held in an inactive state.** This is done using the SW RESET bit of the SCI Control Register 1 (SCICTL1.5). Writing a 0 to this bit initializes and holds the SCI state machines and operating flags at their reset condition. The SCICCR can then be configured. Afterwards, re-enable the SCI port by writing a 1 to the SW RESET bit. At system reset, the SW RESET bit equals 0.
Serial Communications Interface (SCI)

SCI Data Timing

- Start bit valid if 4 consecutive SCICLK periods of zero bits after falling edge
- Majority vote taken on 4th, 5th, and 6th SCICLK cycles

![SCI Data Timing Diagram]

Note: 8 SCICLK periods per data bit

Multiprocessor Wake-Up Modes

- Allows numerous processors to be hooked up to the bus, but transmission occurs between only two of them
- *Idle-line* or *Address-bit* modes
- Sequence of Operation

1. Potential receivers set $SLEEP = 1$, which disables RXINT except when an address frame is received
2. All transmissions begin with an address frame
3. Incoming address frame temporarily wakes up all SCIs on bus
4. CPUs compare incoming SCI address to their SCI address
5. Process following data frames only if address matches
**Idle-Line Wake-Up Mode**

- Idle time separates blocks of frames
- Receiver wakes up when SCIRXD high for 10 or more bit periods
- Two transmit address methods
  - Deliberate software delay of 10 or more bits
  - Set TXWAKE bit to automatically leave exactly 11 idle bits

```
Idle periods
of less than
10 bits
Block of Frames
```

```
Idle Period
10 bits
or greater
```

```
Address frame
follows 10 bit
or greater idle
```

```
1st data frame
```

```
Block of Frames
```

```
ST Addr SPST Data SP Last Data SP ST Addr SP
```

```
SCIRXD/ SCITXD
```

- Last Data
- ST
- Addr
- SP
- Data
- SP
- Last Data
- SP
- ST
- Addr
- SP

```
SCIRXD/ SCITXD
```

```
Last Data 0 SP
```

```
Idle Period
10 bits
or greater
```

```
Address frame
follows 10 bit
or greater idle
```

```
1st data frame
```

```
Idle periods
of less than
10 bits
```

```
Address-Bit Wake-Up Mode
```

- All frames contain an extra address bit
- Receiver wakes up when address bit detected
- Automatic setting of Addr/Data bit in frame by setting TXWAKE = 1 prior to writing address to SCITXBUF

```
Block of Frames
```

```
ST Addr 1 SPST Data 0 SP Last Data 0 SP ST Addr 1 SP
```

```
SCIRXD/ SCITXD
```

```
Last Data 0 SP
```

```
Idle Period
length of no
significance
```

```
First frame within
block is Address.
ADDR/DATA
bit set to 1
```

```
1st data frame
```

```
no additional
idle bits needed
beyond stop bits
```

The SCI interrupt logic generates interrupt flags when it receives or transmits a complete character as determined by the SCI character length. This provides a convenient and efficient way of timing and controlling the operation of the SCI transmitter and receiver. The interrupt flag for the transmitter is TXRDY (SCICTL2.7), and for the receiver RXRDY (SCIRXST.6). TXRDY is
set when a character is transferred to TXSHF and SCITXBUF is ready to receive the next character. In addition, when both the SCIBUF and TXSHF registers are empty, the TX EMPTY flag (SCICTL2.6) is set. When a new character has been received and shifted into SCIRXBUF, the RXRDY flag is set. In addition, the BRKDT flag is set if a break condition occurs. A break condition is where the SCIRXD line remains continuously low for at least ten bits, beginning after a missing stop bit. Each of the above flags can be polled by the CPU to control SCI operations, or interrupts associated with the flags can be enabled by setting the RX/BK INT ENA (SCICTL2.1) and/or the TX INT ENA (SCICTL2.0) bits active high.

Additional flag and interrupt capability exists for other receiver errors. The RX ERROR flag is the logical OR of the break detect (BRKDT), framing error (FE), receiver overrun (OE), and parity error (PE) bits. RX ERROR high indicates that at least one of these four errors has occurred during transmission. This will also send an interrupt request to the CPU if the RX ERR INT ENA (SCICTL1.6) bit is set.

**SCI Summary**

<table>
<thead>
<tr>
<th>SCI Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>✦ Asynchronous communications format</td>
</tr>
<tr>
<td>✦ 65,000+ different programmable baud rates</td>
</tr>
<tr>
<td>✦ Two wake-up multiprocessor modes</td>
</tr>
<tr>
<td>✦ Idle-line wake-up &amp; Address-bit wake-up</td>
</tr>
<tr>
<td>✦ Programmable data word format</td>
</tr>
<tr>
<td>✦ 1 to 8 bit data word length</td>
</tr>
<tr>
<td>✦ 1 or 2 stop bits</td>
</tr>
<tr>
<td>✦ even/odd/no parity</td>
</tr>
<tr>
<td>✦ Error Detection Flags</td>
</tr>
<tr>
<td>✦ Parity error; Framing error; Overrun error; Break detection</td>
</tr>
<tr>
<td>✦ Transmit FIFO and receive FIFO</td>
</tr>
<tr>
<td>✦ Individual interrupts for transmit and receive</td>
</tr>
</tbody>
</table>
The McBSP provides a high-speed direct interface to codecs, analog interface chips (AICs), and other serially connected A/D and D/A devices. It has double-buffered transmission and triple-buffered reception for supporting continuous data streams. There are 128 channels for transmission and reception, and data size selections of 8, 12, 16, 20, 24, and 32 bits, along with μ-law and A-law companding.
**Definition: Bit, Word, and Frame**

- **Bit** - one data bit per serial clock period
- **Word** or “channel” contains number of bits (8, 12, 16, 20, 24, 32)

### Definition: Bit and Word

- CLK
- FS
- D
- a1 a0 b7 b6 b5 b4 b3 b2 b1 b0
- Bit
- Word

- “Bit” - one data bit per serial clock period
- “Word” or “channel” contains number of bits (8, 12, 16, 20, 24, 32)

### Definition: Word and Frame

- FS
- D
- w6 w7 w0 w1 w2 w3 w4 w5 w6 w7
- Word
- Frame

- “Frame” - contains one or multiple words
- Number of words per frame: 1-128
Multi-Channel Selection

- Allows multiple channels (words) to be independently selected for transmit and receive (e.g. only enable Ch0, 5, 27 for receive, then process via CPU)
- The McBSP keeps time sync with all channels, but only “listens” or “talks” if the specific channel is enabled (reduces processing/bus overhead)
- Multi-channel mode controlled primarily via two registers:
  - Multi-channel Control Reg
    (enables Mc-mode)
  - Rec/Xmt Channel Enable Regs
    (enable/disable channels)
- Up to 128 channels can be enabled/disabled

McBSP Summary

- Independent clocking and framing for transmit and receive
- Internal or external clock and frame sync
- Data size of 8, 12, 16, 20, 24, or 32 bits
- TDM mode - up to 128 channels
  - Used for T1/E1 interfacing
- μ-law and A-law companding
- SPI mode
- Direct Interface to many codecs
- Can be serviced by the DMA
Inter-Integrated Circuit (I2C)

- Philips I2C-bus specification compliant, version 2.1
- Data transfer rate from 10 kbps up to 400 kbps
- Each device can be considered as a Master or Slave
- Master initiates data transfer and generates clock signal
- Device addressed by Master is considered a Slave
- Multi-Master mode supported
- Standard Mode – send exactly n data values (specified in register)
- Repeat Mode – keep sending data values (use software to initiate a stop or new start condition)

The I2C provides an interface between devices that are compliant I2C-bus specification version 2.1 and connect using an I2C-bus. External components attached to the 2-wire serial bus can transmit or receive 1 to 8-bit data to or from the device through the I2C module.
I2C Operating Modes and Data Formats

I2C Operating Modes

<table>
<thead>
<tr>
<th>Operating Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave-receiver mode</td>
<td>Module is a slave and receives data from a master (all slaves begin in this mode)</td>
</tr>
<tr>
<td>Slave-transmitter mode</td>
<td>Module is a slave and transmits data to a master (can only be entered from slave-receiver mode)</td>
</tr>
<tr>
<td>Master-receiver mode</td>
<td>Module is a master and receives data from a slave (can only be entered from master-transmit mode)</td>
</tr>
<tr>
<td>Master-transmitter mode</td>
<td>Module is a master and transmits to a slave (all masters begin in this mode)</td>
</tr>
</tbody>
</table>

I2C Serial Data Formats

7-Bit Addressing Format

<table>
<thead>
<tr>
<th>1</th>
<th>7</th>
<th>1</th>
<th>1</th>
<th>n</th>
<th>1</th>
<th>n</th>
<th>1</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Slave Address</td>
<td>R/W</td>
<td>ACK</td>
<td>Data</td>
<td>ACK</td>
<td>Data</td>
<td>ACK</td>
<td>P</td>
</tr>
</tbody>
</table>

10-Bit Addressing Format

<table>
<thead>
<tr>
<th>1</th>
<th>7</th>
<th>1</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>n</th>
<th>1</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>11110AA</td>
<td>R/W</td>
<td>ACK</td>
<td>AAAAAAAA</td>
<td>ACK</td>
<td>Data</td>
<td>ACK</td>
<td>P</td>
</tr>
</tbody>
</table>

Free Data Format

<table>
<thead>
<tr>
<th>1</th>
<th>n</th>
<th>1</th>
<th>n</th>
<th>1</th>
<th>n</th>
<th>1</th>
<th>n</th>
<th>1</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Data</td>
<td>ACK</td>
<td>Data</td>
<td>ACK</td>
<td>Data</td>
<td>ACK</td>
<td>P</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

R/W = 0 – master writes data to addressed slave  
R/W = 1 – master reads data from the slave  
n = 1 to 8 bits  
S = Start (high-to-low transition on SDA while SCL is high)  
P = Stop (low-to-high transition on SDA while SCL is high)
I2C Arbitration

- Arbitration procedure invoked if two or more master-transmitters simultaneously start transmission
  - Procedure uses data presented on serial data bus (SDA) by competing transmitters
  - First master-transmitter which drives SDA high is overruled by another master-transmitter that drives SDA low
  - Procedure gives priority to the data stream with the lowest binary value

I2C Summary

- Compliance with Philips I2C-bus specification (version 2.1)
- 7-bit and 10-bit addressing modes
- Configurable 1 to 8 bit data words
- Data transfer rate from 10 kbps up to 400 kbps
- Transmit FIFO and receive FIFO
Universal Serial Bus (USB)

Universal Serial Bus (USB) Controller
- Complies with USB 2.0 Implementers Forum certification standards
- Full-speed (12 Mbps) operation in Device mode; Full-/low-speed (12 Mbps / 1.5 Mbps) operation in Host mode
- Integrated PHY
- Thirty-two endpoints
  - One dedicated control IN endpoint and one dedicated control OUT endpoint
  - Fifteen configurable IN endpoints and fifteen configurable OUT endpoints

The USB operates as a full-speed function controller during point-to-point communications with a USB host. It complies with the USB 2.0 standard, and a dynamically sizeable FIFO supports queuing of multiple packets.

USB
- Formed by the USB Implementers Forum (USB-IF)
  - http://www.usb.org
- USB-IF has defined standardized interfaces for common USB application, known as Device Classes
  - Human Interface Device (HID)
  - Mass Storage Class (MSC)
  - Communication Device Class (CDC)
  - Device Firmware Upgrade (DFU)
  - Refer to USB-IF Class Specifications for more information
- USB is:
  - Differential
  - Asynchronous
  - Serial
  - NRZI Encoded
  - Bit Stuffed
- USB is a HOST centric bus!
USB Communication

USB Communication

- A component on the bus is either a...
  - *Host* (the master)
  - *Device* (the slave) – also known as peripheral or function
  - *Hub* (neither master nor slave; allows for expansion)
- Communication model is heavily master/slave
  - As opposed to peer-to-peer/networking (i.e. 1394/Firewire)
- Master runs the entire bus
  - Only the master keeps track of other devices on bus
  - Only the master can initiate transactions
- Slave simply responds to host commands
- This makes USB simpler, and cheaper to implement

Enumeration

Enumeration

- USB is universal because of *Enumeration*
  - Process in which a *Host* attempts to identify a *Device*
- If no device attached to a downstream port, then the port sees Hi-Z
- When full-speed device is attached, it pulls up D+ line
- When the Host see a Device, it polls for *descriptor* information
  - Essentially asking, “what are you?”
- Descriptors contain information the host can use to identify a driver
F28x USB Hardware

USB Hardware

- The USB controller requires a total of three signals (D+, D-, and VBus) to operate in device mode and two signals (D+, D-) to operate in embedded host mode.
- VBus implemented in software using external interrupt or polling
  - GPIOs are NOT 5V tolerant
  - To make them tolerant use 100kΩ and internal device ESD diode clamps

Note: (1) VBus sensing is only required in self-powered applications
(2) Device pins D+ and D- have special buffers to support the high speed requirements of USB; therefore their position on the device is not user-selectable

USB Controller Summary

USB Controller Summary

- Complies with USB 2.0 specifications
- Full-speed (12 Mbps) Device controller
- Full-/Low-speed (12 Mbps/1.5 Mbps) Host controller
- The DMA controller may be used to read and write the USB FIFOs via software triggering
- Full software library with application examples is provided within C2000Ware™
Controller Area Network (CAN)

- CAN 2.0B Standard
- High speed (up to 1 Mbps)
- Add a node without disturbing the bus (number of nodes not limited by protocol)
- Less wires (lower cost, less maintenance, and more reliable)
- Redundant error checking (high reliability)
- No node addressing (message identifiers)
- Broadcast based signaling

The CAN module is a serial communications protocol that efficiently supports distributed real-time control with a high level of security. It supports bit-rates up to 1 Mbit/s and is compliant with the CAN 2.0B protocol specification.

CAN does not use physical addresses to address stations. Each message is sent with an identifier that is recognized by the different nodes. The identifier has two functions – it is used for message filtering and for message priority. The identifier determines if a transmitted message will be received by CAN modules and determines the priority of the message when two or more nodes want to transmit at the same time.
CAN Bus and Node

**CAN Bus**

- Two wire differential bus (usually twisted pair)
- Max. bus length depend on transmission rate
  - 40 meters @ 1 Mbps

![CAN Bus Diagram]

The MCU communicates to the CAN Bus using a transceiver. The CAN bus is a twisted pair wire and the transmission rate depends on the bus length. If the bus is less than 40 meters the transmission rate is capable up to 1 Mbit/second.

**CAN Node**

*Wired-AND Bus Connection*

![CAN Node Diagram]
Principles of Operation

- Data messages transmitted are identifier based, not address based
- Content of message is labeled by an identifier that is unique throughout the network
  - (e.g. rpm, temperature, position, pressure, etc.)
- All nodes on network receive the message and each performs an acceptance test on the identifier
- If message is relevant, it is processed (received); otherwise it is ignored
- Unique identifier also determines the priority of the message
  - (lower the numerical value of the identifier, the higher the priority)
- When two or more nodes attempt to transmit at the same time, a non-destructive arbitration technique guarantees messages are sent in order of priority and no messages are lost

Non-Destructive Bitwise Arbitration

- Bus arbitration resolved via arbitration with wired-AND bus connections
  - Dominate state (logic 0, bus is high)
  - Recessive state (logic 1, bus is low)
Message Format and Block Diagram

**CAN Message Format**

- Data is transmitted and received using Message Frames
- 8 byte data payload per message
- Standard and Extended identifier formats

- **Standard Frame: 11-bit Identifier (CAN v2.0A)**
  - Arbitration Field
  - Control Field
  - Data Field
  - 11-bit Identifier
  - DLC: 0...8 Bytes Data
  - CRC
  - ACK
  - EOF

- **Extended Frame: 29-bit Identifier (CAN v2.0B)**
  - Arbitration Field
  - Control Field
  - Data Field
  - 18-bit Identifier
  - Cycle Count (r1)
  - DLC: 0...8 Bytes Data
  - CRC
  - ACK
  - EOF

The MCU CAN module is a full CAN Controller. It contains a message handler for transmission and reception management, and frame storage. The specification is CAN 2.0B Active – that is, the module can send and accept standard (11-bit identifier) and extended frames (29-bit identifier).
The CAN controller module contains 32 mailboxes for objects of 0 to 8-byte data lengths:

- configurable transmit/receive mailboxes
- configurable with standard or extended identifier

The CAN module mailboxes are divided into several parts:

- MID – contains the identifier of the mailbox
- MCF (Message Control Field) – contains the length of the message (to transmit or receive) and the RTR bit (Remote Transmission Request – used to send remote frames)
- MDL and MDH – contains the data

The CAN module contains registers which are divided into five groups:

- Control & Status Registers
- Local Acceptance Masks
- Message Object Time Stamps
- Message Object Timeout
- Mailboxes

**CAN Summary**

<table>
<thead>
<tr>
<th>CAN Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>✷ Fully compliant with CAN standard v2.0B</td>
</tr>
<tr>
<td>✷ Supports data rates up to 1 Mbps</td>
</tr>
<tr>
<td>✷ Thirty-two message objects</td>
</tr>
<tr>
<td>✷ Configurable as receive or transmit</td>
</tr>
<tr>
<td>✷ Configurable with standard or extended identifier</td>
</tr>
<tr>
<td>✷ Programmable receive mask</td>
</tr>
<tr>
<td>✷ Uses 32-bit time stamp on messages</td>
</tr>
<tr>
<td>✷ Programmable interrupt scheme (two levels)</td>
</tr>
<tr>
<td>✷ Programmable alarm time-out</td>
</tr>
<tr>
<td>✷ Programmable wake-up on bus activity</td>
</tr>
<tr>
<td>✷ Two interrupt lines</td>
</tr>
<tr>
<td>✷ Self-test mode</td>
</tr>
</tbody>
</table>
Support Resources

Introduction

This module contains various references to support the development process.

Module Objectives

- TI Workshops Download Site
- Documentation Resources
- C2000Ware™
- TI Development Tools
- Additional Resources
  - Product Information Center
  - On-line support
Chapter Topics

Support Resources ........................................................................................................................................... 13-1

TI Support Resources ........................................................................................................................................ 13-3
C2000 Workshop Download Wiki .................................................................................................................. 13-3
Documentation Resources ................................................................................................................................. 13-4
C2000Ware™ ................................................................................................................................................. 13-4
C2000 Experimenter's Kit ................................................................................................................................. 13-5
F28335 Peripheral Explorer Kit ....................................................................................................................... 13-6
C2000 LaunchPad Evaluation Kit ..................................................................................................................... 13-7
C2000 controlCARD Application Kits ............................................................................................................. 13-8
XDS100 / XDS200 Class JTAG Debug Probes .............................................................................................. 13-9
Product Information Resources ...................................................................................................................... 13-10
TI Support Resources

C2000 Workshop Download Wiki

At the C2000 Workshop Download Wiki you will find all of the materials for the C2000 One-day and Multi-day Workshops, as well as the C2000 archived workshops, which include support for the following device families:

- F2407
- F2812
- F2808
- F28335
- F28027
- F28035
- F28069
- F28M35x
Documentation Resources

- Data Sheet
  - Contains device electrical characteristics and timing specifications
  - Key document for hardware engineers
- Silicon Errata
  - Contains deviations from original specifications
  - Includes silicon revision history
- Technical Reference Manual (TRM)
  - Contains architectural descriptions and register/bit definitions
  - Key document for firmware engineers
- Workshop Materials
  - Hands-on device training materials
  - For hardware and software engineers

Documentation resources can be found at www.ti.com/c2000

C2000Ware™

C2000Ware for C2000 microcontrollers is a cohesive set of software infrastructure, tools, and documentation that is designed to minimize system development time. It includes device-specific
drivers and support software, as well as system application examples. C2000Ware provides the needed resources for development and evaluation. It can be downloaded from the TI website.

C2000 Experimenter’s Kit

The C2000 Experimenter Kits is a tool for device exploration and initial prototyping. These kits are complete, open source, evaluation and development tools where the user can modify both the hardware and software to best fit their needs.

The various Experimenter’s Kits shown on this slide include a specific controlCARD and Docking Station. The docking station provides access to all of the controlCARD signals with two prototyping breadboard areas and header pins, allowing for development of custom solutions. Most have on-board USB JTAG emulation capabilities and no external debug probe or power supply is required. However, where noted, the kits based on a DIMM-168 controlCARD include a 5-volt power supply and require an external JTAG debug probe.
F28335 Peripheral Explorer Kit

- **Experimenter Kit includes**
  - F28335 controlCARD
  - Peripheral Explorer baseboard
  - C2000 applications software with example code and full hardware details available in C2000Ware
  - Code Composer Studio (download)

- **Peripheral Explorer features**
  - ADC input variable resistors
  - GPIO hex encoder & push buttons
  - eCAP infrared sensor
  - GPIO LEDs, I2C & CAN connection
  - Analog I/O (AIC+ McBSP)

- **On-board USB JTAG debug probe**
  - *JTAG debug probe not required*

- **Available through TI authorized distributors and the TI store**

The C2000 Peripheral Explorer Kit is a learning tool for new C2000 developers and university students. The kit includes a peripheral explorer board and a controlCARD with the TMS320F28335 microcontroller. The board includes many hardware-based peripheral components for interacting with the various peripherals common to C2000 microcontrollers, such as the ADC, PWMs, eCAP, I2C, CAN, SPI and McBSP. A teaching ROM is provided containing presentation slides, a learning textbook, and laboratory exercises with solutions.
C2000 LaunchPad Evaluation Kit

The C2000 LaunchPads are low-cost, powerful evaluation platforms which are used to develop real-time control systems based on C2000 microcontrollers. Various LaunchPads are available and developers can find a LaunchPad with the required performance and feature mix for any application. The C2000 BoosterPacks expand the power of the LaunchPads with application-specific plug-in boards, allowing developers to design full solutions using a LaunchPad and BoosterPack combination.
C2000 controlCARD Application Kits

The C2000 Application Kits demonstrate the full capabilities of the C2000 microcontroller in a specific application. The kits are complete evaluation and development tools where the user can modify both the hardware and software to best fit their needs. Each kit uses a device specific controlCARD and a specific application board. All kits are completely open source with full documentation and are supplied with complete schematics, bill of materials, board design details, and software. Visit the TI website for a complete list of available Application Kits.
XDS100 / XDS200 Class JTAG Debug Probes

The JTAG debug probes are used during development to program and communicate with the C20000 microcontroller. While almost all C2000 development tool include emulation capabilities, after you have developed your own target board an external debug probe will be needed. Various debug probes are available with different features and at different price points. Shown here are popular debug probes from two manufacturers.
## Product Information Resources

<table>
<thead>
<tr>
<th>For More Information . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>♦ USA – Product Information Center (PIC)</td>
</tr>
<tr>
<td>♦ Phone: 800-477-8924 or 512-434-1560</td>
</tr>
<tr>
<td>♦ E-mail: <a href="mailto:support@ti.com">support@ti.com</a></td>
</tr>
<tr>
<td>♦ TI E2E Community (videos, forums, blogs)</td>
</tr>
<tr>
<td>♦ <a href="http://e2e.ti.com">http://e2e.ti.com</a></td>
</tr>
<tr>
<td>♦ Embedded Processor Wiki</td>
</tr>
<tr>
<td>♦ <a href="http://processors.wiki.ti.com">http://processors.wiki.ti.com</a></td>
</tr>
<tr>
<td>♦ TI Training</td>
</tr>
<tr>
<td>♦ <a href="http://training.ti.com">http://training.ti.com</a></td>
</tr>
<tr>
<td>♦ TI store</td>
</tr>
<tr>
<td>♦ <a href="http://store.ti.com">http://store.ti.com</a></td>
</tr>
<tr>
<td>♦ TI website</td>
</tr>
<tr>
<td>♦ <a href="http://www.ti.com">http://www.ti.com</a></td>
</tr>
</tbody>
</table>

For more information and support, contact the product information center, visit the TI E2E community, embedded processor Wiki, TI training web page, TI eStore, and the TI website.
Appendix A – F28379D Experimenter Kit

Overview

This appendix provides a quick reference and mapping of the header pins used on the F28379D LaunchPad and F28379D Experimenter Kit. This allows either development board to be used with the workshop.
Chapter Topics

Appendix A – F28379D Experimenter Kit ................................................................. A-1

F28379D Experimenter Kit ......................................................................................... A-3
Initial Hardware Setup .............................................................................................. A-3
Docking Station and LaunchPad Pin Mapping ......................................................... A-3
controlCARD and LaunchPad LED Mapping ......................................................... A-4
Stand-Alone Operation (No Emulator) ..................................................................... A-4
F28379D Experimenter Kit

Initial Hardware Setup

- **F28379D Experimenter Kit:**

  Insert the F28379D controlCARD into the Docking Station connector slot. Using the two (2) supplied USB cables – plug the USB Standard Type A connectors into the computer USB ports and plug the USB Mini-B connectors as follows:

  - A:J1 on the controlCARD (left side) – isolated XDS100v2 JTAG emulation
  - J17 on the Docking Station – board power

  On the Docking Station move switch S1 to the “USB-ON” position. This will power the Docking Station and controlCARD using the power supplied by the computer USB port. Additionally, the other computer USB port will power the on-board isolated JTAG emulator and provide the JTAG communication link between the device and Code Composer Studio.

Docking Station and LaunchPad Pin Mapping

<table>
<thead>
<tr>
<th>Function</th>
<th>Docking Station</th>
<th>LaunchPad</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADCINA0</td>
<td>ANA header, Pin # 09</td>
<td>J3-30</td>
</tr>
<tr>
<td>GND</td>
<td>GND</td>
<td>J2-20 (GND)</td>
</tr>
<tr>
<td>GPIO19</td>
<td>Pin # 73</td>
<td>J1-3</td>
</tr>
<tr>
<td>GPIO18</td>
<td>Pin # 71</td>
<td>J1-4</td>
</tr>
<tr>
<td>DACOUTB</td>
<td>ANA header, Pin # 11</td>
<td>J7-70</td>
</tr>
<tr>
<td>PWM1A</td>
<td>Pin # 49</td>
<td>J4-40</td>
</tr>
<tr>
<td>ECAP1 (via Input X-bar)</td>
<td>Pin # 75 (GPIO24)</td>
<td>J4-34 (GPIO24)</td>
</tr>
</tbody>
</table>
**controlCARD and LaunchPad LED Mapping**

<table>
<thead>
<tr>
<th>Function</th>
<th>controlCARD</th>
<th>LaunchPad</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED – Power</td>
<td>LED LD1 (green)</td>
<td>LED D1 (green)</td>
</tr>
<tr>
<td>LED – GPIO31</td>
<td>LED LD2 (red)</td>
<td>LED D10 (blue)</td>
</tr>
<tr>
<td>LED – GPIO34</td>
<td>LED LD3 (red)</td>
<td>LED D9 (red)</td>
</tr>
</tbody>
</table>

**Stand-Alone Operation (No Emulator)**

When the device is in stand-alone boot mode, the state of GPIO72 and GPIO84 pins are used to determine the boot mode. On the controlCARD switch SW1 controls the boot options for the F28379D device. Check that switch SW1 positions 1 and 2 are set to the default “1 – on” position (both switches up). This will configure the device (in stand-alone boot mode) to GetMode. Since the OTP_KEY has not been programmed, the default GetMode will be boot from flash. Details of the switch positions can be found in the controlCARD information guide.